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Trước khi dùng máy tính

Đọc mục này trước

Về Hướng dẫn sử dụng này
• CASIO Computer Co., Ltd. không chịu trách nhiệm với bất kỳ ai trong

bất kỳ sự cố nào về những hư hỏng đặc biệt, phụ thêm, tình cờ hay hệ
luỵ có liên quan tới hay phát sinh từ việc mua hay dùng sản phẩm này
và các khoản mục đi cùng nó. Hơn nữa, CASIO Computer Co., Ltd. sẽ
không chịu trách nhiệm về bất kì lời khiếu nại thuộc bất kì loại nào về
bất kì cái gì bởi bất kì bên nào nảy sinh từ việc dùng sản phẩm này và
các khoản mục đi cùng nó.

• Các nội dung trong hướng dẫn sử dụng này có thể được thay đổi mà
không cần báo trước.

• Các hiển thị và hình minh hoạ (như các nhãn phím) được trình bày
trong hướng dẫn sử dụng này chỉ được dùng với mục đích minh hoạ, và
có thể khác với các mục thực tế mà chúng thể hiện.

• QR Code là nhãn hiệu thương mại đã được đăng ký của DENSO WAVE
INCORPORATED tại Nhật Bản và các quốc gia khác.

• Tên công ty và tên sản phẩm được dùng trong hướng dẫn sử dụng
này có thể là thương hiệu đã đăng ký hay thương hiệu của chủ sở hữu
tương ứng.

Các thao tác phím
Ví dụ bên dưới minh họa cho cách thao tác phím được đề cập trong
hướng dẫn sử dụng này.

Ví dụ 1: 
Phải nhấn các phím theo trình tự đưa ra ở trên (trái sang phải).

Ví dụ 2: (π)*
Ví dụ trên chỉ ra rằng bạn nên nhấn  và sau đó là , thao tác này sẽ
nhập ký hiệu π. Tất cả thao tác nhập bằng nhiều phím được biểu thị bằng
cách này. Các nhãn trên nút phím được hiển thị, tiếp theo là ký tự nhập
hoặc lệnh trong dấu ngoặc đơn.
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* Tham khảo mục "Nhãn phím" (trang 14) để biết thêm thông tin về các
biểu tượng phím được sử dụng trong ví dụ này.

Ví dụ 3: , , , , , 

• Các phím con trỏ riêng được biểu thị chung là (1) sẽ được thể hiện dưới
dạng , , , .

• Các phím cuộn trang riêng được biểu thị chung là (2) sẽ được thể hiện
dưới dạng , .

Các thao tác menu
Một số thao tác trong hướng dẫn sử dụng này sử dụng dạng đơn giản hóa
của các thao tác trên menu, như thể hiện trong các ví dụ dưới đây.

Ví dụ 1

 – [Other] > [π]

hoặc

Nhấn , sau đó chọn [Other] > [π].

Thao tác thực tế 1

1. Nhấn .
2. Sử dụng  và  để chọn [Other], sau đó nhấn .
3. Sử dụng  và  để chọn [π], sau đó nhấn .
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Ví dụ 2

 - Calculate

hoặc

Nhấn , chọn biểu tượng ứng dụng Calculate, sau đó nhấn .

Thao tác thực tế 2

1. Nhấn .
2. Sử dụng các phím con trỏ ( , , , ) để chọn biểu tượng ứng

dụng Calculate, sau đó nhấn .

Phím  và Phím 
Phím  và phím  thực hiện cùng một thao tác. Trong hướng dẫn sử
dụng này,  được sử dụng để lựa chọn hay áp dụng cài đặt, trong khi 
được sử dụng để thực hiện tính toán. Tuy nhiên, lưu ý rằng không có gì
khác nhau nếu bạn nhấn  hoặc  cho các thao tác có hiển thị  hoặc

.

Ví dụ
Nếu bạn không được hướng dẫn sử dụng một ứng dụng máy tính cụ thể
hoặc để cấu hình các cài đặt cụ thể cho thao tác ví dụ, ứng dụng và các
cài đặt dưới đây sẽ được giả định.

Ứng dụng máy tính: Calculate
Cài đặt: Cài đặt máy tính mặc định ban đầu

Để biết thông tin về cách đưa máy tính về cài đặt mặc định ban đầu, vui
lòng xem "Khởi động máy tính" (trang 8).

Khởi động máy tính

Quan trọng!

• Quy trình dưới đây sẽ khởi động tất cả cài đặt của máy tính, ngoại trừ Contrast, Auto
Power Off, và Language. Đồng thời cũng xóa tất cả dữ liệu được lưu trong bộ nhớ
máy tính.

1. Nhấn  để hiển thị màn hình HOME.
2. Sử dụng các phím con trỏ ( , , , ) để chọn biểu tượng ứng

dụng máy tính, sau đó nhấn .
3. Nhấn , sau đó chọn [Reset] > [Initialize All] > [Yes].

• Thao tác này sẽ hiển thị màn hình HOME.
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Màn hình "Get Started" của máy tính
Khi màn hình HOME được hiển thị, nhấn phím  sẽ hiển thị màn hình
"Get Started", màn hình này bao gồm các thông tin dưới đây.
• QR Code để truy cập trang web "Get Started" của Worldwide Education

Service (https://wes.casio.com/calc/cw/)
Trang web Get Started cấp bạn quyền truy cập vào Hướng dẫn sử dụng
và thông tin liên quan khác để giúp bạn bắt đầu sử dụng máy tính của
mình.

• Mã số ID máy tính (chuỗi 24 ký tự)

Nhấn  để trở về màn hình HOME.

Lưu ý

• Bạn cũng có thể hiển thị màn hình Get Started, bằng cách chọn màn hình đó từ menu
SETTINGS. Vui lòng xem "Sử dụng Menu SETTINGS" (trang 20).

Thận trọng

Những lưu ý an toàn
Cảm ơn bạn đã mua sản phẩm CASIO này.
Hãy đảm bảo rằng bạn đã đọc "Những lưu ý an toàn" trước khi sử dụng
sản phẩm này để dùng sản phẩm đúng cách. Hãy chắc chắn là giữ tất cả
các tài liệu người dùng trong tay để tham khảo trong tương lai.
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Cảnh báo
Biểu thị điều gì đó có thể gây ra nguy cơ tử vong hoặc thương
tích cá nhân nghiêm trọng.

Màn hình hiển thị

Không nhấn vào hoặc để màn hình LCD bị va chạm mạnh.

Làm như vậy có thể khiến mặt kính LCD bị nứt, gây ra nguy cơ thương
tích cá nhân.

Nếu màn hình LCD bị nứt, tuyệt đối không chạm vào bất kỳ
chất lỏng nào bên trong.

Chất lỏng của màn hình LCD dính lên da sẽ gây ra nguy cơ kích ứng
da.
Nếu chất lỏng của màn hình LCD rơi vào miệng của bạn, hãy súc
miệng ngay và liên hệ với bác sĩ của bạn.
Nếu chất lỏng của màn hình LCD dính vào mắt hoặc da, hãy rửa sạch
bằng nước sạch và sau đó liên hệ với bác sĩ của bạn.

Biện pháp phòng ngừa về pin

Nếu chất lỏng rò rỉ từ pin dính vào da hoặc quần áo của bạn,
hãy rửa sạch ngay bằng nước sạch.

Chất lỏng trong pin dính vào mắt sẽ gây nguy cơ suy giảm thị lực, v.v...
Vì vậy, hãy rửa sạch mắt và sau đó liên hệ ngay với bác sĩ.

Cẩn trọng
Biểu thị điều gì đó có thể gây ra nguy cơ thương tích cá nhân
nhẹ hoặc thiệt hại vật chất.

Hãy tuân thủ những lưu ý dưới đây. Nếu không làm như vậy có thể
khiến pin bị vỡ, gây ra nguy cơ hỏa hoạn, thương tích cá nhân, và
làm bẩn các vật xung quanh do rò rỉ chất lỏng.

• Không cố tháo rời pin và tuyệt đối không để pin bị đoản mạch.
• Không sạc pin loại không sạc được.
• Không để pin tiếp xúc với nhiệt hoặc ném pin vào lửa.

• Chỉ sử dụng loại pin được chỉ định.
• Lắp pin đúng với các cực (cực dương (+) và cực âm (–)).
• Thay pin càng sớm càng tốt sau khi hết pin.
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 Biện pháp phòng ngừa về pin

Hãy tuân thủ những lưu ý dưới đây. Không làm như vậy có
thể gây nổ pin hoặc làm rò rỉ chất lỏng hoặc khí dễ cháy.

• Chỉ sử dụng loại pin được chỉ định cho sản phẩm này.
• Không đốt hoặc vứt bỏ pin vào lò đốt rác, hay nghiền hoặc cắt pin

bằng máy móc.
• Không để pin ở nhiệt độ quá cao hoặc quá thấp trong quá trình sử

dụng, bảo quản hoặc vận chuyển.
• Không để pin chịu áp suất khí quyển quá thấp trong quá trình sử

dụng, bảo quản hoặc vận chuyển.

Những lưu ý sử dụng
• Cho dù máy tính đang hoạt động bình thường, hãy thay pin ít nhất hai

năm một lần (R03).
• Bạn sẽ phải trả phí đối với trục trặc hoặc hư hỏng do rò rỉ pin mà không

được bảo hành.
• Pin đi cùng máy tính có thể bị hao hụt trong thời gian giao hàng và cất

giữ. Bởi vậy tuổi thọ của pin sẽ bị giảm dẫn đến việc pin sẽ bị thay sớm
hơn dự kiến.

• Tránh dùng và cất giữ máy tính trong khu vực có nhiệt độ cực đoan, và
môi trường ẩm ướt và nhiều bụi.

• Đừng để máy tính bị va chạm, bị ép hay uốn cong quá mức.
• Đừng bao giờ thử tháo rời máy tính ra.
• Dùng vải mềm, khô để lau bên ngoài máy tính tay.
• Bất kì khi nào vứt bỏ máy tính hay pin, hãy chắc chắn làm theo luật và

quy định của khu vực bạn ở.

Bắt đầu

Gắn và tháo vỏ trước

Để tháo vỏ trước

Trước khi sử dụng máy tính, tháo vỏ trước (①) ra và gắn vào phía sau
(②).
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Để gắn vỏ trước

Khi bạn không sử dụng máy tính, tháo vỏ trước (①) ra và gắn vào phía
trước (②).
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Quan trọng!

• Luôn gắn vỏ trước vào máy tính bất cứ khi nào bạn không sử dụng. Nếu không, việc
vô tình thao tác phím  có thể làm bật nguồn và hết pin.

Bật và tắt nguồn
Nhấn  để bật máy tính.
Nhấn (OFF) để tắt máy tính.

Lưu ý

• Để bật nguồn, nhấn giữ . Để tránh vô tình bật nguồn, phần nút phím  sẽ thấp
hơn một chút so với các phím khác.

• Nếu màn hình hiển thị dưới đây xuất hiện ngay sau khi bạn bật nguồn, có nghĩa là
nguồn pin còn lại yếu.

Nếu màn hình này xuất hiện, hãy thay pin càng sớm càng tốt. Để biết chi tiết về việc
thay pin, vui lòng xem "Thay thế pin" (trang 167).

• Máy tính cũng sẽ tự động tắt sau khoảng 10 phút hoặc 60 phút không dùng. Nhấn
phím  để bật lại máy tính.
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Màn hình HOME
Nhấn  sẽ hiển thị màn hình HOME. Màn hình HOME sẽ hiển thị danh
sách các ứng dụng máy tính đã cài đặt.

  Màn hình HOME   Màn hình ứng dụng
Calculate

                 
Để biết thông tin về các ứng dụng máy tính đã cài đặt, vui lòng xem
"Danh sách ứng dụng máy tính đã cài đặt" (trang 18).

Điều chỉnh độ tương phản hiển thị
1. Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
2. Nhấn , sau đó chọn [System Settings] > [Contrast].

3. Dùng phím  và  để điều chỉnh độ tương phản.
4. Sau khi thiết đặt theo ý của bạn, nhấn .

Quan trọng!

• Nếu điều chỉnh độ tương phản hiển thị vẫn không cải thiện được độ dễ đọc của màn
hình, có nghĩa là nguồn pin yếu. Hãy thay pin.

Nhãn phím
Nhấn phím  rồi nhấn phím thứ hai sẽ thực hiện chức năng thay phiên
của phím thứ hai. Chức năng thay phiên được biểu thị bằng nội dung in
phía trên phím, ở bên trái.

(1) Chức năng nút phím: 
(2) Chức năng thay phiên: (π)
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Chỉ báo
Chỉ báo

Bảng bên dưới mô tả các chỉ báo xuất hiện ở phía trên cùng của màn
hình.

Chỉ báo: Ý nghĩa:

Bàn phím đã được thay đổi do nhấn phím .
Bàn phím sẽ không thay đổi và chỉ báo sẽ biến
mất khi bạn nhấn phím này.

MathI/MathO hoặc MathI/DecimalO được chọn
cho Input/Output trên menu SETTINGS.

/ / 
Cài đặt hiện tại của Angle Unit ( : Degree, :
Radian, hoặc : Gradian) trên menu SETTINGS.

FIX Ấn định số vị trí thập phân trong số thập phân.

SCI Ấn định số chữ số có nghĩa.

E
On được chọn cho Engineer Symbol trên menu
SETTINGS.

i/∠ Cài đặt hiện tại của Complex Result (i : a+bi hoặc∠: r∠θ) trên menu SETTINGS.

Verify được bật (bằng cách chọn "Verify ON" trên
menu TOOLS).

/ 

Có lịch sử tính toán trước ( ) hoặc sau ( ) cho
kết quả tính toán được hiển thị hiện tại. Với một
số ứng dụng máy tính, những chỉ báo này cho
biết có các kết quả tính toán khác.
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Sử dụng menu
Nhiều thao tác của máy tính được thực hiện bằng cách sử dụng màn hình
menu. Ví dụ bên dưới cho thấy các thao tác bắt đầu từ màn hình menu
xuất hiện khi bạn nhấn .

Chọn mục menu

Để chọn mục menu, sử dụng các phím con trỏ ( , , , ) để đánh
dấu mục đó và sau đó nhấn . Lưu ý rằng  và  chỉ được sử dụng
khi có nhiều cột mục menu.

Điều hướng giữa các thứ bậc menu

Chỉ báo " " ở bên phải của mục menu có nghĩa là có các cấp thứ bậc
thấp hơn trong mục đó. Chọn mục menu và nhấn  hoặc  sẽ điều
hướng cấp thấp hơn tiếp theo trong thứ bậc này. Để trở về cấp cao hơn
tiếp theo trong thứ bậc này, nhấn .

Lưu ý

• Nếu bạn đang ở cấp thấp hơn trong thứ bậc của menu một cột, ngoài phím  bạn
còn có thể nhấn  để trở về cấp cao hơn tiếp theo.

Chọn mục menu bằng nút radio ( / )

Khi màn hình hiển thị danh sách các tùy chọn, mỗi tùy chọn sẽ có một nút
radio (  hoặc ) ở bên trái.  cho biết tùy chọn đang được chọn.
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Cách cấu hình cài đặt của mục menu nút radio
1. Đánh dấu mục menu phù hợp và sau đó nhấn .

• Điều gì xảy ra tiếp theo sẽ tùy thuộc vào loại mục menu bạn đã chọn.
- Nếu không còn cài đặt nào để cấu hình cho mục menu bạn đã chọn,

nút radio bên cạnh sẽ chuyển thành .
- Mục menu bạn đã chọn còn nhiều cài đặt khác để cấu hình, màn

hình chọn cài đặt mục menu sẽ xuất hiện. Trong trường hợp này,
chuyển sang bước 2.

2. Trên màn hình cài đặt, đánh dấu cài đặt bạn mong muốn và sau đó
nhấn .
• Thao tác này trở về màn hình mục menu ở bước 1, trong đó nút radio

bên cạnh mục menu bạn đã chọn trước đó chuyển thành .

Cuộn giữa các màn hình

Một thanh cuộn sẽ xuất hiện dọc theo phía bên phải của màn hình khi có
quá nhiều mục menu không vừa trên một màn hình.
• Sử dụng  và  để cuộn giữa các màn hình.
• Sử dụng  và  để cuộn từng dòng.

Để đóng menu và trở về màn hình hiển thị trước menu

Nhấn .

Lưu ý

• Bạn có thể đóng menu được hiển thị bằng cách nhấn , , , , , hoặc
 bằng cách nhấn . Nếu menu được hiển thị là menu xuất hiện ngay sau khi

khởi chạy một ứng dụng máy tính cụ thể hoặc nếu đó là menu dành riêng cho ứng
dụng, bạn không thể đóng menu đó bằng cách nhấn . Trong trường hợp đó, bạn
phải nhấn  để đóng menu.
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Các ứng dụng và menu của
máy tính

Các ứng dụng máy tính

Chọn ứng dụng máy tính
Chọn một ứng dụng máy tính phù hợp với kiểu tính toán bạn muốn thực
hiện.
1. Nhấn  để hiển thị màn hình HOME.

• Để biết thông tin về từng ứng dụng máy tính, vui lòng xem "Danh
sách ứng dụng máy tính đã cài đặt" (trang 18).

2. Sử dụng các phím con trỏ ( , , , ) để chọn biểu tượng ứng
dụng máy tính bạn muốn.

3. Nhấn  để hiển thị màn hình ban đầu của ứng dụng máy tính có biểu
tượng bạn đã chọn.

Danh sách ứng dụng máy tính đã cài đặt

Biểu tượng Mô tả

(Calculate)*

Tính toán chung

(Statistics)

Tính toán thống kê và hồi quy

(Distribution)

Tính toán phân phối

18



(Spreadsheet)

Tính toán bảng tính

(Table)*

Tạo một bảng số dựa trên một hoặc
hai hàm

(Equation)*

Phương trình đồng thời, phương
trình bậc cao hơn, và Solver (hàm
tìm giá trị của bất kỳ biến nào có
trong phương trình đầu vào)

(Inequality)

Tính toán bất phương trình

(Complex)*

Tính toán số phức

(Base-N)

Tính toán liên quan đến hệ thống
số cụ thể (nhị phân, bát phân, thập
phân, thập lục phân)

(Matrix)

Tính toán ma trận

(Vector)

Tính toán véc-tơ
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(Ratio)

Tính toán tỷ lệ

(Math Box)

Các hàm sau để hỗ trợ việc học
toán.
Dice Roll, Coin Toss: Mô phỏng xác
suất
Number Line: Biểu đồ trục số cho tối
đa ba đẳng thức hoặc bất đẳng thức
Circle: Góc và giá trị lượng giác
được thể hiện bằng hình Unit Circle
hoặc Half Circle. Các góc cũng có
thể được thể hiện bằng hình Clock.

Lưu ý

• Verify, hàm xác định tính đúng sai của phương trình hoặc nghiệm đã nhập, khả dụng
với các ứng dụng máy tính được đánh dấu hoa thị (*) trong bảng trên. Để biết thông
tin về Verify, vui lòng xem "Sử dụng Verify" (trang 73).

Sử dụng menu SETTINGS
Để hiển thị menu SETTINGS, nhấn  trong khi sử dụng ứng dụng máy
tính. Menu SETTINGS bao gồm các mục menu dưới đây.

Calc Settings
Bao gồm các mục menu để cấu hình các cài đặt
tính toán, chẳng hạn như dạng thức hiển thị cho
kết quả tính toán.

System Settings
Bao gồm các mục menu để cấu hình các cài đặt
thao tác của máy tính, chẳng hạn như điều chỉnh
độ tương phản.

Reset
Bao gồm các mục menu để thực hiện các thao
tác cài đặt lại khác nhau.
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Get Started
Hiển thị màn hình Get Started. Để biết thêm
thông tin, vui lòng xem "Màn hình "Get Started"
của máy tính" (trang 9).

Lưu ý

• Nhấn  trong khi màn hình HOME được hiển thị sẽ hiển thị màn hình Get Started
thay cho menu SETTINGS.

• Tùy thuộc vào màn hình được hiển thị bởi ứng dụng máy tính, nhấn  có thể không
hiển thị menu SETTINGS.

Thay đổi cài đặt của máy tính
1. Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
2. Nhấn  để hiển thị menu SETTINGS.

3. Sử dụng  và  để chọn Calc Settings hoặc System Settings, sau đó
nhấn .
• Thao tác này sẽ hiển thị danh sách các mục cài đặt có trong menu đã

chọn.
Màn hình ở đây cho thấy ví dụ về màn hình xuất hiện khi [Calc
Settings] được chọn.

• Vui lòng xem "Tùy chọn các mục và cài đặt sẵn có" (trang 22)
để biết về các mục cài đặt sẵn có cho [Calc Settings] và [System
Settings].

4. Sử dụng  và  để đánh dấu mục có cài đặt bạn muốn thay đổi, sau
đó nhấn .
• Thao tác này sẽ hiển thị danh sách các tùy chọn cài đặt cho mục bạn

đã chọn.
Màn hình ở đây cho thấy ví dụ về màn hình xuất hiện khi [Input/
Output] được chọn.

5. Sử dụng  và  để đánh dấu tùy chọn bạn muốn, sau đó nhấn .
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6. Sau khi thiết đặt theo ý của bạn, nhấn .

Tùy chọn các mục và cài đặt sẵn có
"◆" cho biết cài đặt mặc định ban đầu.

Calc Settings > Input/Output

Chỉ định định dạng để máy tính sử dụng cho đầu vào biểu thức và đầu ra
kết quả tính toán.

MathI/MathO◆ Nhập vào: Dạng sách giáo khoa;
Đầu ra: Định dạng có chứa phân
số, √ , và/hoặc π*1

MathI/DecimalO
Nhập vào: Dạng sách giáo khoa;
Đầu ra: Chuyển đổi thành giá trị
thập phân

LineI/LineO
Nhập vào: Tuyến tính*2; Đầu ra:
Số thập phân hoặc phân số

LineI/DecimalO
Nhập vào: Tuyến tính*2; Đầu ra:
Chuyển đổi thành giá trị thập phân

*1 Áp dụng đầu ra thập phân khi không thể xuất ra các định dạng này vì lý
do nào đó.

*2 Tất cả các phép tính, gồm cả phân số và hàm số sẽ được nhập trong
một dòng. Định dạng đầu ra tương tự như định dạng cho các mẫu máy
không có Hiển thị như sách giáo khoa (các mẫu máy S-V.P.A.M., v.v...)

Ví dụ về hiển thị định dạng đầu vào/đầu ra:

MathI/MathO
(cài đặt mặc định ban đầu)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)
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LineI/LineO

LineI/DecimalO
(Number Format: Norm 1)

Calc Settings > Angle Unit

Degree◆; Radian; Gradian
Chỉ định độ, radian hoặc gradian làm đơn vị góc cho hiển thị giá trị nhập
và kết quả tính toán.

Calc Settings > Number Format

Chỉ định số chữ số cho hiển thị kết quả tính toán.
Fix: Giá trị bạn xác định (từ 0 tới 9) kiểm soát số các vị trí thập phân cho
kết quả tính toán được hiển thị. Kết quả tính toán được làm tròn tới chữ
số đã xác định trước khi được hiển thị.

Ví dụ: 1 ÷ 6
(Fix 3)

1 6 ( )*

Sci: Giá trị bạn xác định (từ 1 tới 10) kiểm soát số các chữ số có nghĩa
cho kết quả tính toán được hiển thị. Kết quả tính toán được làm tròn tới
chữ số đã xác định trước khi được hiển thị.

Ví dụ: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: Hiển thị kết quả tính toán ở dạng số mũ khi chúng nằm trong
khoảng bên dưới.
Norm 1◆: 10-2 > |x|, |x| ≥ 1010, Norm 2: 10-9 > |x|, |x| ≥ 1010

Ví dụ: 1 ÷ 200
(Norm 1)
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1 200 ( )*

(Norm 2)

1 200 ( )*

* Nhấn ( ) thay cho  sau khi nhập phép tính sẽ hiển thị kết quả
tính toán dưới dạng thập phân.

Calc Settings > Engineer Symbol

On; Off◆
Chỉ định có hiển thị kết quả tính toán bằng ký hiệu kỹ thuật hay không.

Lưu ý

• Chỉ báo (E) được hiển thị ở phía trên cùng của màn hình trong khi On được chọn cho
cài đặt này.

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆
Chỉ định hỗn số hoặc phân số có thể viết thành hỗn số cho hiển thị phân
số trong kết quả tính toán.

Calc Settings > Complex Result

a+bi◆; r∠θ
Chỉ định tọa độ hình chữ nhật hoặc tọa độ cực cho kết quả tính toán của
ứng dụng Complex và các nghiệm đa thức của ứng dụng Equation.

Lưu ý

• Chỉ báo i được hiển thị ở phía trên cùng của màn hình trong khi a+bi được chọn cho
cài đặt Complex Result. ∠ sẽ hiển thị khi r∠θ được chọn.

Calc Settings > Decimal Mark

Dot◆; Comma
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Chỉ định sử dụng dấu chấm hoặc dấu phẩy cho dấu thập phân trong kết
quả tính toán. Dấu chấm luôn được hiển thị trong quá trình nhập. Khi dấu
chấm được chọn làm dấu thập phân, dấu phân cách cho nhiều kết quả
là dấu phẩy (,). Khi dấu phẩy được chọn, dấu phân cách sẽ là dấu chấm
phẩy (;).

Calc Settings > Digit Separator

On; Off◆
Chỉ định có nên sử dụng ký tự phân cách trong kết quả tính toán hay
không.

System Settings > Contrast

Vui lòng xem "Điều chỉnh độ tương phản hiển thị" (trang 14).

System Settings > Auto Power Off

10 Min.◆; 60 Min.
Chỉ định khoảng thời gian cho đến khi Auto Power Off được kích hoạt.

System Settings > Language

English◆; Tiếng Việt
Chỉ định ngôn ngữ sử dụng cho các menu và thông báo của máy tính.

System Settings > QR Code

Chỉ định phiên bản của QR Code hiển thị khi nhấn (QR).
Version 3: Cho biết QR Code Phiên bản 3.
Version 11◆: Cho biết QR Code Phiên bản 11.

Reset > Settings & Data

Vui lòng xem "Để khởi động các cài đặt của máy tính" (trang 26).

Reset > Variable Memory

Vui lòng xem "Xoá nội dung của mọi bộ nhớ" (trang 40).
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Reset > Initialize All

Vui lòng xem "Khởi động máy tính" (trang 8).

Get Started

Vui lòng xem "Màn hình "Get Started" của máy tính" (trang 9).

Để khởi động các cài đặt của máy tính

Quan trọng!

• Quy trình dưới đây sẽ khởi động tất cả cài đặt của máy tính, ngoại trừ Contrast, Auto
Power Off, và Language. Đồng thời cũng xóa tất cả dữ liệu ngoại trừ dữ liệu bộ nhớ
biến, Ans và PreAns.

1. Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
2. Nhấn , sau đó chọn [Reset] > [Settings & Data] > [Yes].

• Thao tác này sẽ hiển thị màn hình HOME.

Sử dụng menu CATALOG
Nhấn  để hiển thị menu CATALOG. Menu này hiển thị các danh mục
lệnh, hàm và ký hiệu phù hợp với ứng dụng máy tính bạn đang sử dụng
và trạng thái hiện tại (màn hình được hiển thị hoặc cài đặt hiện tại) của
ứng dụng.

Ví dụ: Menu CATALOG của ứng dụng Calculate

Lưu ý

• Để biết thông tin về cách nhập các lệnh, hàm, và ký hiệu từ menu CATALOG, vui lòng
xem "Tính toán nâng cao" (trang 51).

• Để biết thông tin về các lệnh, hàm và ký hiệu cụ thể cho từng ứng dụng máy tính, vui
lòng tham khảo mô tả ứng dụng máy tính trong "Sử dụng các ứng dụng máy tính"
(trang 79).
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Sử dụng menu TOOLS
Menu TOOLS xuất hiện khi bạn nhấn  sẽ bao gồm các mục menu dùng
để thực hiện chức năng dành riêng cho từng ứng dụng máy tính và để
cấu hình các cài đặt.

Ví dụ: Menu TOOLS cho ứng dụng Calculate

Ví dụ: Menu TOOLS cho ứng dụng Table

Lưu ý

• Các mục menu dưới đây là mục chung cho nhiều ứng dụng máy tính.
- Undo (Vui lòng xem "Hoàn tác thao tác" (trang 30).)
- Verify ON, Verify OFF (Vui lòng xem "Sử dụng Verify" (trang 73).)
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Nhập biểu thức và giá trị

Các quy tắc nhập cơ bản
Khi bạn nhấn , thứ tự ưu tiên của tính toán đầu vào sẽ được đánh giá
tự động và kết quả sẽ xuất hiện trên màn hình.

4 × sin 30 × (30 + 10 × 3) = 120

*1 Việc nhập dấu ngoặc đóng là bắt buộc đối với hàm sin và các hàm khác
có chứa dấu ngoặc đơn.

*2 Có thể bỏ qua các ký hiệu phép nhân (×).
*3 Có thể bỏ qua dấu ngoặc đóng ngay trước thao tác .

Di chuyển con trỏ đến vị trí đầu hoặc cuối của biểu thức đầu
vào

Khi nhập một biểu thức, bạn có thể nhấn  để di chuyển con trỏ đến đầu
biểu thức, hoặc nhấn  để di chuyển con trỏ đến cuối biểu thức.

Biểu thức đầu vào và chỉ báo "Khác" cho kết quả tính toán
(  , )

Nếu bạn thấy biểu tượng chỉ hướng (  hoặc ) ở bên phải của dòng
biểu thức đầu vào hoặc dòng kết quả tính toán, nghĩa là dòng hiển thị vẫn
còn tiếp tục ở bên phải. Sử dụng  và  để cuộn dòng này sang trái và
phải.
• Khi bạn thấy  ở đầu cuối bên phải của dòng kết quả tính toán, bạn

có thể chuyển đến cuối kết quả bằng cách nhấn . Để chuyển đến đầu
dòng kết quả tính toán, nhấn .

• Lưu ý rằng nếu bạn muốn cuộn biểu thức đầu vào trong khi cả hai chỉ
báo và  cùng được hiển thị, bạn phải nhấn  hoặc  trước, sau
đó sử dụng  và  để cuộn.
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Tự động hoàn thành dấu ngoặc đơn

Nếu bạn thực hiện một bài toán có cả phép chia và phép nhân nhưng dấu
nhân đã được giản lược, khi đó các dấu ngoặc đơn sẽ được tự động chèn
vào như ví dụ dưới đây.
- Khi thiếu dấu nhân ngay trước dấu mở ngoặc hoặc sau dấu đóng ngoặc.

Ví dụ: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))
- Khi thiếu dấu nhân ngay trước một biến, một hằng số, v.v...

Ví dụ: 6 ÷ 2π → 6 ÷ (2π)

Chỉ báo giới hạn đầu vào

Con trỏ sẽ thay đổi hình dạng thành  khi còn lại từ 10 byte trở xuống giá
trị đầu vào được phép nhập. Nếu điều này xảy ra, hãy dừng nhập phép
tính và sau đó nhấn .

Nhập biểu thức tính toán sử dụng
Định dạng sách giáo khoa (chỉ có ở
MathI/MathO hoặc MathI/DecimalO)
Có thể nhập biểu thức bao gồm các phân số và/hoặc các hàm đặc biệt
như √  ở định dạng sách giáo khoa bằng cách sử dụng những mẫu xuất
hiện khi nhấn một số phím nhất định, hoặc khi bạn nhập vào một số hàm
nhất định từ menu CATALOG.

Ví dụ: 3 1
2  + 5 3

2
1. Nhấn ( ).

• Thao tác này sẽ nhập một mẫu hỗn số.

2. Nhập các giá trị vào vùng nhập số nguyên, tử số và mẫu số của mẫu.

3 1 2

3. Thực hiện tương tự để nhập phần còn lại của biểu thức.

( )5 3 2
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Lưu ý

• Khi con trỏ nhập vào nằm trong vùng nhập giá trị của mẫu (hỗn số, tích phân (∫), tổng
(Σ) và tích (Π)), nhấn  để di chuyển con trỏ đến vị trí ngay sau (bên phải) mẫu,
hoặc nhấn  để di chuyển con trỏ đến vị trí ngay trước (bên trái) mẫu.

• Bạn luôn có thể nhận ra vị trí hiện tại của con trỏ trong một mẫu, vì vị trí con trỏ ở
vùng có khung còn trống hoặc ký tự sẽ có màu đen đậm. Những phần khác trong biểu
thức tính toán sẽ có màu xám đậm.

Hoàn tác thao tác
Để hoàn tác thao tác phím cuối cùng, nhấn , chọn [Undo], sau đó nhấn

.
Để thực hiện lại thao tác phím bạn vừa hoàn tác, nhấn , chọn [Undo],
sau đó nhấn  lần nữa.

Sử dụng các giá trị và biểu thức như đối số

Ví dụ: Để nhập 1 + 7
6 , sau đó đổi thành 1 + 

1 7 6 (INS)

Thao tác nhấn (INS) trong ví dụ trên sẽ làm cho 7
6  trở thành đối số

của hàm được nhập vào bằng thao tác phím tiếp theo (√ ).

Phương thức nhập ghi đè (Chỉ có ở
LineI/LineO hoặc LineI/DecimalO)
Trong phương thức ghi đè, văn bản bạn nhập vào sẽ thay thế cho văn bản
tại vị trí con trỏ hiện tại. Bạn có thể chuyển đổi giữa phương thức chèn
thêm và ghi đè bằng cách thực hiện các thao tác: (INS). Con trỏ sẽ
xuất hiện ở dạng " " trong phương thức chèn thêm và ở dạng " " trong
phương thức ghi đè.
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Tính toán cơ bản

Phép tính số học
Sử dụng các phím , , , và  để thực hiện các phép tính số học.

Ví dụ: 7 × 8 - 4 × 5 = 36

7 8 4 5

Phép tính phân số
Lưu ý rằng phương thức nhập cho phân số phụ thuộc vào cài đặt Input/
Output hiện tại trên menu SETTINGS.

Để nhập 7
3  (phân số có thể viết thành hỗn số)

(Input/Output: MathI/MathO hoặc MathI/DecimalO)

7 3 hoặc 7 3 7
3

(Input/Output: LineI/LineO hoặc LineI/DecimalO)

7 3

(a) Tử số, (b) Mẫu số

Để nhập 2 1
3  (hỗn số)

(Input/Output: MathI/MathO hoặc MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO hoặc LineI/DecimalO)
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2 1 3

(a) Tử số, (b) Mẫu số, (c) Phần số nguyên

Ví dụ: 2
3  + 1 1

2  = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

Lưu ý

• Phân số trong kết quả tính toán được hiển thị sau khi được rút gọn về dạng phân số
tối giản.

Để chuyển đổi dạng thức kết quả tính toán sang phân số có thể viết
thành hỗn số hoặc hỗn số, nhấn . Để biết thêm thông tin, vui lòng xem
"Chuyển đổi phân số có thể viết thành hỗn số và phân số hỗn hợp"
(trang 47).

Kết quả tính toán dạng phân số

Không thể hiển thị kết quả tính toán có tổng số chữ số của hỗn số (bao
gồm cả số nguyên, tử số, mẫu số và ký hiệu phân tách ) lớn hơn 10
bằng dạng phân số. Trong trường hợp này, kết quả tính toán được hiển thị
dưới dạng giá trị thập phân.

Ví dụ 1: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

Vì tổng số chữ số của giá trị 1 1 123456 là 10, kết quả được hiển thị
dưới dạng giá trị phân số.
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Ví dụ 2: 1 1 1234567 (= 1234568 1234567) = 1,00000081

(Input/Output: LineI/LineO)

1 1 1234567

Vì tổng số chữ số của giá trị 1 1 1234567 là 11, kết quả được hiển thị
dưới dạng giá trị thập phân.

Lưu ý

• Phép tính có hỗn số và giá trị thập phân sẽ hiển thị kết quả dưới dạng giá trị thập
phân khi chọn một chế độ khác với MathI/MathO.

Lũy thừa, lũy thừa căn, và nghịch
đảo
Sử dụng các phím dưới đây để nhập hàm lũy thừa, hàm lũy thừa căn, và
hàm nghịch đảo.
Các hàm lũy thừa: (lũy thừa bậc hai), (lũy thừa bậc n)
Các hàm lũy thừa căn: (căn bậc hai), ( ) (căn bậc n)
Hàm nghịch đảo: ( )

Ví dụ 1: (52)3 = 15625

5 3

Ví dụ 2: (1 + 1)2+2 = 16

1 1 2 2

Ví dụ 3: √2 × 3 = 3√2 = 4,242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)
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2 3

Ví dụ 4: 5√32 = 2
(Input/Output: MathI/MathO)

( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

Ví dụ 5: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

Phím  (Lũy thừa của 10)

Việc nhấn phím  giống như nhấn . Cả hai thao tác nhập
"×10 " (MathI/MathO hoặc MathI/DecimalO) hoặc "×10^(" (LineI/LineO
hoặc LineI/DecimalO).

Ví dụ: 1,23 × 103 = 1230

1 23 3

Miền tính toán dạng √ 

Miền hiển thị cho phép của kết quả tính toán dạng √  được thể hiện dưới
đây.

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100
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Ví dụ:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... Được thể hiện ở dạng √ 
• 99√999 (= 297√111) = 3129,089165 ... Được hiển thị dưới dạng giá trị

thập phân

Số Pi, cơ số lôgarit tự nhiên e

Số Pi
Nhập π bằng cách nhấn (π).
π được hiển thị là 3,141592654, nhưng giá trị π =
3,1415926535897932384626 được sử dụng để tính toán nội bộ.

Cơ số lôgarit tự nhiên e
Nhập e bằng cách nhấn (e).
Cơ số lôgarit tự nhiên e được hiển thị là 2,718281828, nhưng giá trị e =
2,7182818284590452353602 được sử dụng để tính toán nội bộ.

Lịch sử và hiển thị lại phép tính

Lịch sử tính toán
Dấu  và/hoặc  ở phía trên cùng của màn hình chỉ ra rằng có thêm nội
dung lịch sử tính toán ở trên và/hoặc dưới. Bạn có thể cuộn các nội dung
lịch sử tính toán bằng cách sử dụng  và .

Ứng dụng hỗ trợ lịch sử tính toán:
Calculate, Complex, Base-N

Ví dụ
2 + 2 = 4

2 2

3 + 3 = 6

3 3
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(Cuộn lại.)

Lưu ý

• Tất cả dữ liệu lịch sử tính toán đều bị xóa bất cứ khi nào bạn nhấn  hoặc , khi
bạn thay đổi cài đặt Input/Output, hoặc bất cứ khi nào bạn thực hiện thao tác Reset
("Settings & Data" hoặc "Initialize All").

Hiển thị lại
Khi kết quả tính toán hiển thị trên màn hình, bạn có thể nhấn ,  hoặc

 để chỉnh sửa biểu thức bạn đã dùng cho phép tính trước đó.

Ví dụ
4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(Tiếp tục)  7

Lưu ý

• Nếu dấu  (trái) hoặc  (phải) hiển thị ở một trong hai đầu hoặc cả hai đầu của
dòng kết quả tính toán, bạn có thể sử dụng  và  để cuộn dòng sang trái và phải.
Nếu điều này xảy ra, nhấn  hoặc  trước tiên, sau đó sử dụng  và  để
chỉnh sửa biểu thức đó.

Sử dụng chức năng bộ nhớ

Bộ nhớ trả lời (Ans)/Bộ nhớ trả lời trước đó
(PreAns)

Kết quả tính toán cuối cùng thu được sẽ được lưu trong bộ nhớ Ans (trả
lời). Kết quả tính toán thu được trước kết quả cuối cùng sẽ được lưu trong
bộ nhớ PreAns (trả lời trước đó). Hiển thị kết quả của phép tính mới sẽ
làm chuyển nội dung hiện tại trong bộ nhớ Ans sang bộ nhớ PreAns và
lưu kết quả phép tính mới vào trong bộ nhớ Ans.
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Lưu ý

• Bộ nhớ PreAns chỉ có thể được sử dụng trong ứng dụng Calculate.
• Nội dung trong bộ nhớ PreAns sẽ bị xóa bất cứ khi nào bạn chuyển sang một ứng

dụng khác ngoài ứng dụng Calculate.

Sử dụng bộ nhớ Ans để thực hiện một loạt các phép tính

Ví dụ: Để chia kết quả của 3 × 4 cho 30

3 4

(Tiếp tục)  30

Nhập nội dung trong bộ nhớ Ans vào biểu thức

Ví dụ: Để thực hiện phép tính dưới đây:

123 456

(Tiếp tục)  789

Sử dụng bộ nhớ PreAns

Ví dụ: Đối với Tk+2 = Tk+1 + Tk (dãy Fibonacci), xác định trình tự dãy số từ
T1 đến T5. Lưu ý rằng T1 = 1 và T2 = 1.
T1 = 1

1

(Ans = T1 = 1)

T2 = 1

1

(Ans = T2 = 1, PreAns = T1 = 1)

T3 = T2 + T1 = 1 + 1

(PreAns)
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(Ans = T3 = 2, PreAns = T2 = 1)

T4 = T3 + T2 = 2 + 1

(Ans = T4 = 3, PreAns = T3 = 2)

T5 = T4 + T3 = 3 + 2

Kết quả: Dãy sẽ là {1, 1, 2, 3, 5}.

Các biến (A, B, C, D, E, F, x, y, z)
Bạn có thể lưu các giá trị cho các biến và sử dụng các biến trong tính
toán.

Màn hình danh sách biến

Nhấn  sẽ hiển thị màn hình hiển thị các giá trị hiện đang được lưu cho
các biến A, B, C, D, E, F, x, y, và z. Trên màn hình này, các giá trị luôn
được hiển thị bằng cách sử dụng Number Format là "Norm 1". Để đóng
màn hình, nhấn  hoặc .

Ví dụ 1: Để lưu kết quả của 3 + 5 cho biến A
1. Thực hiện phép tính.

3 5

2. Nhấn , sau đó chọn [A=] > [Store].
• Thao tác này sẽ lưu trữ kết quả của 3 + 5 (là 8) cho biến A.

3. Nhấn .
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Ví dụ 2: Để thay đổi nội dung của biến A thành 1
1. Nhấn , sau đó đánh dấu vào [A=].

2. Nhấn .
• Thao tác này sẽ hiển thị màn hình chỉnh sửa với 1 được nhập vào.

3. Nhấn .

Lưu ý

• Thay cho thao tác ở bước 2 nêu trên, bạn có thể nhấn  và sau đó chọn [Edit]. Thao
tác này sẽ hiển thị màn hình chỉnh sửa mà không có số nào được nhập vào. Nhập giá
trị bạn muốn và sau đó nhấn .

• Nếu biểu tượng khóa ( ) xuất hiện khi bạn đánh dấu một biến trên màn hình danh
sách biến, điều đó có nghĩa là không thể chỉnh sửa biến được đánh dấu.

Ví dụ 3: Để xem lại giá trị của biến nhớ A và danh sách giá trị đã lưu ở
các biến nhớ còn lại
(Tiếp tục từ bước 2 của Ví dụ 1)
1. Nhấn , sau đó chọn [A=] > [Recall].

• Thao tác này sẽ nhập "A".

2. Nhấn .
• Thao tác này sẽ hiển thị lại giá trị của biến A.

Ví dụ 4: Để nhân nội dung của biến A với 10
(Tiếp tục từ bước 2 của Ví dụ 1)
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(A)* 10

* Nhập biến như đã minh họa ở đây: nhấn  và sau đó nhấn phím tương
ứng với tên biến mong muốn. Để nhập x làm tên biến, bạn có thể nhấn

(x) hoặc .

Xoá nội dung của mọi bộ nhớ
Bộ nhớ Ans và nội dung biến vẫn được lưu lại ngay cả khi bạn nhấn ,
thay đổi ứng dụng máy tính, hoặc tắt máy tính.
Nội dung bộ nhớ PreAns vẫn được lưu lại ngay cả khi bạn nhấn  và tắt
máy tính mà không thoát khỏi ứng dụng Calculate.
Thực hiện quy trình sau khi bạn muốn xoá nội dung của tất cả các bộ nhớ.
1. Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
2. Nhấn , sau đó chọn [Reset] > [Variable Memory] > [Yes].

Sử dụng CALC
CALC cho phép bạn nhập các biểu thức tính toán bao gồm một hoặc
nhiều biến, lưu các giá trị cho các biến, và tính toán kết quả.
CALC chỉ có thể được sử dụng trong ứng dụng Calculate.
Định dạng của biểu thức có thể được tính toán với CALC được thể hiện
dưới đây.

A+3, 2x + 3y, 2Ax + 3By + C, v.v...

Ví dụ: Để nhập 3A + B rồi thế vào các giá trị sau để thực hiện tính toán: A
= 5, B = 10 (Input/Output: MathI/MathO)
1. Sử dụng theo thao tác phím bên dưới để nhập 3A+B.

3 (A) (B)

2. Nhấn , sau đó chọn [CALC].

3. Nhập giá trị cho A và B, sau đó thực hiện tính toán.

5 10
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• Thao tác này sẽ hiển thị màn hình kết quả tính toán CALC. Bạn có
thể nhấn  trong khi màn hình này được hiển thị để trở về màn hình
ở bước 2, bước mà bạn có thể lưu một giá trị khác cho biến và lặp lại
phép tính.

Lưu ý

• Khi lưu một giá trị cho biến trong bước 3 ở trên, việc nhập sẽ luôn là nhập tuyến
tính bất kể cài đặt Input/Output của menu SETTINGS. Để biết thông tin về cài đặt
Input/Output, vui lòng xem "Tùy chọn các mục và cài đặt sẵn có" (trang 22).
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Thay đổi dạng thức kết quả
tính toán

Sử dụng menu FORMAT
Bạn có thể sử dụng menu FORMAT xuất hiện khi bạn nhấn  để chuyển
đổi kết quả tính toán được hiển thị sang các dạng thức khác nhau.

Danh sách menu FORMAT

Mục menu này: Chuyển đổi sang dạng thức này:

Standard
Standard (Gồm dạng thức phân số, π,
√ .)

Decimal Thập phân

Prime Factor Phân tích thành thừa số nguyên tố

Recurring Decimal Số thập phân tuần hoàn

Rectangular Coord Tọa độ hình chữ nhật

Polar Coord Tọa độ cực

Improper Fraction Phân số có thể viết thành hỗn số

Mixed Fraction Hỗn số

ENG Notation
Ký pháp kỹ thuật (dạng thức a×10n,
với n = số mũ chia hết cho 3)

Sexagesimal Độ, phút, giây (Hệ lục thập phân)
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Lưu ý

• Các mục menu xuất hiện khi nhấn  sẽ tuỳ thuộc vào kết quả tính toán đang được
hiển thị. Ngoài ra, nếu kết quả tính toán không thể chuyển đổi được hiển thị, menu sẽ
không xuất hiện khi bạn nhấn .

Thao tác mẫu về chuyển đổi

Ví dụ: 3 ÷ 2 = 3
2  = 1,5 = 1 1

2
Trong ví dụ này, chúng ta sẽ chuyển đổi kết quả tính toán được hiển thị
dưới dạng phân số có thể viết thành hỗn số sang một giá trị thập phân,
sau đó sang hỗn số. Cuối cùng, chúng ta sẽ hủy chuyển đổi và quay lại
kết quả tính toán ban đầu.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. Thực hiện phép tính 3 ÷ 2.

3 2

2. Để chuyển đổi kết quả tính toán sang giá trị thập phân, nhấn , chọn
[Decimal], sau đó nhấn .

3. Để chuyển đổi kết quả tính toán sang hỗn số, nhấn , chọn [Mixed
Fraction], sau đó nhấn .

4. Để hủy chuyển đổi, nhấn .
• Thao tác này sẽ hiển thị kết quả tính toán ban đầu ở bước 1.
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Chuyển đổi Standard và Decimal
Standard là một dạng thức hiển thị kết quả tính toán dưới dạng có chứa
phân số, √ , hoặc π nếu có thể. Decimal là một dạng thức hiển thị kết quả
tính toán dưới dạng giá trị thập phân.

Lưu ý

• Có thể chuyển đổi sang dạng thức Standard có chứa √  hoặc π khi MathI/MathO hoặc
MathI/DecimalO được chọn cho cài đặt Input/Output trên menu SETTINGS.

Bạn có thể sử dụng thao tác bên dưới để chuyển đổi kết quả tính toán
sang dạng thức Standard hoặc Decimal.

Ví dụ: π ÷ 6 = 1
6  π = 0,5235987756 (Input/Output: MathI/MathO)

(π) 6

(Chọn [Decimal].)

(Chuyển đổi sang giá trị thập phân.)

(Chuyển đổi sang dạng thức Standard.)

Quan trọng!

• Với một số kết quả tính toán, việc chọn [Standard] trên menu FORMAT sẽ không
chuyển đổi giá trị đã hiển thị.

Để thu được kết quả hiển thị là số thập phân khi đang ở chế
độ MathI/MathO hoặc LineI/LineO

Nhấn ( ) thay vì  sau khi nhập một phép tính.
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Phân tích thành thừa số nguyên tố
Trong ứng dụng Calculate, số nguyên dương dài không quá 10 chữ số có
thể được phân tích thành thừa số nguyên tố.

Ví dụ: Để thực hiện phân tích thành thừa số nguyên tố đối với 1014

1014

 – [Prime Factor]

Lưu ý

• Không thể phân tích các loại giá trị được mô tả bên dưới, cho dù chúng có từ 10 chữ
số trở xuống.
- Một thừa số trong các thừa số nguyên tố có giá trị từ 1.018.081 trở lên.
- Hai hay nhiều thừa số trong các thừa số nguyên tố của giá trị có nhiều hơn ba chữ

số.
• Phần không thể phân tích sẽ được đặt trong dấu ngoặc đơn trên màn hình.

Ví dụ: 2036162 = 2 × (1018081)*
*1018081 = 10092

2036162
 – [Prime Factor]

Chuyển đổi số thập phân tuần hoàn
(Phép tính số thập phân tuần hoàn)
Máy tính này cho phép bạn chuyển đổi kết quả tính toán sang dạng thức
thập phân tuần hoàn trong ứng dụng Calculate, nếu có thể. Bạn cũng có
thể nhập một giá trị thập phân tuần hoàn và thực hiện tính toán.

Chuyển đổi kết quả tính toán sang giá trị thập
phân tuần hoàn

Để chuyển đổi kết quả tính toán sang giá trị thập phân tuần hoàn, nhấn
, sau đó chọn [Recurring Decimal] từ menu FORMAT xuất hiện. Để biết

thao tác thực tế, vui lòng xem "Ví dụ về phép tính số thập phân tuần
hoàn" (trang 46).
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Nhập số thập phân tuần hoàn
Để nhập một giá trị thập phân tuần hoàn, sử dụng mục menu CATALOG
như dưới đây.

– [Numeric Calc] > [Recurring Decimal]
Để biết thao tác thực tế, vui lòng xem "Ví dụ về phép tính số thập phân
tuần hoàn" (trang 46).

Quan trọng!

• Nếu giá trị bắt đầu bằng một phần số nguyên (như: 12,3123123...), không đưa phần
số nguyên vào khi thêm dấu phân cách (12.(312)).

• Chỉ có thể nhập số thập phân tuần hoàn khi MathI/MathO hoặc MathI/DecimalO được
chọn cho Input/Output trên menu SETTINGS.

Ví dụ về phép tính số thập phân tuần hoàn
Để tính 3.(021) + 0.(312) (Input/Output: MathI/MathO)
1. Thực hiện thao tác sau để nhập biểu thức tính toán.

3  – [Numeric Calc] >
[Recurring Decimal] 021

0  – [Numeric Calc] >
[Recurring Decimal] 312

• Thao tác này sẽ hiển thị kết quả tính toán dưới dạng phân số.

2. Nhấn , sau đó chọn [Recurring Decimal].
• Điều này sẽ thay đổi dạng thức kết quả sang số thập phân tuần hoàn.

• Để trả kết quả tính toán về dạng phân số, chọn  – [Standard].

Lưu ý

• Chỉ có kết quả tính toán thỏa mãn các điều kiện sau mới có thể được hiển thị dưới
dạng số thập phân tuần hoàn.
- Tổng số chữ số được sử dụng trong hỗn số (bao gồm số nguyên, tử số, mẫu số và

ký hiệu phân tách) không được lớn hơn 10.
- Kích thước dữ liệu của giá trị khi hiển thị dưới dạng số thập phân tuần hoàn không

được lớn hơn 99 byte, được tính như sau: [số chữ số (mỗi chữ số 1 byte)] + [1 byte
cho dấu thập phân] + [3 byte cho mã quản lý số thập phân tuần hoàn]. Ví dụ, kích
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thước dữ liệu của số 0.(123) sẽ gồm 4 byte cho các chữ số, 1 byte cho dấu thập
phân, và 3 byte cho mã quản lý số thập phân tuần hoàn, tổng cộng là 8 byte.

Chuyển đổi tọa độ hình chữ nhật và
tọa độ cực
Bạn có thể chuyển đổi kết quả tính toán số phức sang tọa độ hình chữ
nhật (  – [Rectangular Coord]) hoặc tọa độ cực (  – [Polar Coord]). Có
thể thực hiện thao tác chuyển đổi này đối với một trong các trường hợp
sau:
• Khi một nghiệm phương trình bậc cao hơn của ứng dụng Equation

được hiển thị (với điều kiện là On được chọn cho cài đặt  – [Complex
Roots] của ứng dụng Equation)

• Khi kết quả tính toán ứng dụng Complex được hiển thị

Để biết thao tác chuyển đổi mẫu thực tế, vui lòng xem các phần bên dưới.
"Chuyển đổi nghiệm số phức thành tọa độ hình chữ nhật hoặc tọa
độ cực" (trang 119)
"Chuyển đổi kết quả tính toán số phức thành tọa độ hình chữ nhật
hoặc tọa độ cực" (trang 127)

Chuyển đổi phân số có thể viết
thành hỗn số và phân số hỗn hợp
Bạn có thể chuyển đổi kết quả tính toán ở dạng phân số hoặc giá trị thập
phân (giá trị thập phân có thể đổi thành phân số bằng máy tính này) đang
được hiển thị thành một hỗn số hoặc phân số có thể viết thành hỗn số.

Ví dụ 1: 13
4  = 3 1

4
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

Ví dụ 2: 3,25 = 13
4  = 3 1

4  (Input/Output: LineI/LineO)

3 25
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 – [Improper Fraction]

 – [Mixed Fraction]

Ký pháp kỹ thuật
Bạn có thể chuyển đổi phần số mũ của giá trị kết quả tính toán được hiển
thị thành mũ mười và là bội số của 3, sau đó hiển thị kết quả.

Ví dụ: Biến đổi giá trị 1234 sang ký pháp kỹ thuật, dịch chuyển dấu thập
phân sang phải, sau đó sang trái.
1. Nhập 1234, sau đó nhấn .

2. Thực hiện thao tác dưới đây để vào Chế độ chuyển đổi ENG.

 – [ENG Notation]

• Việc vào Chế độ chuyển đổi ENG sẽ làm chuyển đổi kết quả tính toán
sang ký pháp kỹ thuật và làm cho dấu  xuất hiện bên phải.

• Trong Chế độ chuyển đổi ENG, bạn có thể sử dụng  và  để thay
đổi dấu thập phân của phần định trị.

3. Để thoát khỏi Chế độ chuyển đổi ENG, nhấn .
• Thao tác này sẽ thoát khỏi Chế độ chuyển đổi ENG và làm cho dấu 

biến mất khỏi màn hình.
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• Bạn cũng có thể thoát khỏi Chế độ chuyển đổi ENG bằng cách nhấn
 hoặc .

Lưu ý

• Không thể thực hiện các phép tính toán thông thường khi đang ở Chế độ chuyển đổi
ENG. Để bắt đầu phép tính mới, hãy thoát khỏi Chế độ chuyển đổi ENG.

• Ký pháp kỹ thuật cũng có thể được hiển thị bằng ký hiệu kỹ thuật. Để biết chi tiết, vui
lòng xem "Ký hiệu kỹ thuật" (trang 64).

Chuyển đổi hệ lục thập phân (Phép
tính độ, phút, giây)
Bạn có thể chuyển đổi kết quả tính toán giá trị thập phân sang giá trị lục
thập phân.

Chuyển đổi kết quả tính toán giá trị thập phân
sang giá trị lục thập phân

Ví dụ: 1,25 = 1°15’0”

1 25

 – [Sexagesimal]

Nhập và tính bằng giá trị lục thập phân
Ngoài việc chuyển đổi giá trị được hiển thị sang giá trị lục thập phân, bạn
cũng có thể nhập các giá trị lục thập phân và sử dụng chúng trong các
phép tính.
Cú pháp sau dùng để nhập một giá trị lục thập phân:

{độ} ( ) {phút} ( ) {giây} ( )
Lưu ý rằng bạn phải luôn nhập nội dung cho độ và phút, ngay cả khi
chúng bằng không.

Ví dụ: Để thực hiện phép tính 2°20’30” + 9’30”. Tiếp theo, chuyển đổi kết
quả tính toán sang giá trị thập phân.

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )
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(Chuyển đổi sang giá trị thập phân.)
 – [Decimal]

(Trả về dạng hiển thị hệ lục thập phân.)
 – [Sexagesimal]
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Tính toán nâng cao
Phần này mô tả các lệnh, hàm và ký hiệu chung cho tất cả ứng dụng của
máy tính. Thứ tự được sử dụng ở đây trình bày các lệnh, hàm, và ký hiệu
giống như thứ tự mà chúng được hiển thị trên menu CATALOG xuất hiện
khi bạn nhấn .

Lưu ý

• Ngoài ra còn có các mục menu CATALOG dành riêng cho ứng dụng của máy tính,
không được hiển thị ở đây. Vui lòng xem chương dành cho từng ứng dụng máy tính
để biết thêm thông tin về các mục menu dành riêng cho ứng dụng.

• Tùy thuộc vào ứng dụng máy tính bạn đang sử dụng và màn hình được hiển thị bởi
ứng dụng máy tính, bạn có thể không nhập được một số lệnh, hàm hoặc ký hiệu. Các
lệnh, hàm và ký hiệu không thể nhập sẽ không xuất hiện trên menu CATALOG.

• Các lệnh, hàm và ký hiệu được mô tả ở đây không khả dụng trong ứng dụng Base-N.

Giải tích hàm
Phần này sẽ giải thích các lệnh và hàm bạn có thể nhập sau khi thực hiện
thao tác:  – [Func Analysis].

Derivative(d/dx)
Derivative(d/dx) lấy hệ số vi phân gần đúng tại tọa độ x được chỉ định (a)
trong biểu thức f(x) đầu vào.

Lưu ý

• Hàm này có thể được sử dụng với bất kỳ ứng dụng máy tính nào sau đây: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Cú pháp nhập

Cú pháp nhập phụ thuộc vào cài đặt Input/Output trên menu SETTINGS,
như được thể hiện trong bảng bên dưới.

Cài đặt Input/Output Cú pháp nhập

MathI/MathO hoặc MathI/DecimalO  d
dx (f(x))|x=a
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LineI/LineO hoặc LineI/DecimalO  d
dx (f(x), a, tol)*

* tol chỉ định dung sai, sẽ trở thành 1 × 10-16 khi không nhập gì cho tol.

Những lưu ý khi tính toán đạo hàm

• Khi sử dụng hàm lượng giác trong f(x), hãy chỉ định "Radian" làm Angle
Unit trên menu SETTINGS.

• Giá trị tol nhỏ hơn cho độ chính xác cao hơn, nhưng cũng làm mất
nhiều thời gian tính toán hơn. Khi chỉ định tol, hãy sử dụng giá trị từ 1 ×
10-22 trở lên.

• Kết quả không chính xác và lỗi có thể xảy ra do những yếu tố sau đây:
- các điểm không kế tiếp trong các giá trị x
- sự thay đổi đột ngột trong các giá trị x
- bao hàm điểm cực đại và điểm cực tiểu trong các giá trị x
- bao hàm điểm uốn trong các giá trị x
- bào hàm các điểm không vi phân được trong giá trị x
- kết quả phép tính vi phân gần bằng không

Ví dụ về phép tính đạo hàm

Xác định f’( π
2 ) khi f(x) = sin(x) (Bỏ qua đặc tả tol.)

(Input/Output: MathI/MathO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output: LineI/LineO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
Máy tính này thực hiện tính tích phân theo phương pháp Gauss-Kronrod
của tích phân số.

Lưu ý

• Hàm này có thể được sử dụng với bất kỳ ứng dụng máy tính nào sau đây: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.
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Cú pháp nhập

Cú pháp nhập phụ thuộc vào cài đặt Input/Output trên menu SETTINGS,
như được thể hiện trong bảng bên dưới.

Cài đặt Input/Output Cú pháp nhập

MathI/MathO hoặc MathI/DecimalO

LineI/LineO hoặc LineI/DecimalO

* tol chỉ định dung sai, sẽ trở thành 1 × 10-10 khi không nhập gì cho tol.

Lưu ý khi tính toán tích phân

• Khi sử dụng hàm lượng giác trong f(x), hãy chỉ định "Radian" làm Angle
Unit trên menu SETTINGS.

• Giá trị tol nhỏ hơn cho độ chính xác cao hơn, nhưng cũng làm mất
nhiều thời gian tính toán hơn. Khi chỉ định tol, hãy sử dụng giá trị từ 1 ×
10-22 trở lên.

• Tùy vào nội dung của f(x), các giá trị dương và âm trong khoảng lấy
tích phân hoặc khoảng lấy tích phân, lỗi lớn có thể xảy ra trong các giá
trị tích phân được tính toán. (Ví dụ: Khi có các phần có điểm không kế
tiếp hoặc thay đổi đột ngột. Khi khoảng lấy tích phân quá rộng.) Trong
những trường hợp như vậy, việc chia khoảng lấy tích phân thành nhiều
phần và sau đó thực hiện tính toán có thể cải thiện độ chính xác tính
toán.

Ví dụ về phép tính tích phân

(ln(x), 1, e) = 1 (Bỏ qua đặc tả tol.)

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)
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Summation(Σ)
Với Σ(, bạn có thể tính được tổng của một biểu thức f(x) đầu vào cho một
miền cụ thể.

Lưu ý

• Hàm này có thể được sử dụng với bất kỳ ứng dụng máy tính nào sau đây: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (ngoại trừ Solver), Inequality,
Matrix, Vector, Ratio.

Cú pháp nhập

Cú pháp nhập phụ thuộc vào cài đặt Input/Output trên menu SETTINGS,
như được thể hiện trong bảng bên dưới.

Cài đặt Input/Output Cú pháp nhập

MathI/MathO hoặc MathI/DecimalO

LineI/LineO hoặc LineI/DecimalO

* a và b là các số nguyên có thể được chỉ định trong miền -1 × 1010 < a ≤ b
< 1 × 1010.

Ví dụ về phép tính Σ

(x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5

Product(Π)
Với ∏(, bạn có thể tính được tích của một biểu thức f(x) đầu vào cho một
miền cụ thể.
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Lưu ý

• Hàm này có thể được sử dụng với bất kỳ ứng dụng máy tính nào sau đây: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (ngoại trừ Solver), Inequality,
Matrix, Vector, Ratio.

Cú pháp nhập

Cú pháp nhập phụ thuộc vào cài đặt Input/Output trên menu SETTINGS,
như được thể hiện trong bảng bên dưới.

Cài đặt Input/Output Cú pháp nhập

MathI/MathO hoặc MathI/DecimalO

LineI/LineO hoặc LineI/DecimalO Π(f(x), a, b)*

* a và b là các số nguyên có thể được chỉ định trong miền a < 1 × 1010, b <
1 × 1010, a ≤ b.

Ví dụ về phép tính ∏

(x + 1) = 720

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Product(Π)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Product(Π)]
1 (,)1 (,)5

Remainder
Bạn có thể sử dụng hàm ÷R để tính thương số và số dư trong phép chia.
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Lưu ý

• Hàm này có thể được sử dụng trên màn hình tính toán của các ứng dụng máy tính
bên dưới.
Calculate, Statistics, Matrix, Vector

Ví dụ: Để tính thương số và số dư của 5 ÷ 2 (thương số = 2, số dư = 1)

5  – [Func Analysis] > [Remainder]
2

Lưu ý

• Khi bạn thực hiện phép tính số dư, thương số được lưu trong biến E, trong khi giá trị
số dư được lưu trong biến F.

• Chỉ có giá trị thương số của phép tính ÷R mới được lưu trong bộ nhớ Ans.
• Kết quả tính toán được hiển thị như minh họa trên màn hình ở bên phải khi

LineI/LineO hoặc LineI/DecimalO được chọn cho cài đặt Input/Output trên menu
SETTINGS.

Trường hợp khi phép chia có dư trở thành phép chia không
dư

Nếu phép chia có dư tồn tại một trong những điều kiện sau thì phép tính
sẽ được thực hiện như phép chia bình thường (phép chia không dư).
• Khi số bị chia hoặc số chia có giá trị quá lớn.
• Khi thương số không phải là số nguyên dương, hoặc nếu số dư không

phải là số nguyên dương hoặc giá trị phân số dương.

Logarithm(logab), Logarithm(log)
Sử dụng (log) hoặc  – [Func Analysis] > [Logarithm(log)] để nhập
logab dưới dạng log (a, b). Cơ số 10 là cài đặt mặc định ban đầu nếu bạn
không nhập gì cho a.

Ví dụ 1: log101000 = log 1000 = 3

(log)1000
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Ví dụ 2: log216 = 4

(log)2 (,)16

Phím  (hoặc  – [Func Analysis] > [Logarithm(logab)]) cũng có thể
được sử dụng để nhập, nhưng chỉ trong khi MathI/MathO hoặc MathI/
DecimalO được chọn cho Input/Output trên menu SETTINGS. Trong
trường hợp này, bạn phải nhập một giá trị cho cơ số này.

Ví dụ 3: log216 = 4

2 16

Natural Logarithm
Sử dụng (ln) hoặc  – [Func Analysis] > [Natural Logarithm] để
nhập "ln".

Ví dụ: ln 90 (= loge90) = 4,49980967

(ln)90

Xác suất
Phần này sẽ giải thích các lệnh và hàm bạn có thể nhập sau khi thực hiện
thao tác:  – [Probability].

%
Việc nhập một giá trị sau lệnh % sẽ biến giá trị nhập thành phần trăm.

Lưu ý

• Bạn không thể nhập % bằng ứng dụng Complex.

Ví dụ 1: 150 × 20% = 30

150 20
 – [Probability] > [%]
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Ví dụ 2: Tìm phần trăm của 880 để thu được kết quả là 660. (75%)

660 880
 – [Probability] > [%]

Ví dụ 3: Tìm kết quả còn lại khi giảm đi 25% của 3500. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
Hàm này thu được giai thừa của một giá trị bằng không hoặc một số
nguyên dương.

Ví dụ: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
Hàm hoán vị (nPr) và hàm tổ hợp (nCr)

Ví dụ: Để xác định số các hoán vị và tổ hợp có thể tìm được khi lựa bốn
người từ một nhóm 10 người.

Hoán vị:

10
 – [Probability] > [Permutation(P)]

4

Tổ hợp:

10
 – [Probability] > [Combination(C)]

4

Random Number
Hàm này tạo ra một số giả ngẫu nhiên trong khoảng từ 0,000 đến 0,999.
Kết quả được hiển thị như một phân số khi MathI/MathO được chọn cho
Input/Output trên menu SETTINGS.
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Lưu ý

• Không thể nhập Ran# bằng Solver của ứng dụng Equation.

Ví dụ: Để lấy số nguyên ngẫu nhiên có ba chữ số

1000
 – [Probability] > [Random Number]

(Mỗi lần thực hiện sẽ cho kết quả khác nhau.)

Random Integer
Hàm này tạo ra một số nguyên ngẫu nhiên giả giữa giá trị bắt đầu và giá
trị kết thúc đã xác định.

Lưu ý

• Không thể nhập RanInt# bằng Solver của ứng dụng Equation.

Ví dụ: Để tạo ra số nguyên ngẫu nhiên trong khoảng từ 1 đến 6

 – [Probability] > [Random Integer]
1 (,)6

(Mỗi lần thực hiện sẽ cho kết quả khác nhau.)

Tính toán số
Phần này sẽ giải thích các lệnh và hàm bạn có thể nhập sau khi thực hiện
thao tác:  – [Numeric Calc].

GCD, LCM
GCD xác định ước chung lớn nhất của hai giá trị, trong khi LCM xác định
bội chung nhỏ nhất.

Ví dụ 1: Để xác định ước chung lớn nhất của 28 và 35

 – [Numeric Calc] > [GCD]
28 (,)35

Ví dụ 2: Để xác định bội chung nhỏ nhất của 9 và 15
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 – [Numeric Calc] > [LCM]
9 (,)15

Absolute Value
Khi bạn đang thực hiện tính toán một số thực, hàm này sẽ chỉ lấy giá trị
truyệt đối.

Ví dụ: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Recurring Decimal
Bạn có thể sử dụng mục menu bên dưới để nhập số thập phân tuần hoàn.

 – [Numeric Calc] > [Recurring Decimal]
Để biết chi tiết, vui lòng xem "Chuyển đổi số thập phân tuần hoàn
(Phép tính số thập phân tuần hoàn)" (trang 45).

Integer Part
Hàm này trích phần số nguyên của giá trị.

Ví dụ: Để trích phần số nguyên của -3,5

 – [Numeric Calc] > [Integer Part]
((-))3 5

Round Off
Sử dụng hàm Round Off (Rnd) làm cho các giá trị phân số thập phân của
đối số được làm tròn theo cài đặt Number Format hiện tại. Ví dụ, kết quả
bên trong và được hiển thị của Rnd(10 ÷ 3) là 3,333 khi cài đặt Number
Format là Fix 3. Sử dụng cài đặt Norm 1 hoặc Norm 2 làm cho đối số
được làm tròn ở chữ số thứ 11 của phần định trị.
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Ví dụ: Để thực hiện các phép tính sau đây khi Fix 3 được chọn cho số các
chữ số hiển thị: 10 ÷ 3 × 3 và Rnd(10 ÷ 3) × 3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3

Largest Integer
Hàm này xác định số nguyên lớn nhất không vượt quá giá trị.

Ví dụ: Để xác định số nguyên lớn nhất không vượt quá -3,5

 – [Numeric Calc] > [Largest Integer]
((-))3 5

Đơn vị góc, tọa độ cực/tọa độ hình
chữ nhật, hệ lục thập phân
Phần này sẽ giải thích các lệnh, hàm, và ký hiệu bạn có thể nhập sau khi
thực hiện thao tác:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
Các hàm này chỉ định đơn vị góc.
° chỉ định độ, r radian, và g gradian.
Bạn có thể nhập từng chức năng bằng cách sử dụng các mục menu bên
dưới.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

Ví dụ: π/2 radian = 90° (Angle Unit: Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]
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Rect to Polar, Polar to Rect
"Pol(" chuyển đổi toạ độ hình chữ nhật sang toạ độ cực, trong khi "Rec("
chuyển đổi toạ độ cực sang toạ độ hình chữ nhật.

• Chỉ định Angle Unit trên menu SETTINGS trước khi thực hiện tính toán.
• Kết quả tính toán cho r và θ và cho x và y lần lượt được lưu cho các

biến x và y.
• Kết quả tính toán θ được hiển thị trong miền -180° < θ ≤ 180°.

Lưu ý

• Pol( và Rec( có thể được sử dụng trên màn hình tính toán của các ứng dụng máy tính•
bên dưới.
Calculate*, Statistics, Matrix, Vector
* Khi tắt Verify (Verify OFF).

Ví dụ 1: Để chuyển đổi tọa độ hình chữ nhật (√2, √2) sang tọa độ cực
(Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

Ví dụ 2: Để chuyển đổi tọa độ cực (√2, 45°) sang tọa độ hình chữ nhật
(Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

Độ, Phút, Giây
Bạn có thể sử dụng các phím hoặc mục menu bên dưới để nhập các ký
hiệu hệ lục thập phân ( ).

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

Để biết chi tiết, vui lòng xem "Chuyển đổi hệ lục thập phân (Phép tính
độ, phút, giây)" (trang 49).
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Hàm hyperbolic, lượng giác
Phần này sẽ giải thích về các hàm hyperbolic và hàm lượng giác.

Các hàm hyperbolic
Có thể nhập các hàm hyperbolic bằng cách sử dụng các mục menu bên
dưới.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1], hoặc
[tanh-1]

Cài đặt đơn vị góc không ảnh hưởng đến tính toán.

Ví dụ: sinh 1 = 1,175201194

 – [Hyperbolic/Trig] > [sinh] 1

Các hàm lượng giác
Có thể nhập các hàm lượng giác bằng các phím hoặc các mục menu bên
dưới.

Phím Mục menu

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

Chỉ định Angle Unit trên menu SETTINGS trước khi thực hiện tính toán.

Ví dụ: sin 30 = 1
2  (Angle Unit: Degree)

30
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Ký hiệu kỹ thuật
Máy tính của bạn hỗ trợ sử dụng 11 ký hiệu kỹ thuật (m, μ, n, p, f, k, M, G,
T, P, E) bạn có thể dùng để nhập giá trị hoặc để hiển thị kết quả tính toán.
• Có thể nhập ký hiệu kỹ thuật sau khi thực hiện thao tác:  – [Engineer

Symbol].
• Để hiển thị kết quả tính toán có ký hiệu kỹ thuật, hãy thực hiện thao tác

sau:  – [Calc Settings] > [Engineer Symbol] > [On].

Ví dụ về nhập và tính toán có dùng ký hiệu kỹ thuật

Ví dụ 1: Nhập 500k
(Engineer Symbol: On)

500  – [Engineer Symbol] > [Kilo] 

Ví dụ 2: Để tính 999k (kilo) + 25k (kilo) = 1,024M (Mega) = 1024k (kilo) =
1024000
(Engineer Symbol: On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
(Nhập Chế độ chuyển đổi ENG.)

• Nhấn , , hoặc  sẽ thoát Chế độ chuyển đổi ENG và làm 
biến mất khỏi màn hình. Để bắt đầu phép tính mới, hãy thoát khỏi
Chế độ chuyển đổi ENG.

• Để biết chi tiết về Chế độ chuyển đổi ENG, vui lòng xem "Ký pháp kỹ
thuật" (trang 48).
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Hằng số khoa học
Máy tính của bạn có tích hợp lên đến 47 hằng số khoa học. Các giá trị này
đều dựa trên các giá trị được CODATA khuyến nghị (2018).

Ví dụ: Để nhập hằng số khoa học c (tốc độ ánh sáng trong chân không),
và hiển thị giá trị của nó
1. Nhấn , chọn [Sci Constants], sau đó nhấn .

• Thao tác này sẽ hiển thị menu danh mục hằng số khoa học*.

2. Chọn [Universal], sau đó nhấn .
• Thao tác này sẽ hiển thị menu các hằng số khoa học trong danh mục

Universal.

3. Chọn [c], sau đó nhấn .

4. Nhấn .

* Bảng dưới đây trình bày các hằng số khoa học có trong mỗi danh mục.

Danh mục Hằng số khoa học

Universal h, , c, ε0, μ0, Z0, G, lP, tP

Electromagnetic μN, μB, e, Φ0, G0, KJ, RK

Atomic&Nuclear
mp, mn, me, mμ, a0, α, re, λC, γp,
λCp, λCn, R∞, μp, μe, μn, μμ, mτ

Physico-Chem mu, F, NA, k, Vm, R, c1, c2, σ

Adopted Values gn, atm, RK-90, KJ-90
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Other t

Chuyển đổi đơn vị
Bạn có thể sử dụng các lệnh chuyển đổi đơn vị để chuyển đổi từ đơn vị đo
lường này sang đơn vị đo lường khác. Dữ liệu công thức chuyển đổi dựa
trên "NIST Special Publication 811 (2008)".

Ví dụ: Để chuyển đổi 5 cm thành inch (Input/Output: LineI/LineO)
1. Nhập giá trị cần được chuyển đổi.

5

2. Nhấn , chọn [Unit Conversions], sau đó nhấn .
• Thao tác này sẽ hiển thị menu các danh mục chuyển đổi đơn vị*.

3. Chọn [Length], sau đó nhấn .
• Thao tác này sẽ hiển thị menu các lệnh chuyển đổi trong danh mục

Length.

4. Chọn [cm in] (lệnh chuyển đổi từ centimet thành inch) rồi sau đó nhấn
.

5. Nhấn .

* Bảng dưới đây trình bày các lệnh chuyển đổi đơn vị có trong mỗi danh
mục.

Danh mục Lệnh chuyển đổi đơn vị

Length
in cm, cm in, ft m, m ft, yd m, m

yd, mile km, km mile, n mile m,
m n mile, pc km, km pc

66



Area acre m2, m2 acre

Volume
gal(US) L, L gal(US), gal(UK) L, L

gal(UK)

Mass oz g, g oz, lb kg, kg lb

Velocity km/h m/s, m/s km/h

Pressure
atm Pa, Pa atm, mmHg Pa, Pa

mmHg, kgf/cm2 Pa, Pa kgf/cm2,
lbf/in2 kPa, kPa lbf/in2

Energy kgf m J, J kgf m, J cal15, cal15 J

Power hp kW, kW hp

Temperature °F °C, °C °F

Khối lượng nguyên tử và bảng tuần
hoàn hóa học
Bộ nhớ máy tính của bạn có chứa các giá trị cho khối lượng nguyên tử
của 118 nguyên tố. Bạn có thể hiển thị một giá trị cụ thể trên màn hình và
thậm chí sử dụng các giá trị trong tính toán. Khối lượng nguyên tử do máy
tính của bạn tạo ra dựa trên khối lượng được IUPAC (Liên minh Quốc tế
về Hóa học thuần túy và Hóa học ứng dụng) công bố cho năm 2019.

Để xem lại khối lượng nguyên tử từ bảng tuần hoàn hóa học

Ví dụ: Để hiển thị khối lượng nguyên tử của scandi (Ký hiệu hóa học: Sc,
Số nguyên tử: 21)

1. Hiển thị màn hình bảng tuần hoàn hóa học.
 – [Atomic Table] > [Periodic Table]

(1) Con trỏ
(2) Số nguyên tử
(3) Ký hiệu hóa học
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(4) Khối lượng nguyên tử*

* Giá trị khối lượng nguyên tử trong ngoặc vuông ([ ]) thể hiện khối
lượng nguyên tử của nguyên tố được biết đến nhiều nhất trong các
đồng vị.

2. Di chuyển con trỏ đến ô scandi.

3. Nhấn .
• Thao tác này sẽ nhập lệnh xem lại khối lượng nguyên tử (AtWt) theo

sau là số nguyên tử scandi (21).

4. Nhấn  lại lần nữa.
• Thao tác này sẽ hiển thị khối lượng nguyên tử của scandi.

Để xem lại khối lượng nguyên tử bằng cách nhập số nguyên
tử

1. Nhấn , sau đó chọn [Atomic Table] > [Atomic Weight].
• Thao tác này sẽ nhập lệnh xem lại khối lượng nguyên tử (AtWt).

2. Nhập số nguyên tử mong muốn, sau đó nhấn .

Các mục khác
Các hàm và ký hiệu có thể nhập bằng các phím máy tính cũng có thể
được nhập bằng menu [Other]. Sử dụng  – [Other] để hiển thị menu
hàm và ký hiệu. Ví dụ, để nhập Ans, bạn có thể nhấn  hoặc thực hiện
thao tác sau:  – [Other] > [Ans].
Bảng dưới đây thể hiện mục menu [Other] tương ứng với từng thao tác
phím.
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*1

*2

*3

Mục menu Phím

Ans

PreAns (PreAns)

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 Nghịch đảo
*2 Bình phương
*3 Dấu trừ
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Đăng ký và sử dụng phương
trình xác định cho f(x) và g(x)

Đăng ký và sử dụng phương trình
xác định cho f(x) và g(x)
Máy tính này có các hàm "f(" và "g(" mà bạn có thể sử dụng sau khi đăng
ký phương trình xác định cho các hàm đó. Ví dụ, sau khi đăng ký f(x) = x2

+ 1 làm phương trình xác định cho hàm "f(", bạn có thể tính được f(0) = 1
và f(5) = 26.
Nhấn  để hiển thị menu đăng ký phương trình xác định của f(x) hoặc
g(x), và để nhập "f(" hoặc "g(".

Lưu ý

• Các phương trình xác định của f(x) và g(x) cũng được sử dụng bằng f(x) và g(x) trong
ứng dụng Table. Để biết thông tin về ứng dụng Table, vui lòng xem "Tạo một bảng
số" (trang 108).

Đăng ký phương trình xác định
Ví dụ 1: Để đăng ký f(x) = x2 + 1
1. Nhấn , chọn biểu tượng ứng dụng Calculate, sau đó nhấn .
2. Nhấn , sau đó chọn [Define f(x)].

• Thao tác này sẽ hiển thị màn hình đăng ký phương trình f(x).

3. Nhập x2 + 1.

1

4. Nhấn .
• Thao tác này sẽ đăng ký biểu thức bạn nhập vào, và màn hình hiển

thị trước khi bạn nhấn  ở bước 2 của quy trình này sẽ xuất hiện lại.

Lưu ý

• Phương trình xác định có thể được đăng ký từ bất kỳ ứng dụng máy tính nào, ngoại
trừ Distribution, Equation (Simul Equation/Polynomial), Inequality, Base-N, Ratio và
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Math Box. Tuy nhiên, tùy vào màn hình được hiển thị bởi ứng dụng máy tính (ví dụ,
nếu màn hình menu được hiển thị), menu có thể không xuất hiện khi bạn nhấn .

Thực hiện tính toán bằng cách gán giá trị cho
phương trình xác định đã đăng ký

Ví dụ 2: Để gán giá trị x = 3 cho f(x) mà bạn đã đăng ký trong Ví dụ 1
(Tiếp tục từ Ví dụ 1)
1. Nhấn , sau đó chọn [f(x)].

• Thao tác này sẽ nhập "f(".

2. Gán giá trị là 3, sau đó thực hiện tính toán.

3

Đăng ký hàm hợp
Ví dụ 3: Để chèn hàm f(x) đã được xác định trong Ví dụ 1 vào g(x) để
đăng ký g(x) = f(x) × 2 - x
(Tiếp tục từ Ví dụ 1)
1. Nhấn , sau đó chọn [Define g(x)].

• Thao tác này sẽ hiển thị màn hình đăng ký phương trình g(x).

2. Nhập f(x) × 2 - x.

* 2

* Nhấn  khi màn hình đăng ký phương trình g(x) được hiển thị, mục
menu duy nhất xuất hiện là [f(x)]. Tương tự như vậy, nhấn  khi màn
hình đăng ký phương trình f(x) được hiển thị, mục menu duy nhất xuất
hiện là [g(x)].

3. Nhấn .
• Thao tác này sẽ đăng ký phương trình bạn nhập vào và quay về màn

hình hiển thị trước khi bạn bắt đầu thao tác ở bước 1.

Lưu ý

• Thao tác để gán giá trị cho x của hàm g(x) và tính toán kết quả sẽ tương tự như trong
phần "Thực hiện tính toán bằng cách gán giá trị cho phương trình xác định đã
đăng ký" (trang 71). Tuy nhiên, lưu ý rằng thay vì chọn [f(x)] ở bước 1, bạn nên chọn
[g(x)].

• Trong thao tác ở Ví dụ 3, bạn nhập f(x) vào phương trình xác định của g(x). Ngược lại,
bạn cũng có thể nhập g(x) vào phương trình xác định của f(x). Tuy nhiên, bạn không
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được nhập g(x) vào f(x), và nhập f(x) vào g(x) cùng một lúc. Nếu bạn làm như vậy, lỗi
Circular ERROR sẽ xảy ra khi bạn thực hiện tính toán sử dụng hàm f(x) hoặc g(x).

Giữ lại dữ liệu
Thực hiện bất kỳ thao tác nào dưới đây sẽ làm các phương trình xác định
được đăng ký cho f(x) và g(x) bị xóa.

• Nhấn 
• Sử dụng menu SETTINGS để chuyển đổi cài đặt Input/Output giữa

MathI*1 và LineI*2.
*1 MathI/MathO hoặc MathI/DecimalO
*2 LineI/LineO hoặc LineI/DecimalO

• Thực hiện  – [Reset] > [Settings & Data] hoặc  – [Reset] >
[Initialize All]
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Sử dụng Verify

Tổng quan về Verify
Verify sẽ kiểm tra tính đúng đắn của một đẳng thức hoặc bất đẳng thức
đầu vào.

Verify có thể sử dụng với các ứng dụng máy tính sau đây.
Calculate, Table, Equation, Complex

Lưu ý

• Mục tiêu và quy trình cần thiết cho thao tác Verify sẽ phụ thuộc vào ứng dụng máy
tính sử dụng thao tác. Để biết chi tiết, vui lòng xem các phần bên dưới.
Sử dụng Verify với ứng dụng Calculate (trang 74)
Sử dụng Verify với ứng dụng Table (trang 111)
Sử dụng Verify với ứng dụng Equation (trang 121)
Sử dụng Verify với ứng dụng Complex (trang 128)

Bật và tắt Verify
Để sử dụng Verify, trước tiên bạn cần bật tính năng này bằng cách chọn
[Verify ON] trên menu TOOLS của ứng dụng máy tính.

Quan trọng!

• Việc chuyển đổi giữa bật và tắt Verify trong ứng dụng Calculate hoặc Complex sẽ xóa
toàn bộ lịch sử tính toán.

• Trong khi Verify được bật, một ứng dụng máy tính chỉ có thể được sử dụng cho các
thao tác Verify. Không thể được sử dụng cho các tính toán bình thường. Tắt Verify khi
bạn không sử dụng.
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Lưu ý

• Verify thường bị tắt sau khi bạn khởi chạy một ứng dụng máy tính. Tuy nhiên, nếu
bạn trở về màn hình HOME từ một ứng dụng máy tính sau khi bật Verify, sau đó khởi
chạy lại cùng ứng dụng máy tính đó trước khi khởi chạy một ứng dụng máy tính khác,
Verify vẫn được bật.

Để bật Verify

1. Nhấn , chọn biểu tượng của ứng dụng máy tính bạn muốn khởi chạy,
sau đó nhấn .
• Chọn một ứng dụng máy tính có thể sử dụng Verify.

2. Nhấn  để hiển thị menu TOOLS.
• Tùy thuộc vào màn hình được hiển thị bởi ứng dụng máy tính, menu

có thể không xuất hiện khi bạn nhấn .
3. Chọn [Verify ON], sau đó nhấn .

• Thao tác này sẽ trở về màn hình được hiển thị trước khi bạn nhấn
. Lúc này, một chỉ báo  sẽ xuất hiện ở phía trên cùng của màn

hình cho biết Verify được bật.

Để tắt Verify

1. Nhấn  để hiển thị menu TOOLS.
2. Chọn [Verify OFF], sau đó nhấn .

• Thao tác này sẽ trở về màn hình được hiển thị trước khi bạn nhấn
, và chỉ báo  sẽ biến mất khỏi phía trên cùng của màn hình.

Lưu ý

• Verify sẽ bị tắt khi bạn thực hiện bất kỳ thao tác nào sau đây.
- Nhấn 
- Nhấn  (hoặc ) để trở về màn hình HOME từ ứng dụng máy tính hiện tại, sau

đó khởi chạy ứng dụng máy tính khác
- Thực hiện  – [Reset] > [Settings & Data] hoặc  – [Reset] > [Initialize All]

Sử dụng Verify với ứng dụng
Calculate
Sau khi bật Verify trong ứng dụng Calculate, bạn có thể kiểm tra xem một
phương trình hoặc bất phương trình có đúng hay không. "True" xuất hiện
trên màn hình nếu phương trình hoặc bất phương trình bạn nhập trên máy
tính là đúng, còn "False" sẽ xuất hiện nếu sai.
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Thao tác mẫu với Verify
Bật Verify trong ứng dụng Calculate trước khi thực hiện thao tác bên dưới.
Để biết thông tin về cách bật Verify, vui lòng xem "Để bật Verify" (trang
74).

Ví dụ 1: Để kiểm tra xem 4√9 = 12 là đúng hay sai

4 9
 – [Verify] > [＝]*

12

* Bạn có thể chọn biểu tượng đẳng thức hoặc biểu tượng bất đẳng thức
từ menu xuất hiện khi bạn nhấn , sau đó chọn [Verify].

Ví dụ 2: Để kiểm tra xem 0 < ( 8
9  )2  -  8

9   đúng hay sai.

0  – [Verify] > [＜]
8 9 8 9

Biểu thức có thể xác minh
Bạn có thể nhập các biểu thức sau để kiểm tra.
• Các đẳng thức hoặc bất đẳng thức bao gồm một toán tử quan hệ

4 = √16, 4 ≠ 3, π > 3, 1 + 2 ≤ 5, (3 × 6) < (2 + 6) × 2, v.v...
• Các đẳng thức hoặc bất đẳng thức bao gồm nhiều toán tử quan hệ

1 ≤ 1 < 1 + 1, 3 < π < 4, 22 = 2 + 2 = 4, 2 + 3 = 5 ≠ 2 + 5 = 8, v.v...

Những lưu ý khi nhập biểu thức vào

• Các loại biểu thức sau gây ra Syntax ERROR và không thể kiểm tra
được.
- Một biểu thức trong đó nhiều toán tử quan hệ không được định hướng
theo cùng một hướng (Ví dụ: 5 ≤ 6 ≥ 4)
- Một biểu thức trong đó có hai toán tử sau đây trong bất kỳ tổ hợp nào
(Ví dụ: 4 < 6 ≠ 8)

• Một số biểu thức không tương ứng với những biểu thức được mô tả ở
trên cũng có thể tạo ra Syntax ERROR và không thể kiểm tra được.

Thực hiện thao tác xác minh tuần tự ở phía bên
phải của biểu thức

Khi kết quả kiểm tra đúng sai của đẳng thức hoặc bất đẳng thức có chứa
toán tử quan hệ được hiển thị, việc chọn một toán tử quan hệ từ menu
CATALOG sẽ nhập vào phía bên phải của biểu thức được kiểm tra làm
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dòng tiếp theo. Có thể sử dụng khả năng này để thực hiện kiểm tra đúng
sai liên tiếp của đẳng thức hoặc bất đẳng thức.

Ví dụ: Thực hiện đánh giá đúng sai liên tục đối với (x + 1)(x + 5) = x2 + x +
5x + 5 và x2 + x + 5x + 5 = x2 + 6x + 5

1 5
– [Verify] > [＝]

5 5

 – [Verify] > [＝]

6 5

Lưu ý

• Kết quả kiểm tra sẽ lưu 1 vào bộ nhớ Ans khi True và 0 khi False.
• Khi Verify được bật (Verify ON), máy tính sẽ thực hiện thao tác toán học trên biểu

thức đầu vào, sau đó hiển thị True hoặc False dựa trên kết quả. Do đó, sai số tính
toán có thể xảy ra hoặc kết quả toán học chính xác có thể không được hiển thị khi
biểu thức tính toán đầu vào bao gồm tính toán gần tới điểm kỳ dị hoặc điểm uốn của
hàm, hoặc khi biểu thức đầu vào chứa nhiều thao tác tính toán. Ngoài ra, nghiệm
được hiển thị khi Verify tắt (Verify OFF) có thể không được đánh giá là True, vì kết
quả có thể khác với dữ liệu nội bộ do làm tròn và do giới hạn số chữ số được hiển thị.
Điều này cũng áp dụng đối với các ứng dụng khác ngoài ứng dụng Calculate.
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Sử dụng các chức năng QR
Code

Sử dụng các chức năng QR Code
Máy tính của bạn có thể hiển thị các biểu tượng QR Code có thể đọc
được bằng thiết bị thông minh.

Quan trọng!

• Các thao tác trong phần này giả định rằng thiết bị thông minh đang được sử dụng
có trình đọc QR Code có thể đọc nhiều biểu tượng QR Code, và có thể kết nối với
Internet.

• Việc quét QR Code được máy tính này hiển thị bằng thiết bị thông minh sẽ làm thiết bị
thông minh đó truy cập trang web CASIO.

Lưu ý

• QR Code sẽ xuất hiện trên màn hình mỗi khi bạn nhấn (QR) trong khi bất kỳ
màn hình nào dưới đây được hiển thị.
- Màn hình HOME
- Màn hình menu SETTINGS
- Màn hình lỗi
- Màn hình kết quả tính toán trong bất kỳ ứng dụng máy tính nào
- Màn hình bảng trong bất kỳ ứng dụng máy tính nào
- Màn hình ứng dụng Spreadsheet
Để biết chi tiết, vui lòng truy cập trang web của CASIO (https://wes.casio.com).

Hiển thị QR Code
Ví dụ: Để hiển thị QR Code cho kết quả tính toán trong ứng dụng
Calculate của máy tính và quét bằng thiết bị thông minh
1. Trong ứng dụng Calculate, thực hiện một số tính toán.
2. Nhấn (QR) để hiển thị QR Code.

• Các số ở góc dưới bên phải của màn hình thể hiện số QR Code hiện
tại và tổng số biểu tượng QR Code. Để hiển thị QR Code tiếp theo,
nhấn  hoặc .

Lưu ý

• Để trở về QR Code trước đó, hãy nhấn  hoặc  nhiều lần nếu cần để cuộn về
trước cho đến khi QR Code xuất hiện.

3. Sử dụng thiết bị thông minh để quét QR Code trên màn hình máy tính.
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• Để biết thông tin về cách quét QR Code, vui lòng tham khảo tài liệu
người dùng về trình đọc QR Code bạn đang sử dụng.

Nếu bạn gặp khó khăn khi quét QR Code
Khi QR Code được hiển thị, sử dụng  và  để điều chỉnh độ tương
phản hiển thị của QR Code. Việc điều chỉnh độ tương phản này chỉ ảnh
hưởng đến màn hình QR Code.

Quan trọng!

• Tùy vào thiết bị thông minh và/hoặc ứng dụng đọc QR Code được sử dụng, bạn có
thể gặp vấn đề trong việc quét các biểu tượng QR Code được tạo bởi máy tính này.

• Khi cài đặt "QR Code" trên menu SETTINGS là "Version 3", những ứng dụng máy
tính có thể hiển thị các biểu tượng QR Code sẽ bị hạn chế. Nếu bạn cố hiển thị QR
Code trong một ứng dụng không hỗ trợ hiển thị QR Code, thông báo "Not Supported
(Version 3)" sẽ xuất hiện. Tuy nhiên, QR Code được tạo bởi cài đặt này sẽ dễ quét
bằng thiết bị thông minh hơn.

• Để biết thêm thông tin, vui lòng truy cập trang web của CASIO (https://
wes.casio.com).
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Sử dụng các ứng dụng máy
tính

Tính toán thống kê
Ứng dụng Statistics tính toán các giá trị thống kê khác nhau dựa trên dữ
liệu biến đơn (x) hoặc biến đôi (x, y).

Quy trình chung để thực hiện tính toán thống kê
1. Nhấn , chọn biểu tượng ứng dụng Statistics, sau đó nhấn .
2. Trên menu xuất hiện, chọn [1-Variable] (biến đơn) hoặc [2-Variable]

(biến đôi), sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo thống kê.

Biến đơn

Biến đôi

3. Hiển thị cột Freq (tần số) nếu cần.
• Để biết chi tiết, vui lòng xem "Cột Freq (Tần số)" (trang 80).

4. Nhập dữ liệu.
• Để biết chi tiết, vui lòng xem "Nhập dữ liệu bằng Bộ soạn thảo

thống kê" (trang 80).
5. Sau khi bạn nhập dữ liệu xong, hãy nhấn .

• Thao tác này sẽ làm cho menu bên dưới xuất hiện.

Biến đơn
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Biến đôi

6. Chọn mục menu cho thao tác bạn muốn thực hiện.
• Chọn [1-Var Results], [2-Var Results], hoặc [Reg Results] để xem

danh sách kết quả tính toán dựa trên dữ liệu bạn đã nhập. Để biết chi
tiết, vui lòng xem "Hiển thị kết quả tính toán thống kê" (trang 83).

• Để hiển thị màn hình tính toán thống kê cho việc thực hiện các phép
tính dựa trên dữ liệu nhập, chọn [Statistics Calc]. Để biết chi tiết, vui
lòng xem "Sử dụng màn hình tính toán thống kê" (trang 87).

Lưu ý

• Để trở về Bộ soạn thảo thống kê từ màn hình tính toán thống kê, nhấn  sau đó
nhấn .

Nhập dữ liệu bằng Bộ soạn thảo thống kê
Bộ soạn thảo thống kê hiển thị một, hai, hoặc ba cột: biến đơn (x), biến
đơn và tần số (x, Freq), biến đôi (x, y), biến đôi và tần số (x, y, Freq). Số
lượng hàng dữ liệu có thể được nhập phụ thuộc vào số lượng cột: 160
hàng cho một cột, 80 hàng cho hai cột, 53 hàng cho ba cột.

Quan trọng!

• Tất cả dữ liệu hiện đang được nhập vào Bộ soạn thảo thống kê sẽ bị xóa bất cứ khi
nào bạn thực hiện bất kỳ thao tác nào dưới đây.
- Chuyển đổi kiểu tính toán thống kê giữa biến đơn và biến đôi
- Thay đổi cài đặt Frequency trên menu TOOLS

• Việc tính toán thống kê có thể mất nhiều thời gian khi có một số lượng lớn các mục
dữ liệu.

Cột Freq (Tần số)

Nếu bạn bật cài đặt Frequency trên menu TOOLS, một cột có nhãn "Freq"
cũng sẽ được đưa vào Bộ soạn thảo thống kê. Bạn có thể sử dụng cột
Freq để chỉ định tần số (số lần xuất hiện trong nhóm dữ liệu của cùng một
mẫu) của mỗi giá trị mẫu.
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Biến đơn

Biến đôi

Để hiển thị cột Freq
1. Trong khi Bộ soạn thảo thống kê được hiển thị, hãy nhấn  và sau đó

chọn [Frequency] > [On].
2. Nhấn  để trở về Bộ soạn thảo thống kê.

Để ẩn cột Freq
1. Trong khi Bộ soạn thảo thống kê được hiển thị, hãy nhấn  và sau đó

chọn [Frequency] > [Off].
2. Nhấn  để trở về Bộ soạn thảo thống kê.

Quy tắc nhập dữ liệu mẫu trên Bộ soạn thảo thống kê

Dữ liệu bạn nhập được chèn vào ô có con trỏ. Sử dụng các phím con trỏ
để di chuyển con trỏ giữa các ô.

   Con trỏ

Sau khi nhập một giá trị, nhấn . Thao tác này đăng ký giá trị và hiển thị
tối đa sáu chữ số trong ô.

Ví dụ 1: Để lựa chọn biến đôi và nhập dữ liệu sau: (170, 66), (179, 75),
(173, 68)
1. Nhấn , chọn biểu tượng ứng dụng Statistics, sau đó nhấn .
2. Chọn [2-Variable], sau đó nhấn .
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3. Sử dụng theo thao tác bên dưới để nhập dữ liệu.

170 179 173
66 75 68

Lưu ý

• Trên Bộ soạn thảo thống kê, bạn có thể lưu giá trị trong một ô vào biến. Ví dụ, nếu
thực hiện thao tác sau khi màn hình trong bước 3 ở trên hiển thị, máy sẽ lưu 68 vào
biến A:  – [A=] > [Store]. Để biết chi tiết về các biến số, vui lòng xem "Các biến
(A, B, C, D, E, F, x, y, z)" (trang 38).

Soạn thảo dữ liệu mẫu

Để thay thế dữ liệu trong một ô
Trên Bộ soạn thảo thống kê, di chuyển con trỏ đến ô chứa dữ liệu bạn
muốn chỉnh sửa, nhập dữ liệu mới, sau đó nhấn .

Để xóa một hàng
Trên Bộ soạn thảo thống kê, di chuyển con trỏ đến hàng bạn muốn xóa và
sau đó nhấn .

Để chèn một hàng
1. Trên Bộ soạn thảo thống kê, di chuyển con trỏ đến hàng sẽ nằm dưới

hàng bạn sẽ chèn.
2. Thực hiện thao tác sau:  – [Edit] > [Insert Row].

Để xoá tất cả nội dung của Bộ soạn thảo thống kê
Trên Bộ soạn thảo thống kê, thực hiện thao tác sau:  – [Edit] > [Delete
All].

Sắp xếp dữ liệu

Bạn có thể sắp xếp dữ liệu của Bộ soạn thảo thống kê theo thứ tự tăng
dần hoặc giảm dần trên các giá trị x, y, hoặc cột Freq.

Quan trọng!

• Lưu ý rằng sau khi bạn thay đổi trình tự sắp xếp dữ liệu, bạn sẽ không thể trả về trình
tự gốc.
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Ví dụ 2: Để sắp xếp dữ liệu nhập trong Ví dụ 1 (trang 81) theo thứ tự
tăng dần ở cột x, và sau đó theo thứ tự giảm dần ở cột y
1. Sử dụng quy trình trong Ví dụ 1 để nhập dữ liệu.

2. Sắp xếp dữ liệu theo thứ tự tăng dần trên cột x.

 – [Sort] > [x Ascending]

3. Sắp xếp dữ liệu theo thứ tự giảm dần trên cột y.

 – [Sort] > [y Descending]

Hiển thị kết quả tính toán thống kê

Hiển thị kết quả tính toán thống kê biến đơn

Màn hình 1-Var Results thể hiện một danh sách các giá trị thống kê khác
nhau (ví dụ như giá trị trung bình và độ lệch chuẩn không gian mẫu) được
tính toán dựa trên dữ liệu biến đơn. Phần này mô tả thao tác cần thiết để
hiển thị màn hình 1-Var Results.

Ví dụ 3: Để nhập dữ liệu dưới đây và hiển thị các kết quả tính toán thống
kê biến đơn

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1. Nhấn , chọn biểu tượng ứng dụng Statistics, sau đó nhấn .
2. Chọn [1-Variable], sau đó nhấn .

• Thao tác này sẽ hiển thị Bộ soạn thảo thống kê.
3. Nhấn  và sau đó chọn [Frequency] > [On].

• Nhấn  để trở về Bộ soạn thảo thống kê.
4. Nhập dữ liệu vào cột x.

1 2 3 4 5 6 7 8 9 10

5. Nhập dữ liệu vào cột Freq.

83



2 2 2 2 3 4 2

6. Nhấn .

7. Chọn [1-Var Results], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình 1-Var Results.

 (hoặc )

 (hoặc )

• Để biết ý nghĩa của các biến được thể hiện trên màn hình 1-Var
Results, vui lòng xem "Danh sách các biến giá trị thống kê và hàm
tính toán thống kê" (trang 90).

8. Nhấn  hoặc  để trở về Bộ soạn thảo thống kê.

Hiển thị kết quả tính toán thống kê biến đôi

Màn hình 2-Var Results thể hiện một danh sách các giá trị thống kê khác
nhau (ví dụ như giá trị trung bình và độ lệch chuẩn không gian mẫu) được
tính toán dựa trên dữ liệu biến đôi. Phần này mô tả thao tác cần thiết để
hiển thị màn hình 2-Var Results.

Ví dụ 4: Để nhập dữ liệu dưới đây và hiển thị các kết quả tính toán thống
kê biến đôi

x 1,0 1,2 1,5 1,6 1,9 2,1 2,4 2,5 2,7 3,0
y 1,0 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 2,0

1. Nhấn , chọn biểu tượng ứng dụng Statistics, sau đó nhấn .
2. Chọn [2-Variable], sau đó nhấn .

• Thao tác này sẽ hiển thị Bộ soạn thảo thống kê.
3. Nhập dữ liệu vào cột x.

84



1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. Nhập dữ liệu vào cột y.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5. Nhấn .

6. Chọn [2-Var Results], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình 2-Var Results.

 (hoặc )

 (hoặc )

 (hoặc )

• Để biết ý nghĩa của các biến được thể hiện trên màn hình 2-Var
Results, vui lòng xem "Danh sách các biến giá trị thống kê và hàm
tính toán thống kê" (trang 90).

7. Nhấn  hoặc  để trở về Bộ soạn thảo thống kê.

Hiển thị kết quả tính toán hồi quy

Màn hình Reg Results hiển thị một danh sách các kết quả tính toán hồi
quy (hệ số của phương trình hồi quy) dựa trên dữ liệu biến đôi. Phần này
mô tả thao tác cần thiết để hiển thị màn hình Reg Results.
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Ví dụ 5: Để sử dụng dữ liệu biến đôi nhập trong Ví dụ 4 (trang 84) và
hiển thị kết quả của hai phép tính hồi quy trình bày bên dưới
• Phương trình hồi quy "y = a + bx" hệ số (a, b), và hệ số tương quan (r)

khi hồi quy tuyến tính được thực hiện trên dữ liệu
• Phương trình hồi quy "y = a + bx + cx2" hệ số (a, b, c) khi hồi quy bậc hai

được thực hiện trên dữ liệu

Lưu ý

• Để biết thông tin về các kiểu tính toán hồi quy được hỗ trợ bởi ứng dụng Statistics, vui
lòng xem "Danh sách kiểu hồi quy được hỗ trợ" (trang 86).

1. Thực hiện các bước từ 1 đến 5 của quy trình trong Ví dụ 4 (trang 84).
2. Chọn [Reg Results], sau đó nhấn .

• Thao tác này sẽ hiển thị menu kiểu hồi quy.

3. Chọn [y=a+bx], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình Reg Results hồi quy tuyến tính.

4. Nhấn  hoặc  để trở về Bộ soạn thảo thống kê.
5. Nhấn , sau đó chọn [Reg Results] > [y=a+bx+cx2].

• Thao tác này sẽ hiển thị màn hình Reg Results hồi quy bậc hai.

6. Nhấn  hoặc  để trở về Bộ soạn thảo thống kê.
• Để biết ý nghĩa của các biến được thể hiện trên màn hình Reg

Results, vui lòng xem "Danh sách các biến giá trị thống kê và hàm
tính toán thống kê" (trang 90).

Danh sách kiểu hồi quy được hỗ trợ

Kiểu hồi quy
Phương trình hồi quy

(mục menu kiểu hồi quy)

Hồi quy tuyến tính y = a + bx
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Hồi quy bậc hai y = a + bx + cx2

Hồi quy lôgarit y = a + b･ln(x)

Hồi quy mũ của e y = a･e^(bx)

Hồi quy mũ của ab y = a･b^x

Hồi quy lũy thừa y = a･x^b

Hồi quy nghịch đảo y = a + b/x

Sử dụng màn hình tính toán thống kê
Bạn có thể sử dụng màn hình tính toán thống kê để xem lại các giá trị
thống kê riêng lẻ và sử dụng các giá trị trong tính toán.

Màn hình không có đầu vào biểu thức tính toán

Phép tính ví dụ

Để xem lại giá trị thống kê, hãy sử dụng biến thể hiện giá trị thống kê bạn
muốn xem lại (ví dụ, giá trị trung bình x: x, độ lệch chuẩn không gian mẫu
x: σx, giá trị tối đa x: max(x), v.v...). Để biết thêm thông tin về các biến này,
vui lòng xem "Danh sách các biến giá trị thống kê và hàm tính toán
thống kê" (trang 90).

Hiển thị màn hình tính toán thống kê

Biến đơn
1. Trong khi Bộ soạn thảo thống kê được hiển thị, nhấn .
2. Trên menu xuất hiện, chọn [Statistics Calc] và sau đó nhấn .
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Biến đôi
1. Trong khi Bộ soạn thảo thống kê được hiển thị, nhấn .
2. Trên menu xuất hiện, chọn [Statistics Calc] và sau đó nhấn .

• Thao tác này sẽ hiển thị menu kiểu hồi quy ( vui lòng xem "Danh
sách kiểu hồi quy hỗ trợ" (trang 86)).

3. Trên menu, chọn kiểu hồi quy bạn muốn và sau đó nhấn .

• Ví dụ trên sử dụng menu hiển thị để chọn [y=a+bx] (Hồi quy tuyến
tính).

Để trở về Bộ soạn thảo thống kê từ màn hình tính toán thống kê
Nhấn , sau đó nhấn .

Ví dụ phép tính sử dụng màn hình tính toán thống kê

Ví dụ 6: Để xác định tổng dữ liệu mẫu (Σx) và giá trị trung bình (x) của dữ
liệu biến đơn nhập trong Ví dụ 3 (trang 83)
1. Thực hiện các bước từ 1 đến 6 của quy trình trong Ví dụ 3 (trang 83).
2. Chọn [Statistics Calc], sau đó nhấn .

3. Tính tổng dữ liệu mẫu (Σx).

 – [Statistics] > [Summation] > [Σx]

4. Tính giá trị trung bình (x).

 – [Statistics] >
[Mean/Var/Dev...] > [x]
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Lưu ý

• Để hiển thị màn hình 1-Var Results từ màn hình tính toán thống kê ở trên, hãy nhấn
 và sau đó chọn [1-Var Results]. Để trở về màn hình tính toán thống kê từ màn

hình 1-Var Results, nhấn  hoặc .

Ví dụ 7: Để xác định các hệ số (a, b) và hệ số tương quan (r) của phương
trình hồi quy tuyến tính "y = a + bx" dựa trên dữ liệu biến đôi nhập trong Ví
dụ 4 (trang 84)
1. Thực hiện các bước từ 1 đến 5 của quy trình trong Ví dụ 4 (trang 84).
2. Chọn [Statistics Calc], sau đó nhấn .

• Thao tác này sẽ hiển thị menu kiểu hồi quy.

3. Chọn [y=a+bx], sau đó nhấn .

4. Xác định các hệ số (a, b) và hệ số tương quan (r) của phương trình hồi
quy "y = a + bx".

 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• Để chọn kiểu hồi quy khác, nhấn  và sau đó chọn [Select Reg
Type]. Thao tác này sẽ hiển thị menu kiểu hồi quy từ bước 2.

Để hiển thị màn hình 2-Var Results từ màn hình tính toán thống kê
Nhấn  và sau đó chọn [2-Var Results].

Để hiển thị màn hình Reg Results từ màn hình tính toán thống kê
Nhấn  và sau đó chọn [Reg Results].
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Danh sách các biến giá trị thống kê và hàm tính toán thống kê

Bạn có thể sử dụng menu CATALOG để xem lại các biến thể hiện các giá
trị thống kê và các hàm được sử dụng cho tính toán thống kê.

Lưu ý

• Đối với các tính toán thống kê biến đơn, các biến được đánh dấu bằng dấu hoa thị (*)
là biến có sẵn.

• Đối với công thức tính toán được sử dụng cho mỗi biến và lệnh, vui lòng xem "Công
thức tính toán thống kê" (trang 93).

 – [Statistics] > [Summation]
Σx*, Σy ...... tổng của dữ liệu mẫu
Σx2*, Σy2 ...... tổng bình phương của dữ liệu mẫu
Σxy ...... tổng của tích dữ liệu x và dữ liệu y
Σx3 ...... tổng của lũy thừa ba của dữ liệu x
Σx2y ...... tổng của (bình phương dữ liệu x × dữ liệu y)
Σx4 ...... tổng trùng phương của dữ liệu x

 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... giá trị trung bình
σ2

x*, σ2
y ...... Phương sai của tổng thể chung

σx*, σy ...... độ lệch chuẩn không gian mẫu
s2

x*, s2
y ...... phương sai mẫu

sx*, sy ...... độ lệch chuẩn mẫu
n* ...... số các khoản mục

 – [Statistics] > [Min/Max/Quartile] (Chỉ áp dụng với dữ liệu biến đơn)
min(x)* ...... giá trị tối thiểu
Q1* ...... tứ phân vị thứ nhất
Med* ...... số trung vị
Q3* ...... tứ phân vị thứ ba
max(x)* ...... giá trị tối đa

 – [Statistics] > [Norm Dist] (Chỉ áp dụng với dữ liệu biến đơn)
P(*, Q(*, R(*, t* ...... Các hàm để thực hiện tính toán phân phối chuẩn.
Để biết thêm thông tin về các hàm này, vui lòng xem "Thực hiện tính
toán phân phối chuẩn (Chỉ áp dụng với dữ liệu biến đơn)" (trang
91).

 – [Statistics] > [Min/Max] (Chỉ áp dụng với dữ liệu biến đôi)
min(x), min(y) ...... giá trị tối thiểu
max(x), max(y) ...... giá trị tối đa

 – [Statistics] > [Regression] (Chỉ áp dụng với dữ liệu biến đôi)
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Đối với hồi quy bậc hai
a, b, c ...... hệ số hồi quy đối với hồi quy bậc hai
x̂1, x̂2 ...... Các hàm để xác định giá trị ước lượng x1 và x2 đối với giá trị y
đã nhập. Đối với đối số, nhập giá trị của y ngay trước hàm x̂1 hoặc x̂2.
ŷ ...... Hàm để xác định giá trị ước lượng y đối với giá trị x đã nhập. Đối
với đối số, nhập giá trị của x ngay trước hàm này.

Đối với hồi quy không phải bậc hai
a, b ...... các hệ số hồi quy
r ...... hệ số tương quan
x̂ ...... Hàm để xác định giá trị ước lượng x đối với giá trị y đã nhập. Đối
với đối số, nhập giá trị của y ngay trước hàm này.
ŷ ...... Hàm để xác định giá trị ước lượng y đối với giá trị x đã nhập. Đối
với đối số, nhập giá trị của x ngay trước hàm này.
Để biết ví dụ về thao tác xác định giá trị ước lượng, vui lòng xem "Tính
toán giá trị ước lượng (Chỉ áp dụng với dữ liệu biến đôi)" (trang
92).

Thực hiện tính toán phân phối chuẩn (Chỉ áp dụng với dữ liệu
biến đơn)

Trong khi tính toán thống kê biến đơn được chọn, bạn có thể thực hiện
tính toán phân phối chuẩn bằng cách sử dụng các hàm dưới đây từ menu
xuất hiện khi bạn nhấn  và sau đó chọn [Statistics] > [Norm Dist].

P(, Q(, R( ... Những hàm này lấy đối số t và xác định xác suất phân phối
chuẩn như ảnh minh họa bên dưới.

t ...... Hàm này có đối số x đứng trước. Hàm tính toán đại lượng ngẫu
nhiên chuẩn cho giá trị dữ liệu x sử dụng giá trị trung bình (x) và độ lệch
chuẩn không gian mẫu (σx) của dữ liệu nhập bằng Bộ soạn thảo thống kê.

Ví dụ 8: Với dữ liệu biến đơn nhập trong Ví dụ 3 (trang 83), xác định biến
thiên đã chuẩn hóa khi x = 2, và P(t) tại thời điểm đó.
1. Thực hiện các bước từ 1 đến 6 của quy trình trong Ví dụ 3 (trang 83).
2. Chọn [Statistics Calc], sau đó nhấn .
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3. Tính biến thiên đã chuẩn hóa khi x = 2.

2
 – [Statistics] > [Norm Dist] > [ t]

4. Tính P(t).

 – [Statistics] > [Norm Dist] > [P(]

Tính toán giá trị ước lượng (Chỉ áp dụng với dữ liệu biến đôi)

Dựa trên phương trình hồi quy thu được bằng tính toán thống kê biến đôi,
giá trị ước lượng của y có thể được tính đối với giá trị x cho trước. Giá trị x
tương ứng (hai giá trị, x1 và x2, trong trường hợp hồi quy bậc hai) cũng có
thể được tính đối với giá trị của y trong phương trình hồi quy.

Ví dụ 9: Để xác định giá trị ước lượng đối với y khi x = 5,5 trong phương
trình hồi quy được tạo ra bởi hồi quy tuyến tính của dữ liệu nhập trong Ví
dụ 4 (trang 84)
1. Thực hiện các bước từ 1 đến 5 của quy trình trong Ví dụ 4 (trang 84).
2. Chọn [Statistics Calc], sau đó nhấn .

• Thao tác này sẽ hiển thị menu kiểu hồi quy.

3. Chọn [y=a+bx], sau đó nhấn .

4. Nhập giá trị x (5,5), sau đó nhập "ŷ", đây là hàm để xác định giá trị ước
lượng của y.

5 5
 – [Statistics] > [Regression] > [ŷ]
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5. Nhấn .

Công thức tính toán thống kê

Công thức tính toán thống kê biến đơn

Công thức tính toán thống kê biến đôi

Công thức tính toán hồi quy

Hồi quy tuyến tính (y = a + bx)

Hồi quy bậc hai (y = a + bx + cx2)
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Hồi quy lôgarit (y = a + b･ln(x))

Hồi quy mũ của e (y = a･e^(bx))

Hồi quy mũ của ab (y = a･b^x)
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Hồi quy lũy thừa (y = a･x^b)

Hồi quy nghịch đảo (y = a + b/x)

Tính toán phân phối
Trong ứng dụng Distribution, bạn có thể thu được giá trị xác suất bằng
cách chọn kiểu tính toán phân phối và nhập các tham số khác nhau.*
Dưới đây là bảng các kiểu tính toán phân phối có thể thực hiện.
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Kiểu tính toán phân phối Mục menu

Xác suất nhị thức Binomial PD

Xác suất tích lũy nhị thức Binomial CD

Mật độ xác suất chuẩn Normal PD

Xác suất tích lũy chuẩn Normal CD

Phân phối tích lũy chuẩn nghịch đảo* Inverse Normal

Xác suất Poisson Poisson PD

Xác suất tích lũy Poisson Poisson CD

* "Inverse Normal" thực hiện tính toán nghịch đảo để xác định giá trị dữ
liệu (xInv) từ giá trị xác suất (Area).

Quy trình chung để thực hiện tính toán phân phối
Ví dụ: Để tính xác suất tích lũy nhị thức đối với dữ liệu x {2, 3, 4, 5} khi N
(số lần thử) = 5 và p (xác suất thành công) = 0,5

1. Nhấn , chọn biểu tượng ứng dụng Distribution, sau đó nhấn .
• Thao tác này sẽ hiển thị menu kiểu tính toán phân phối.

2. Trên menu, chọn kiểu tính toán phân phối.
• Ở đây chúng ta muốn tính xác suất tích lũy nhị thức. Chọn [Binomial

CD], sau đó nhấn .
3. Trên menu xuất hiện, chọn phương pháp nhập dữ liệu (x).

[List] ... Chọn để nhập nhiều mục dữ liệu x cùng lúc. Thao tác chọn mục
menu này sẽ làm cho màn hình danh sách xuất hiện.

[Variable] ... Chọn để nhập một mục dữ liệu x. Thao tác chọn mục menu
này sẽ làm cho màn hình nhập tham số xuất hiện.

• Tại đây chúng ta muốn nhập nhiều mục dữ liệu x cùng lúc, chọn [List]
và sau đó nhấn .

4. Trên màn hình danh sách, nhập dữ liệu x {2, 3, 4, 5}.
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2 3 4 5

5. Nhấn .
• Thao tác này sẽ hiển thị màn hình nhập tham số Binomial CD.

6. Nhập giá trị cho các tham số (N = 5, p = 0,5).

5 0 5

• Các tham số yêu cầu nhập dữ liệu sẽ tùy thuộc vào kiểu tính toán
bạn đã chọn ở bước 2 của quy trình này. Để biết chi tiết, vui lòng xem
"Danh sách tham số" (trang 98).

7. Sau khi nhập giá trị cho tất cả các biến, chọn [Execute] và sau đó nhấn
.

• Thao tác này sẽ hiển thị màn hình kết quả tính toán.

• Nếu bạn đã chọn [List] trong bước 3, kết quả tính toán (cột P) sẽ xuất
hiện trên màn hình danh sách. Để biết chi tiết, vui lòng xem "Màn
hình danh sách" (trang 98).

• Nếu bạn thực hiện bất kỳ thao tác chỉnh sửa nào (xem "Soạn thảo
nội dung màn hình danh sách" (trang 99)) trên màn hình danh
sách trong khi kết quả tính toán được hiển thị, tất cả các kết quả tính
toán sẽ bị xóa. Danh sách sẽ trở về trạng thái trong bước 4 (hoàn tất
nhập dữ liệu màn hình danh sách) của quy trình này.

• Một thông báo lỗi xuất hiện nếu giá trị nhập nằm ngoài miền cho
phép. "ERROR" sẽ xuất hiện trong cột P của màn hình kết quả tính
toán khi giá trị nhập cho dữ liệu tương ứng nằm ngoài miền cho phép.

• Nếu nhấn  trong khi màn hình kết quả tính toán được hiển thị, máy
sẽ trở về màn hình nhập tham số.

Lưu ý

• Nếu bạn đã chọn Normal PD, Normal CD, hoặc Inverse Normal trong bước 2 ở trên,
phương pháp nhập dữ liệu (x) sẽ luôn là "Variable" (nhập một mục dữ liệu x). Do đó,
menu ở bước 3 sẽ không hiển thị vào lúc này.

• Nếu phương pháp nhập dữ liệu (x) là "Variable", kết quả tính toán sẽ được lưu trong
bộ nhớ Ans.

• Độ chính xác tính phân toán phối lên đến 6 chữ số có nghĩa.
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Danh sách tham số
Danh sách dưới đây cho biết ý nghĩa của các ký hiệu xuất hiện trên màn
hình nhập tham số.

Binomial PD, Binomial CD
x … dữ liệu
N … số lần thử
p … xác suất thành công (0 ≤ p ≤ 1)

Normal PD
x … dữ liệu
μ … giá trị trung bình của không gian mẫu
σ … độ lệch chuẩn không gian mẫu (σ > 0)

Normal CD
Lower … biên dưới
Upper … biên trên
μ … giá trị trung bình của không gian mẫu
σ … độ lệch chuẩn không gian mẫu (σ > 0)

Inverse Normal
Area = giá trị xác suất (0 ≤ Area ≤ 1)
μ … giá trị trung bình của không gian mẫu
σ … độ lệch chuẩn không gian mẫu (σ > 0)
(Cài đặt phần dư luôn ở bên trái.)

Poisson PD, Poisson CD
x … dữ liệu
λ … giá trị trung bình

Lưu ý

• Giá trị cuối cùng nhập vào cho từng tên tham số được giữ lại, bất kể màn hình nhập ở
nơi nhập. Ví dụ, việc nhập một giá trị cho N trên màn hình nhập tham số Binomial PD
cũng sẽ thay đổi giá trị của N trên màn hình nhập tham số Binomial CD.

• Các giá trị bạn nhập vào cho từng tham số được giữ lại, chỉ cần bạn không thực hiện
một trong các thao tác sau:  – [Reset] > [Settings & Data] hoặc  – [Reset] >
[Initialize All].

Màn hình danh sách
Bạn có thể sử dụng màn hình danh sách để nhập tối đa 45 mục dữ liệu x.
Kết quả tính toán cũng được hiển thị trên màn hình danh sách.
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(1) Kiểu tính toán phân phối
(2) Giá trị tại vị trí con trỏ hiện tại
(3) Dữ liệu (x)
(4) Kết quả tính toán (P)

Lưu ý

• Trên màn hình danh sách, bạn có thể lưu giá trị trong một ô vào biến. Ví dụ, nếu thực
hiện thao tác sau khi màn hình trên được hiển thị, máy sẽ lưu 1 vào biến A:  – [A=]
> [Store]. Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C, D, E, F, x, y,
z)" (trang 38).

• Nếu thực hiện một trong các thao tác dưới đây, máy sẽ xóa tất cả dữ liệu x nhập trên
màn hình danh sách.
- Trở về màn hình HOME và khởi chạy ứng dụng máy tính khác
- Thực hiện [Delete All] (Xem "Để xóa tất cả nội dung trên màn hình danh sách"

(trang 100).)
- Thực hiện  – [Reset] > [Settings & Data] hoặc  – [Reset] > [Initialize All]

Soạn thảo nội dung màn hình danh sách

Để thay đổi dữ liệu x trong một ô

Trên màn hình danh sách, di chuyển con trỏ đến ô chứa dữ liệu bạn muốn
thay đổi, nhập dữ liệu mới, sau đó nhấn .

Để xóa một hàng

Trên màn hình danh sách, di chuyển con trỏ đến hàng bạn muốn xóa và
sau đó nhấn .

Để chèn một hàng

1. Trên màn hình danh sách, di chuyển con trỏ đến hàng sẽ nằm dưới
hàng bạn sẽ chèn.

2. Thực hiện thao tác sau:  – [Edit] > [Insert Row].
• Thao tác này sẽ chèn một hàng với 0 được nhập vào làm giá trị mặc

định ban đầu.
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3. Nhập dữ liệu.

Để xóa tất cả nội dung trên màn hình danh sách

Trên màn hình danh sách, thực hiện thao tác sau:  – [Edit] > [Delete
All].

Ví dụ về phép tính
Để tính mật độ xác suất chuẩn khi x = 36, μ = 35, σ = 2
1. Nhấn , chọn biểu tượng ứng dụng Distribution, sau đó nhấn .
2. Trên menu kiểu tính toán phân phối xuất hiện, chọn [Normal PD], sau

đó nhấn .
• Thao tác này sẽ hiển thị màn hình nhập tham số Normal PD.

3. Nhập giá trị cho các tham số (x = 36, μ = 35, σ = 2).

36 35 2

4. Nhấn .

• Nhấn  lại lần nữa hoặc nhấn  hoặc  sẽ trở lại màn hình nhập
tham số trong bước 3 của quy trình này.

• Bạn có thể lưu kết quả tính toán đang được hiển thị vào một biến. Ví
dụ, nếu thực hiện thao tác sau khi màn hình trong bước 4 ở trên hiển
thị, máy sẽ lưu kết quả tính toán vào biến A:  – [A=] > [Store]. Để
biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C, D, E, F,
x, y, z)" (trang 38).

Sử dụng bảng tính
Ứng dụng Spreadsheet cho phép thực hiện các phép tính bằng cách sử
dụng bảng tính 45 hàng × 5 cột (ô A1 đến E45).
Để thực hiện các thao tác trong phần này, trước tiên hãy khởi chạy ứng
dụng Spreadsheet. Nhấn , chọn biểu tượng ứng dụng Spreadsheet,
sau đó nhấn . Thao tác này sẽ hiển thị màn hình bảng tính.

100



(1) Số hàng (1 đến 45)
(2) Chữ cái cột (A đến E)
(3) Con trỏ: Cho biết ô đang được chọn. Số hàng và chữ cái cột của ô

hiện đang được chọn được hiển thị bằng màu đen, số hàng và chữ
cái cột của ô khác được hiển thị bằng màu xám đậm.

(4) Ô chỉnh sửa: Hiển thị nội dung của ô nơi con trỏ đang được đặt.

Quan trọng!

• Bất kỳ lúc nào bạn tắt máy tính hoặc nhấn phím , mọi nội dung đã nhập vào bảng
tính sẽ bị xóa.

Nhập và chỉnh sửa nội dung trong ô
Bạn có thể nhập một hằng số hoặc một công thức vào mỗi ô.
Hằng số: Hằng số là một nội dung bất kỳ có giá trị được cố định ngay sau
khi bạn nhập vào thành công. Hằng số có thể là một giá trị số, hoặc một
biểu thức tính toán (chẳng hạn như 7+3, sin30, A1×2, v.v...) không có dấu
bằng (=) ở phía trước.
Công thức: Công thức bắt đầu bằng dấu bằng (=), chẳng hạn như
=A1×2, được thực hiện khi được viết ra.

Lưu ý

• Có thể nhập tối đa 49 byte vào một ô (số byte trước khi nội dung nhập vào được xác
nhận bằng cách nhấn ) đang được chỉnh sửa. Dưới đây là cách đếm số byte.
- Số, biến, ký hiệu: 1 byte trên mỗi ký tự
- Các lệnh, hàm: 1 byte cho mỗi lệnh hoặc hàm

Toàn bộ một lệnh hoặc hàm được tính là một byte. Ví dụ, sau đây là một byte: "√ (",
"Sum(".

• Dưới đây là số byte sử dụng sau khi nội dung nhập vào được xác nhận, theo nội dung
được nhập vào mỗi ô.
- Hằng số: 14 byte, bất kể số lượng chữ số nhập vào*
- Công thức: Số byte nhập vào (tối đa 49 byte) + 15 byte
* Nếu bạn nhập hằng số với 11 chữ số có nghĩa trở lên, giá trị sẽ được chuyển thành

10 chữ số có nghĩa khi việc nhập được xác nhận.
Ví dụ: Nếu bạn nhập 12345678915 (11 chữ số), giá trị sẽ được chuyển đổi thành
1,234567892 x 1010 (10 chữ số).
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Để hiển thị dung lượng có thể nhập vào còn lại

Nhấn , chọn [Available Memory], sau đó nhấn .

Nhập hằng số và công thức vào ô
Ví dụ 1: Vào các ô A1, A2, và A3, lần lượt nhập các hằng số 7×5, 7×6, và
A2+7 vào các ô. Sau đó, nhập công thức sau vào ô B1: =A1+7.
1. Di chuyển con trỏ tới ô A1.
2. Thực hiện thao tác phím dưới đây.

7 5 7 6 (A) 7

3. Di chuyển con trỏ tới ô B1, sau đó thực hiện thao tác phím dưới đây.

(=) (A) 7

Lưu ý

• Trên màn hình bảng tính, bạn có thể lưu giá trị trong một ô vào biến. Ví dụ, nếu thực
hiện thao tác sau khi màn hình trong bước 3 hiển thị, máy sẽ lưu 42 (kết quả tính toán
của công thức được đưa vào ô B1) vào biến A:  – [A=] > [Store]. Để biết chi tiết
về các biến số, vui lòng xem "Các biến (A, B, C, D, E, F, x, y, z)" (trang 38).

• Bạn có thể chỉ định để một công thức trong ô chỉnh sửa sẽ được hiển thị là công thức
hoặc là giá trị kết quả tính toán của công thức đó. Vui lòng xem "Các mục cài đặt
ứng dụng Spreadsheet" (trang 107).

Để chỉnh sửa dữ liệu ô hiện có

1. Di chuyển con trỏ đến ô có nội dung bạn muốn chỉnh sửa, sau đó nhấn
.

• Thay vì nhấn , bạn cũng có thể thực hiện thao tác dưới đây.
 – [Edit Cell]

• Nội dung ô trong ô chỉnh sửa sẽ thay đổi từ căn phải sang căn trái.
Con trỏ văn bản (|) sẽ xuất hiện trong ô chỉnh sửa để bạn có thể
chỉnh sửa nội dung của nó.

2. Sử dụng  và  để di chuyển con trỏ văn bản quanh nội dung của ô,
và chỉnh sửa theo mong muốn.

3. Để hoàn tất và áp dụng các chỉnh sửa, nhấn .
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Để nhập tên tham chiếu ô bằng cách sử dụng lệnh Grab

Lệnh Grab có thể được sử dụng thay cho tên tham chiếu thủ công (chẳng
hạn như A1) được nhập bằng cách sử dụng thao tác phím để chọn và
nhập vào ô mà bạn muốn tham chiếu.

Ví dụ 2: Tiếp tục từ Ví dụ 1, nhập công thức sau vào ô B2: =A2+7.
1. Di chuyển con trỏ tới ô B2.
2. Thực hiện thao tác dưới đây.

(=)  – [Spreadsheet] > [Grab]

7

Tham chiếu ô tương đối và tuyệt đối
Có hai kiểu tham chiếu ô: tương đối và tuyệt đối.

Tham chiếu ô tương đối

Tham chiếu ô (A1) trong một công thức như =A1+7 là tham chiếu tương
đối, nghĩa là nó sẽ thay đổi tùy thuộc vào ô nơi công thức được đặt. Ví dụ,
nếu công thức =A1+7 nằm trong ô B1, việc sao chép và sau đó dán vào ô
C3 sẽ cho ra kết quả là =B3+7 được nhập vào ô C3. Vì thao tác sao chép
và dán làm di chuyển công thức đi một cột (B tới C) và hai hàng (1 đến 3),
nên tham chiếu ô tương đối A1 trong công thức được di chuyển một cột
và hai hàng đến B3. Nếu kết quả của thao tác sao chép và dán khiến tên
tham chiếu ô tương đối bị thay đổi thành nội dung bất kỳ nằm ngoài phạm
vi của các ô bảng tính, chữ cái cột và/hoặc số hàng áp dụng sẽ được thay
thế bằng dấu hỏi (?), và "ERROR" sẽ được hiển thị dưới dạng dữ liệu của
ô.

Tham chiếu ô tuyệt đối

Nếu bạn muốn hàng hoặc cột, hoặc cả phần hàng và cột của tên tham
chiếu ô vẫn giữ nguyên khi dán, bạn cần tạo tên tham chiếu ô tuyệt đối.
Để tạo tham chiếu ô tuyệt đối, hãy đặt một dấu đô la ( ) ở phía trước tên
cột và/hoặc số hàng. Bạn có thể sử dụng một trong ba tham chiếu ô tuyệt
đối khác nhau: cột tuyệt đối với hàng tương đối ( A1), cột tương đối với
hàng tuyệt đối (A 1), hoặc hàng và cột đều tuyệt đối ( A 1).
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Để nhập ký hiệu tham chiếu ô tuyệt đối ( )

Khi nhập một công thức vào ô, hãy nhấn  và sau đó chọn
[Spreadsheet] > [ ].

Cách cắt và dán dữ liệu bảng tính

1. Di chuyển con trỏ đến ô bạn muốn cắt dữ liệu.
2. Nhấn , chọn [Cut & Paste], sau đó nhấn .

• Thao tác này sẽ đưa nội dung vào chế độ chờ dán. Để hủy chế độ
chờ dán, nhấn  hoặc .

3. Di chuyển con trỏ đến ô bạn muốn dán dữ liệu vừa cắt, sau đó nhấn
.

• Thao tác dán dữ liệu cũng sẽ xóa dữ liệu khỏi ô nơi bạn đã thực hiện
thao tác cắt, và tự động hủy chế độ chờ dán.

Lưu ý

• Trong trường hợp thao tác cắt và dán, các tham chiếu ô không thay đổi khi dán, bất
kể chúng là tương đối hay tuyệt đối.

Cách sao chép và dán dữ liệu bảng tính

1. Di chuyển con trỏ đến ô bạn muốn sao chép dữ liệu.
2. Nhấn , chọn [Copy & Paste], sau đó nhấn .

• Thao tác này sẽ đưa nội dung vào chế độ chờ dán. Để hủy chế độ
chờ dán, nhấn  hoặc .

3. Di chuyển con trỏ đến ô bạn muốn dán dữ liệu vừa sao chép, sau đó
nhấn .
• Chế độ chờ dán được duy trì cho đến khi bạn nhấn  hoặc , vì

vậy bạn có thể dán dữ liệu đã sao chép vào các ô khác nếu muốn.

Lưu ý

• Khi bạn sao chép nội dung của ô chứa công thức với tham chiếu tương đối, tham
chiếu tương đối sẽ thay đổi theo vị trí của ô nơi nội dung được dán.

Cách xóa dữ liệu nhập vào từ một ô cụ thể

Di chuyển con trỏ tới ô có nội dung bạn muốn xóa và nhấn .

Cách xóa nội dung của tất cả các ô trong một bảng tính

Nhấn , chọn [Delete All], sau đó nhấn .
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Sử dụng các lệnh đặc biệt của ứng dụng
Spreadsheet

Trong ứng dụng Spreadsheet, các lệnh dưới đây có thể được sử dụng
trong công thức hoặc hằng số. Những lệnh này nằm trên menu xuất hiện
khi bạn nhấn  và sau đó chọn [Spreadsheet].

Min(
Trả về giá trị nhỏ nhất trong phạm vi ô được chỉ định.
Cú pháp: Min(ô bắt đầu:ô kết thúc)

Max(
Trả về giá trị lớn nhất trong phạm vi ô được chỉ định.
Cú pháp: Max(ô bắt đầu:ô kết thúc)

Mean(
Trả về giá trị trung bình trong phạm vi ô được chỉ định.
Cú pháp: Mean(ô bắt đầu:ô kết thúc)

Sum(
Trả về giá trị tổng trong phạm vi ô được chỉ định.
Cú pháp: Sum(ô bắt đầu:ô kết thúc)

Ví dụ 3: Tiếp tục từ Ví dụ 1, nhập công thức =Sum(A1:A3), tức tính tổng
các ô A1, A2, và A3, vào ô A4.
1. Di chuyển con trỏ tới ô A4.
2. Nhập =Sum(A1:A3).

(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3. Nhấn .

Nhập hàng loạt cùng một công thức hoặc hằng số
vào nhiều ô

Bạn có thể sử dụng các quy trình trong phần này để nhập cùng một công
thức hoặc hằng số vào một chuỗi các ô cụ thể. Sử dụng lệnh Fill Formula
để nhập hàng loạt một công thức, hoặc Fill Value để nhập hàng loạt một
hằng số.
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Lưu ý

• Nếu công thức hoặc hằng số nhập vào chứa tham chiếu tương đối, tham chiếu tương
đối sẽ được nhập vào theo ô phía trên bên trái của phạm vi chỉ định. Nếu công thức
hoặc hằng số nhập vào chứa tham chiếu tuyệt đối, tham chiếu tuyệt đối sẽ được nhập
vào tất cả các ô trong phạm vi chỉ định.

Để nhập hàng loạt cùng một công thức vào một loạt các ô

Ví dụ 4: Tiếp tục từ Ví dụ 1, nhập hàng loạt vào các ô B1, B2, và B3 một
công thức nhân đôi giá trị của ô bên trái rồi trừ đi 3.
1. Di chuyển con trỏ tới ô B1.
2. Nhấn , chọn [Fill Formula], sau đó nhấn .

• Thao tác này sẽ hiển thị màn hình Fill Formula.
3. Trong dòng "Form", nhập công thức =2A1-3: 2 (A) 3 .

• Không cần nhập ký hiệu bằng (=) ở đầu.
4. Trong dòng "Range", chỉ định B1:B3 làm phạm vi nhập vào hàng loạt.

5. Để áp dụng nhập vào, nhấn .
• Thao tác này sẽ nhập = 2A1-3 vào ô B1, =2A2-3 vào ô B2, và =2A3-3

vào ô B3.

Để nhập hàng loạt cùng một hằng số vào một loạt các ô

Ví dụ 5: Tiếp tục từ Ví dụ 4, nhập hàng loạt vào các ô C1, C2, và C3 các
giá trị gấp ba lần giá trị trong các ô bên trái chúng.
1. Di chuyển con trỏ tới ô C1.
2. Nhấn , chọn [Fill Value], sau đó nhấn .

• Thao tác này sẽ hiển thị màn hình Fill Value.
3. Trong dòng "Value", nhập hằng số B1×3: (B) 3 .
4. Trong dòng "Range", chỉ định C1:C3 làm phạm vi nhập vào hàng loạt.
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5. Để áp dụng nhập vào, nhấn .
• Thao tác này sẽ nhập giá trị của mỗi kết quả tính toán vào các ô C1,

C2, và C3.

Các mục cài đặt ứng dụng Spreadsheet
Các mục cài đặt dưới đây được bao gồm trong menu TOOLS.
"◆" cho biết cài đặt mặc định ban đầu.

Auto Calc
Chỉ định có nên tự động tính lại các công thức hay không.
On◆: Cho phép tự động tính lại.
Off: Tắt tự động tính lại.

Show Cell
Chỉ định một công thức trong ô chỉnh sửa sẽ được hiển thị là công thức
hoặc là giá trị kết quả tính toán của công thức đó.
Formula◆: Hiển thị công thức.
Value: Hiển thị giá trị kết quả tính toán của công thức.

Auto Calc và Recalculate
"Auto Calc" là mục cài đặt trên menu TOOLS (vui lòng xem "Các mục cài
đặt ứng dụng Spreadsheet" (trang 107)).
Với cài đặt mặc định ban đầu của ứng dụng Spreadsheet (Auto Calc: On),
công thức trong một ô được tự động tính lại mỗi khi nội dung ô được
chỉnh sửa. Tùy thuộc vào nội dung của bảng tính, việc tính lại tự động có
thể mất nhiều thời gian để hoàn thành. Khi tắt Auto Calc (Off), bạn cần
thực hiện tính lại theo cách thủ công.

Để thực hiện tính lại theo cách thủ công

Nhấn , chọn [Recalculate], sau đó nhấn .

Lưu ý

• Ngay cả khi cài đặt Auto Calc là On, bạn cũng nên thực hiện [Recalculate] trong các
trường hợp dưới đây.
- Khi menu SETTINGS được sử dụng để thay đổi cài đặt Angle Unit
- Khi ô chứa công thức sử dụng hàm "f(" hoặc "g(" và phương trình xác định tương

ứng (f(x) hoặc g(x)) được cập nhật
- Khi ô chứa công thức sử dụng biến và biến tương ứng được cập nhật
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Tạo một bảng số
Bạn có thể sử dụng ứng dụng Table để tạo một bảng số dựa trên các
phương trình xác định được đăng ký cho các hàm f(x) và g(x).

Quy trình chung để tạo một bảng số

Ví dụ: Để tạo bảng số cho hàm f(x) = x2 + 1
2  và g(x) = x2 - 1

2  cho miền -1

≤ x ≤ 1, bước tăng 0,5

1. Nhấn , chọn biểu tượng ứng dụng Table, sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình bảng số.
• Nếu một phương trình xác định chưa được đăng ký cho một hoặc cả

hai hàm f(x) và g(x), dữ liệu ở vị trí chọn con trỏ trống, một thông báo
sẽ xuất hiện ở cuối màn hình cho biết rằng phương trình xác định
chưa được đăng ký.

2. Cấu hình cài đặt để tạo bảng số từ hai hàm.
(1) Nhấn , sau đó chọn [Table Type] > [f(x)/g(x)].
(2) Nhấn .
• Để biết thông tin về các cài đặt, vui lòng xem "Số hàng tối đa trong

bảng số theo Table Type" (trang 109).
3. Đăng ký phương trình xác định cho f(x).

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

(Màn hình ngay trước khi bạn nhấn )

4. Đăng ký phương trình xác định cho g(x).

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(Màn hình ngay trước khi bạn nhấn )

• Bạn cũng có thể sử dụng  để đăng ký biểu thức xác định. Để
biết thêm thông tin, vui lòng xem "Đăng ký phương trình xác định"
(trang 109).

5. Cấu hình cài đặt phạm vi bảng số.
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 – [Table Range]
((-))1 1 0 5

6. Nhấn .
• Thao tác này sẽ hiển thị các kết quả trong màn hình bảng số.

• Thao tác tạo bảng số làm cho nội dung của biến x bị thay đổi.

Lưu ý

• Trên màn hình bảng số, bạn có thể lưu giá trị trong một ô vào biến. Ví dụ, nếu thực
hiện thao tác sau khi màn hình trong bước 6 ở trên hiển thị, máy sẽ lưu -1 vào biến A:

 – [A=] > [Store]. Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C,
D, E, F, x, y, z)" (trang 38).

Số hàng tối đa trong bảng số theo Table Type
Bạn có thể cấu hình các cài đặt màn hình số để hiển thị cột cho cả f(x) và
g(x), hoặc cho một trong hai. Để thiết lập, hãy sử dụng menu xuất hiện khi
bạn nhấn  – [Table Type] trong khi màn hình bảng số được hiển thị.

f(x)/g(x) ... Hiển thị cả cột f(x) và g(x) (cài đặt mặc định ban đầu)
f(x) ... Chỉ hiển thị cột f(x)
g(x) ... Chỉ hiển thị cột g(x)

Số hàng tối đa trong bảng số được tạo phụ thuộc vào cài đặt Table Type.
Tối đa 45 hàng được hỗ trợ đối với cài đặt "f(x)" hoặc "g(x)", và 30 hàng
được hỗ trợ đối với cài đặt "f(x)/g(x)".

Đăng ký phương trình xác định
Có hai cách để đăng ký các phương trình xác định cho f(x) và g(x).
• Khi màn hình bảng số của ứng dụng Table được hiển thị, đăng ký một

phương trình bằng cách nhấn 
 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• Khi màn hình bảng số của ứng dụng Table được hiển thị, hoặc khi sử
dụng bất kỳ ứng dụng máy tính nào ngoại trừ Distribution, Equation
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(Simul Equation/Polynomial), Inequality, Base-N, Ratio và Math Box,
đăng ký một phương trình bằng cách nhấn 

 – [Define f(x)]
 – [Define g(x)]

Màn hình đăng ký phương trình f(x) hoặc g(x) giống nhau sẽ xuất hiện, bất
kể thao tác nào trong hai thao tác trên được sử dụng để đăng ký phương
trình xác định.

Lưu ý

• Để biết chi tiết về các thao tác sử dụng , vui lòng xem "Đăng ký và sử dụng
phương trình xác định cho f(x) và g(x)" (trang 70).

Soạn thảo dữ liệu màn hình bảng số

Để xóa một hàng

1. Trên màn hình bảng số, di chuyển con trỏ đến hàng bạn muốn xóa.
2. Nhấn .

Để chèn một hàng

1. Trên màn hình bảng số, di chuyển con trỏ đến hàng sẽ nằm dưới hàng
bạn sẽ chèn.

2. Thực hiện thao tác sau:  – [Edit] > [Insert Row].

Để xóa tất cả các nội dung màn hình bảng số

Trên màn hình bảng số, thực hiện thao tác sau:  – [Edit] > [Delete All].

Để thay đổi giá trị nhập cho ô trong cột x

Bạn có thể thay đổi giá trị trong ô x đang được đánh dấu. Việc thay đổi giá
trị x sẽ làm cho các giá trị f(x) và g(x) trong cùng một hàng được cập nhật
tương ứng.

Để nhập một giá trị vào ô cột x được đánh dấu bằng cách sử
dụng: {giá trị của ô ở trên} +/- {giá trị bước}

Nếu có giá trị trong ô x phía trên ô x đang được đánh dấu, việc nhấn 
hoặc  sẽ tự động nhập vào ô được đánh dấu một giá trị bằng với giá
trị của ô ở trên cộng với giá trị bước. Ngoài ra, việc nhấn  sẽ tự động
nhập vào giá trị bằng với giá trị của ô trên trừ giá trị bước. Các giá trị f(x)
và g(x) trong cùng một hàng cũng được cập nhật tương ứng.
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Thời điểm cập nhật f(x) và g(x)
Giá trị f(x) và g(x) hiển thị trên màn hình bảng số được cập nhật khi bất kỳ
điều nào sau đây xảy ra.
• Khi nhấn  trong khi [Execute] được chọn trên màn hình Table Range.
• Khi các phương trình xác định cho f(x) và g(x) được cập nhật (ngoại trừ

khi phương trình xác định là hàm hợp).
• Khi nhập số vào cột x (bao gồm cả thao tác nhấn , ,  trong cột

x).
• Khi Verify được chuyển từ bật sang tắt (  – [Verify OFF]).

Tuy nhiên, lưu ý rằng các giá trị không được cập nhật tự động sau các
thao tác sau đây.
• Khi menu SETTINGS được sử dụng để thay đổi cài đặt Angle Unit.
• Khi biến của một phương trình xác định được cập nhật (giá trị số mới

được lưu trữ) khi một phương trình xác định có chứa một biến (ví dụ:
f(x) = 2x + A) được đăng ký.

• Khi phương trình xác định của hàm hợp (Ví dụ: g(x) = f(x) × 2 - x) được
đăng ký, và phương trình xác định của hàm tham chiếu (Ví dụ: f(x) của
g(x) = f(x) × 2 - x) được cập nhật (phương trình xác định mới được đăng
ký).

Trong những trường hợp này, hãy thực hiện  – [Recalculate] trong khi
màn hình bảng số được hiển thị để cập nhật các giá trị.

Sử dụng Verify với ứng dụng Table
Nếu Verify được bật trong ứng dụng Table, mỗi khi bạn nhập giá trị f(x)
(hoặc giá trị g(x)) tương ứng với x trên màn hình bảng số, máy tính sẽ xác
định xem giá trị có đúng hay không.

Lưu ý

• Có thể sử dụng Verify với nhiều ứng dụng máy tính khác nhau. Trước khi thực hiện
các thao tác trong phần này, vui lòng đọc thông tin trong "Tổng quan về Verify"
(trang 73) trước.

Thao tác mẫu với Verify

Thao tác mẫu này bắt đầu với bảng số được tạo theo các cài đặt sau.

Phương trình xác định ...... f(x) = x2 + 1
2       g(x) = x2 - 1

2
Table Range ......... Start: -1, End: 1, Step: 0,5

Thực hiện quy trình tiếp tục từ bước 6 trong phần "Quy trình chung để
tạo một bảng số" (trang 108).
1. Để bật Verify, nhấn  và sau đó chọn [Verify ON].

111



• Chỉ báo  sẽ xuất hiện ở phía trên cùng của màn hình để cho biết
rằng Verify được bật.

• Thao tác này sẽ xóa tất cả nội dung của cột f(x) và g(x) của màn hình
bảng số.

2. Nhấn  để di chuyển con trỏ đến hàng đầu tiên của cột f(x).

3. Nhập giá trị f(x) (1,5) tương ứng với x = 1.

1 5

• "True" được hiển thị nếu giá trị nhập là đúng.
• "False" được hiển thị nếu giá trị nhập là sai. Nhấn , , hoặc  để

trở về màn hình bảng số và nhập lại số.
4. Nếu "True" được hiển thị, nhấn , , hoặc .

• Thao tác này sẽ trở về màn hình bảng số và di chuyển con trỏ đến
hàng tiếp theo.

• Bạn có thể tiếp tục nhập các giá trị f(x) và g(x) cho x. Mỗi lần bạn nhập
một giá trị, máy tính sẽ xác định xem giá trị đó có đúng hay không.

5. Để tắt Verify và kết thúc thao tác Verify, hãy nhấn  và sau đó chọn
[Verify OFF].
• Thao tác này sẽ làm cho chỉ báo  biến mất khỏi màn hình.
• Để biết chi tiết về thao tác tắt Verify, vui lòng xem "Để tắt Verify"

(trang 74).
• Bất kỳ thay đổi nào bạn đã thực hiện hoặc giá trị mới mà bạn đã nhập

vào giá trị cột x của màn hình bảng số trong khi Verify được bật sẽ
được giữ lại. Khi bạn tắt Verify, cột f(x) và g(x) sẽ được tính lại theo
các giá trị trong cột x.
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Lưu ý

• Nếu kết quả kiểm tra là "True", giá trị nhập vào cột f(x) hoặc g(x) có thể được lưu vào
biến. Ví dụ, nếu thực hiện thao tác sau khi màn hình trong bước 4 ở trên hiển thị, máy
sẽ lưu 1,5 vào biến A:  – [A=] > [Store]. Để biết chi tiết về các biến số, vui lòng
xem "Các biến (A, B, C, D, E, F, x, y, z)" (trang 38).

• Bạn có thể thay đổi giá trị trong ô bằng cách di chuyển con trỏ đến ô trong cột x và
nhập giá trị mới. Việc thay đổi giá trị trong ô x sẽ làm cho giá trị trong cột f(x) và g(x) bị
xóa.

• Bạn cũng có thể nhập giá trị vào ô cột x đang không chứa giá trị (nếu chưa vượt quá
số hàng tối đa). Để biết thông tin về số hàng tối đa, vui lòng xem "Số hàng tối đa
trong bảng số theo Table Type" (trang 109).

• Thao tác nhấn  trong khi Verify được bật sẽ làm tắt Verify và đồng thời xóa tất cả
dữ liệu hiện đang nhập trong bảng số.

Để xóa tất cả nội dung của cột f(x) và g(x)

Khi Verify được bật, nội dung của cột f(x) và g(x) có thể được xóa hàng
loạt. Trên màn hình bảng số, thực hiện thao tác sau:  – [Edit] > [Delete
f/g Column].

Giữ lại dữ liệu
Các thao tác sau sẽ loại bỏ một số dữ liệu và xóa một số cài đặt của ứng
dụng Table.① Trở về màn hình HOME và khởi chạy ứng dụng máy tính khác.② Nhấn .③ Thay đổi cài đặt Input/Output với menu SETTINGS.④ Thay đổi cài đặt Table Type với menu TOOLS.
Bảng dưới đây cho biết dữ liệu nào được loại bỏ và dữ liệu nào được giữ
lại.

Dữ liệu, 
Cài đặt

① ② ③ ④
Dữ liệu bảng số
(cột x, f(x), g(x))

Được loại
bỏ Được loại bỏ Được loại bỏ Được loại

bỏ

Cài đặt Table Range Được loại
bỏ Được giữ lại Được giữ lại Được giữ lại

Cài đặt Table Type Được giữ lại Được giữ lại Được giữ lại --
Các phương trình xác
định f(x), g(x) Được giữ lại Được loại bỏ Được loại bỏ Được giữ lại
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Tính toán phương trình
Ứng dụng Equation bao gồm ba hàm được mô tả dưới đây. Sau khi khởi
động ứng dụng, bạn có thể sử dụng menu Equation xuất hiện để chọn
hàm bạn muốn.

Simul Equation: Phương trình tuyến tính đồng thời với từ hai đến bốn ẩn
Polynomial: Phương trình bậc cao hơn từ bậc 2 đến 4
Solver: Hàm tìm giá trị của bất kỳ biến nào có trong phương trình đầu vào

Phương trình tuyến tính đồng thời
Ở đây, chúng tôi giải thích quy trình chung để giải phương trình đồng thời
với ví dụ giải một phương trình tuyến tính đồng thời có ba ẩn.

Ví dụ 1: 

1. Nhấn , chọn biểu tượng ứng dụng Equation, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Equation.

2. Chọn [Simul Equation], sau đó nhấn .
• Thao tác sẽ này hiển thị menu số ẩn.

3. Chọn [3 Unknowns], sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo hệ số.

4. Sử dụng Bộ soạn thảo hệ số để nhập các giá trị hệ số.
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1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• Thao tác nhấn  trong khi Bộ soạn thảo hệ số hiển thị sẽ xóa tất cả
các hệ số thành không.

5. Nhấn .
• Điều này sẽ hiển thị nghiệm.

• Trong khi chỉ báo  hiển thị, mỗi thao tác nhấn  (hoặc ) sẽ hiển
thị một nghiệm khác.

(hoặc )

(hoặc )

• Thao tác nhấn  hoặc  trong khi chỉ báo  hiển thị sẽ làm cho
nghiệm hiển thị trước đó xuất hiện lại.

• Thao tác nhấn  trong khi nghiệm cuối cùng hiển thị sẽ làm trở về
Bộ soạn thảo hệ số. Để trở về Bộ soạn thảo hệ số trong khi bất kỳ
nghiệm nào được hiển thị, nhấn .

• Thao tác nhấn  trong khi Bộ soạn thảo hệ số hiển thị sẽ làm trở về
menu số ẩn.

Lưu ý

• Trong khi Bộ soạn thảo hệ số hiển thị, bạn có thể lưu giá trị đang được đánh dấu vào
một biến. Ngoài ra, trong khi nghiệm đang hiển thị, nghiệm hiển thị hiện tại cũng có
thể được lưu vào biến. Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B,
C, D, E, F, x, y, z)" (trang 38).

Phương trình bậc cao hơn từ bậc 2 đến 4
Khi bạn giải phương trình bậc cao hơn với ứng dụng Equation, các giá trị
sau đây sẽ được hiển thị tùy theo bậc của phương trình.

• Phương trình bậc hai
Sau khi hiển thị nghiệm của ax2+bx+c=0, tọa độ nhỏ nhất (hoặc lớn
nhất) (x, y) đối với y=ax2+bx+c sẽ được hiển thị.
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• Phương trình bậc ba
Sau khi hiển thị nghiệm của ax3+bx2+cx+d=0, tọa độ (x, y) của giá trị nhỏ
nhất (hoặc giá trị lớn nhất) của y=ax3+bx2+cx+d sẽ được hiển thị, chỉ
khi giá trị nhỏ nhất hoặc giá trị lớn nhất có tồn tại. Trường hợp giá trị
nhỏ nhất hoặc giá trị lớn nhất không tồn tại, thao tác nhấn  trong khi
nghiệm cuối cùng được hiển thị sẽ làm xuất hiện thông báo "No Local
Max/Min".

• Phương trình bậc bốn
Nghiệm của ax4+bx3+cx2+dx+e=0 được hiển thị.

Ở đây, chúng tôi sẽ đưa ra ví dụ về phương trình bậc hai để giải thích quy
trình chung khi giải phương trình bậc cao hơn.

Ví dụ 2: x2 + 2x − 2 = 0
(Input/Output: MathI/MathO)
1. Nhấn , chọn biểu tượng ứng dụng Equation, sau đó nhấn .

• Thao tác này sẽ hiển thị menu Equation.

2. Chọn [Polynomial], sau đó nhấn .
• Thao tác này sẽ hiển thị menu số bậc.

3. Chọn [ax2+bx+c], sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo hệ số.

4. Sử dụng Bộ soạn thảo hệ số để nhập các giá trị hệ số.

1 2 ((-))2

• Thao tác nhấn  trong khi Bộ soạn thảo hệ số hiển thị sẽ xóa tất cả
các hệ số thành không.

5. Nhấn .
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• Điều này sẽ hiển thị nghiệm.

• Trong khi chỉ báo  hiển thị, mỗi thao tác nhấn  (hoặc ) sẽ hiển
thị kết quả tính toán (nghiệm hoặc tọa độ) khác.

(hoặc )

(Hiển thị tọa độ x nhỏ nhất của y = x2 + 2x − 2.)

(hoặc )

(Hiển thị tọa độ y nhỏ nhất của y = x2 + 2x − 2.)

(hoặc )

• Thao tác nhấn  hoặc  trong khi chỉ báo  hiển thị sẽ làm cho kết
quả tính toán hiển thị trước đó xuất hiện lại.

• Thao tác nhấn  trong khi kết quả tính toán cuối cùng hiển thị sẽ làm
trở về Bộ soạn thảo hệ số. Để trở về Bộ soạn thảo hệ số trong khi bất
kỳ kết quả tính toán nào hiển thị, nhấn .

• Thao tác nhấn  trong khi Bộ soạn thảo hệ số hiển thị sẽ làm trở về
menu số bậc.

Lưu ý

• Trong khi Bộ soạn thảo hệ số hiển thị, bạn có thể lưu giá trị đang được đánh dấu vào
một biến. Ngoài ra, trong khi kết quả tính toán (nghiệm hoặc tọa độ) hiển thị, kết quả
có thể được lưu vào một biến. Để biết chi tiết về các biến số, vui lòng xem "Các biến
(A, B, C, D, E, F, x, y, z)" (trang 38).

Hiển thị nghiệm số phức (Complex Roots)

Các phương trình bậc cao hơn có thể có nghiệm số phức. Khi Polynomial
được chọn trên menu Equation, bạn có thể sử dụng các thao tác dưới đây
để bật hoặc tắt hiển thị nghiệm số phức.

 – [Complex Roots] > [On] 
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Bật hiển thị nghiệm số phức (cài đặt mặc định ban đầu).

 – [Complex Roots] > [Off] 
Tắt hiển thị nghiệm số phức. Việc nhập và tính phương trình có một
hoặc nhiều nghiệm số phức sẽ chỉ làm thông báo "No Real Roots"
xuất hiện.

Ví dụ 3: 2x2 + 3x + 4 = 0
(Input/Output: MathI/MathO, Complex Result: a+bi, Complex Roots: On)
1. Nhấn , chọn biểu tượng ứng dụng Equation, sau đó nhấn .

• Thao tác này sẽ hiển thị menu Equation.

2. Chọn [Polynomial] > [ax2+bx+c].
• Thao tác này sẽ hiển thị Bộ soạn thảo hệ số.

3. Sử dụng Bộ soạn thảo hệ số để nhập các giá trị hệ số.

2 3 4

4. Nhấn .
• Điều này sẽ hiển thị nghiệm.

5. Hiển thị các giá trị nghiệm và tọa độ khác.

(hoặc )

(hoặc )
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(hoặc )

• Thao tác nhấn  trong khi kết quả tính toán cuối cùng hiển thị sẽ làm
trở về Bộ soạn thảo hệ số. Để trở về Bộ soạn thảo hệ số trong khi bất
kỳ kết quả tính toán nào hiển thị, nhấn .

Chuyển đổi nghiệm số phức thành tọa độ hình chữ nhật hoặc
tọa độ cực

Bạn có thể sử dụng menu FORMAT xuất hiện khi nhấn  để chuyển đổi
nghiệm số phức sang dạng thức tọa độ hình chữ nhật hoặc tọa độ cực.

Ví dụ 4: Để chuyển đổi nghiệm số phức hiển thị trong Ví dụ 3 (trang 117)
sang dạng thức tọa độ cực và sau đó chuyển sang dạng thức tọa độ hình
chữ nhật
1. Thực hiện các bước 1 đến 4 của Ví dụ 3 (trang 117).

2. Nhấn , chọn [Polar Coord], sau đó nhấn .
• Thao tác này sẽ chuyển đổi nghiệm sang dạng thức tọa độ cực.

3. Nhấn , chọn [Rectangular Coord], sau đó nhấn .
• Thao tác này sẽ chuyển đổi nghiệm sang dạng thức tọa độ hình chữ

nhật.

Sử dụng Solver
Solver dùng phương pháp Newton để tính xấp xỉ nghiệm phương trình.
Solver hỗ trợ nhập phương trình của các dạng thức sau.
Ví dụ: y = x + 5, x = sin(A), xy + C (Xem như xy + C = 0)

Ví dụ 5: Để giải x2 - B
2  = 0 tìm x khi B = 4

(Input/Output: MathI/MathO)
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Lưu ý

• Trước khi giải x2 - B
2  = 0 tìm x, 4 cần phải được lưu vào biến B. Việc này được thực

hiện trong bước 3 của quy trình dưới đây.

1. Nhấn , chọn biểu tượng ứng dụng Equation, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Equation.

2. Chọn [Solver], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình nhập phương trình Solver.

3. Ở bước này, thực hiện lưu 4 vào biến B.

4

• Thao tác này có thể được thực hiện bất kỳ lúc nào trước bước 7 của
quy trình này.

• Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C, D, E,
F, x, y, z)" (trang 38).

• Nhấn  để trở về màn hình nhập phương trình Solver.
4. Nhập phương trình.

(B) 2
(=)*0

* Bạn cũng có thể sử dụng thao tác sau để nhập dấu =:  – [Equation]
> [=].

5. Nhấn  để đăng ký phương trình nhập vào.
6. Trên màn hình Solve Target xuất hiện, xác nhận đã chọn [x] và nhấn

.
• Thao tác này sẽ hiển thị màn hình với giá trị ban đầu của x.

7. Nhập 1 làm giá trị ban đầu của x.

1

8. Sau khi chắc chắn rằng [Execute] được chọn, nhấn  để giải phương
trình.
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(1) Biến cần được giải
(2) Nghiệm
(3) Kết quả (Bên trái) − (Bên phải)

• Nghiệm bao giờ cũng được hiển thị theo dạng thức thập phân.
• Kết quả (Bên trái) - (Bên phải) này càng gần không, độ chính xác của

nghiệm càng cao.
9. Tiếp theo, nhấn phím thực hiện thao tác bạn muốn.

Để làm những điều sau: Nhấn phím:

Trở về màn hình trong bước 6. *

Lưu biểu thức đầu vào và trở về màn hình ở
bước 4.

 hoặc 

* Giá trị ban đầu khi bạn nhấn phím này sẽ trở thành giá trị ban đầu mà
bạn đã sử dụng gần nhất cho phép tính.

Quan trọng!

• Solver thực hiện hội tụ theo một số lần đặt sẵn. Nếu
không thể tìm thấy nghiệm, máy sẽ hiển thị màn hình
xác nhận giống như trong hình bên để xác nhận xem
bạn có muốn tiếp tục hay không. Nhấn  trong khi
[Continue] được chọn để tiếp tục hoặc chọn [Exit] và
nhấn  để hủy thao tác Solver.

• Tùy thuộc vào nội dung bạn nhập vào cho giá trị ban đầu cho biến nghiệm (x trong ví
dụ trên), Solver có thể không thu được nghiệm. Nếu điều này xảy ra, hãy thử thay đổi
giá trị ban đầu sao cho gần với nghiệm hơn.

• Solver có thể không xác định được nghiệm đúng, ngay cả khi nghiệm tồn tại.
• Solver sử dụng phương pháp Newton, vì vậy ngay cả khi có nhiều nghiệm, chỉ một

trong số các nghiệm sẽ được trả về.
• Do giới hạn trong phương pháp Newton, nghiệm có xu hướng khó thu được đối với

các phương trình như sau: y=sinx, y=ex, y=√x.

Sử dụng Verify với ứng dụng Equation
Ứng dụng Equation cho phép bạn sử dụng Verify cho các phương trình
đồng thời hoặc bậc cao hơn. Việc bật Verify với ứng dụng Equation sẽ
làm xuất hiện menu trả lời như hình dưới thay vì nghiệm.
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Sau khi bạn sử dụng menu này để nhập phản hồi (bằng cách chọn [Enter
Solution] và sau đó nhập vào một nghiệm, hoặc chọn [No Solution] hoặc
[Infinite Solution]), máy tính sẽ xác định xem phản hồi của bạn có đúng
hay không.

Lưu ý

• Menu trên sẽ xuất hiện trong trường hợp của Simul Equation. Một menu khác sẽ xuất
hiện trong trường hợp của Polynomial.

• Có thể sử dụng Verify với nhiều ứng dụng máy tính khác nhau. Trước khi thực hiện
các thao tác trong phần này, vui lòng đọc thông tin trong "Tổng quan về Verify"
(trang 73) trước.

• Không thể sử dụng Verify với các hàm của ứng dụng Equation dưới đây.
- [Simul Equation] > [3 Unknowns] hoặc [4 Unknowns]
- [Polynomial] > [ax3+bx2+cx+d] hoặc [ax4+bx3+cx2+dx+e]
- [Solver]
Thao tác chọn bất kỳ một trong các mục menu ở trên trên menu Equation trong khi
Verify được bật sẽ làm thông báo "Not Compatible with Verify" xuất hiện trên màn
hình.

Ví dụ về thao tác Verify

Ví dụ 6: Nhập hai nghiệm (x1 = -1 + √3, x2 = -1 - √3) của phương trình
x2 + 2x - 2 = 0 đã được giải trong Ví dụ 2 (trang 115), và xác định xem
chúng có đúng hay không. Ngoài ra, chọn xem phương trình này có giá trị
tối thiểu hoặc giá trị tối đa, nhập các giá trị tọa độ (x, y), và xác định xem
các giá trị đó có đúng hay không.
1. Thực hiện các bước 1 đến 4 của Ví dụ 2 (trang 115).

2. Để bật Verify, nhấn  và sau đó chọn [Verify ON].
• Chỉ báo  sẽ xuất hiện ở phía trên cùng của màn hình để cho biết

rằng Verify đã được bật.
3. Nhấn .

• Thao tác này sẽ hiển thị menu trả lời phương trình bậc hai.
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4. Xác nhận đã chọn [Solution], sau đó nhấn .
• Thao tác này sẽ hiển thị menu số nghiệm.

5. Tại đây, chọn [2 Solutions] và sau đó nhấn .
6. Trên màn hình nhập nghiệm xuất hiện, nhập x1 và x2.

((-))1 3
((-))1 3

7. Xác nhận đã chọn [Execute], sau đó nhấn .

• "True" sẽ xuất hiện trên màn hình nếu số lượng nghiệm và tất cả
nghiệm nhập vào là chính xác.

• "False" sẽ xuất hiện nếu số lượng nghiệm hoặc nghiệm nhập vào là
sai. Nhấn  hoặc  để trở về màn hình nhập nghiệm và nhập lại
giá trị. Để thay đổi lựa chọn về số lượng nghiệm, nhấn  trên màn
hình nhập nghiệm và bắt đầu lại từ bước 4.

8. Xác nhận đã chọn [Back To Equation], sau đó nhấn .
• Thao tác này sẽ trở về Bộ soạn thảo hệ số trong bước 1 của quy trình

này.
9. Nhấn  để hiển thị menu trả lời và sau đó chọn [Max] hoặc [Min].

• Phương trình x2 + 2x - 2 = 0 có một giá trị tối thiểu, vì vậy chúng ta sẽ
chọn [Min] và sau đó nhấn .

10. Trên màn hình nhập giá trị tọa độ xuất hiện, nhập x và y.

((-))1
((-))3

11. Xác nhận đã chọn [Execute], sau đó nhấn .
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• "True" sẽ xuất hiện trên màn hình khi lựa chọn giá trị tối đa hoặc tối
thiểu và tất cả các giá trị tọa độ nhập vào đều chính xác.

• "False" xuất hiện khi lựa chọn giá trị tối đa hoặc tối thiểu hoặc giá trị
tọa độ nhập vào là sai. Nếu điều này xảy ra, nhấn  hoặc  để trở
về màn hình nhập giá trị tọa độ và nhập lại các giá trị. Nếu bạn muốn
thay đổi lựa chọn giá trị tối đa/tối thiểu, nhấn  trên màn hình nhập
giá trị tọa độ và bắt đầu lại từ bước 9.

12. Xác nhận đã chọn [Back To Equation], sau đó nhấn .
• Thao tác này sẽ trở về Bộ soạn thảo hệ số trong bước 1 của quy trình

này.
13. Để tắt Verify và thoát khỏi thao tác Verify, hãy nhấn  và sau đó chọn

[Verify OFF].
• Thao tác này sẽ làm cho chỉ báo  biến mất khỏi màn hình.
• Để biết thông tin về cách tắt Verify, vui lòng xem "Để tắt Verify"

(trang 74).

Lưu ý

• Bạn có thể xem nghiệm và giá trị tối thiểu bằng cách chọn [Confirm Solution] ở bước 8
hoặc bước 12 của quy trình này, sau đó nhấn . Màn hình sẽ xuất hiện và các thao
tác có thể được thực hiện giống như ở bước 5 của Ví dụ 2 (trang 115).

Tính toán bất phương trình
Bạn có thể sử dụng ứng dụng Inequality để giải bất phương trình bậc 2, 3,
hoặc 4.

Quy trình chung để thực hiện tính toán bất
phương trình

Ví dụ 1: Để giải x2 + 2x - 3 ≥ 0
1. Nhấn , chọn biểu tượng ứng dụng Inequality, sau đó nhấn .

• Thao tác này sẽ hiển thị menu số bậc.

2. Chọn [ax2+bx+c], sau đó nhấn .
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3. Trên menu xuất hiện, chọn kiểu và hướng cho dấu của bất phương
trình (>,<, ≥, ≤).
• Ở đây chúng ta muốn giải x2 + 2x - 3 ≥ 0, chọn [ax2+bx+c≥0] và sau

đó nhấn .
4. Trên Bộ soạn thảo hệ số xuất hiện, nhập các giá trị hệ số.

1 2 ((-))3

5. Nhấn .
• Thao tác này sẽ hiển thị nghiệm.

• Để trở về Bộ soạn thảo hệ số trong khi nghiệm được hiển thị, nhấn
, , hoặc .

• Thao tác nhấn  trong khi Bộ soạn thảo hệ số hiển thị sẽ làm trở về
menu ở bước 2.

• Thao tác nhấn  trong khi menu ở bước 2 hiển thị sẽ làm trở về
menu số bậc.

Lưu ý

• Các nghiệm được hiển thị như trong màn hình dưới đây khi không chọn MathI/MathO
cho cài đặt Input/Output trên menu SETTINGS.

• "No Solution" xuất hiện trên màn hình nghiệm khi bất phương trình vô nghiệm (chẳng
hạn như x2 < 0).

• "All Real Numbers" xuất hiện trên màn hình nghiệm khi nghiệm của bất phương trình
đều là số (chẳng hạn như x2 ≥ 0).

Tính toán số phức
Để thực hiện tính toán số phức, trước tiên hãy khởi chạy ứng dụng
Complex.
Nhấn , chọn biểu tượng ứng dụng Complex, sau đó nhấn .
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Nhập số phức
Bạn có thể dùng tọa độ hình chữ nhật (a+bi) hoặc tọa độ cực (r∠θ) để
nhập số phức.

Ví dụ 1: Để nhập 2+3i

2 3 (i)*

* Bạn cũng có thể sử dụng thao tác sau để nhập i:  – [Complex] > [i].

Ví dụ 2: Để nhập 5∠30

5  – [Complex] > [∠] 30

Ví dụ về phép tính dùng ứng dụng Complex

Trước khi thực hiện thao tác ví dụ

• Đối với các ví dụ trong phần này, hãy sử dụng menu SETTINGS để
chọn MathI/MathO cho cài đặt Input/Output. Cấu hình các cài đặt khác
như được trình bày cho mỗi ví dụ.

• Kết quả tính toán số phức được hiển thị theo cài đặt Complex Result
trên menu SETTINGS.

• Nếu bạn định thực hiện nhập và hiển thị kết quả tính toán theo dạng
thức tọa độ cực, hãy xác định Angle Unit trên menu SETTINGS trước
khi bắt đầu tính toán.

• Giá trị θ của kết quả tính toán được hiển thị trong miền -180° < θ ≤ 180°.
• Khi không chọn MathI/MathO, màn hình kết quả tính toán sẽ hiển thị a

và bi (hoặc r và θ) trên các dòng riêng biệt.

Ví dụ 3: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)

Lưu ý

• Khi tăng một số phức lên thành lũy thừa số nguyên bằng cách sử dụng cú pháp
(a+bi)n, giá trị lũy thừa có thể nằm trong khoảng sau đây: -1 × 1010 < n < 1 × 1010.

Ví dụ 4: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)
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2  – [Complex] > [∠] 45

Ví dụ 5: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

Ví dụ 6: Để thu được số phức liên hợp của 2 + 3i
(Complex Result: a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

Ví dụ 7: Để thu được giá trị tuyệt đối và đối số của 1 + i
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

Ví dụ 8: Để trích phần thực và phần ảo của 2 + 3i

 – [Complex] > [Real Part]
2 3 (i)

 – [Complex] > [Imaginary Part]
2 3 (i)

Chuyển đổi kết quả tính toán số phức thành tọa độ hình chữ
nhật hoặc tọa độ cực

Bạn có thể sử dụng menu FORMAT xuất hiện khi bạn nhấn  để chuyển
đổi kết quả tính toán số phức sang dạng thức tọa độ hình chữ nhật hoặc
tọa độ cực.
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Ví dụ 9: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

Sử dụng Verify với ứng dụng Complex
Sau khi bật Verify trong ứng dụng Complex, bạn có thể kiểm tra xem một
phương trình hay bất phương trình có đúng hay không. Với ứng dụng
Complex, bạn có thể kiểm tra xem phương trình có chứa số phức có đúng
hay không.

Lưu ý

• Có thể sử dụng Verify với nhiều ứng dụng máy tính khác nhau. Trước khi thực hiện
các thao tác trong phần này, vui lòng đọc thông tin trong "Tổng quan về Verify"
(trang 73) trước.

• Không thể xác định được một bất phương trình có chứa số phức là đúng hay sai
(Math ERROR).

• Khi Verify được bật với ứng dụng Complex, các mục sau đây giống với các mục cho
ứng dụng Calculate.
- "Biểu thức có thể xác minh" (trang 75)
- "Thực hiện thao tác xác minh tuần tự ở phía bên phải của biểu thức" (trang 75)

Ví dụ về thao tác Verify

Ví dụ 10: Để kiểm tra xem i2 = -1 có đúng hay không
1. Để bật Verify, nhấn  và sau đó chọn [Verify ON].

• Chỉ báo  sẽ xuất hiện ở phía trên cùng của màn hình để cho biết
rằng Verify đã được bật.

2. Nhập i2 = -1 và kiểm tra xem có đúng hay không.

(i)
 – [Verify] > [=] ((-))1
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3. Để tắt Verify và thoát khỏi thao tác Verify, hãy nhấn  và sau đó chọn
[Verify OFF].
• Thao tác này sẽ làm cho chỉ báo  biến mất khỏi màn hình.
• Để biết thông tin về cách tắt Verify, vui lòng xem "Để tắt Verify"

(trang 74).

Tính toán cơ số n
Khi bạn muốn thực hiện các phép tính sử dụng các giá trị thập phân, thập
lục phân, nhị phân, và/hoặc bát phân, hãy khởi chạy ứng dụng Base-N.
Nhấn , chọn biểu tượng ứng dụng Base-N, sau đó nhấn . Cài đặt
phương thức số mặc định ban đầu khi bạn khởi chạy ứng dụng Base-N là
thập phân.

Sau khi khởi chạy ứng dụng Base-N, hãy sử dụng  để chuyển đổi
phương thức số.
Mỗi lần nhấn , máy sẽ chuyển qua các phương thức số như trình bày
dưới đây.

(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]

Lưu ý

• Các chữ số dưới được thêm vào các giá trị được trình bày trong ví dụ thể hiện cơ số
(phương thức số) của từng giá trị.
Ví dụ: 12 ... Nhị phân 1; 116 ... Thập lục phân 1

Ví dụ 1: Để tính 112 + 12

1. Sử dụng  để thay đổi phương thức số thành [Binary].
2. Thực hiện phép tính 112 + 12.

11 1

Ví dụ 2: Để tính 1F16 + 116 theo thập lục phân
1. Sử dụng  để thay đổi phương thức số thành [Hexadecimal].
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2. Thực hiện phép tính 1F16 + 116.

1 (F) 1

Lưu ý

• Sử dụng các phím sau để nhập các chữ cái từ A đến F cho các giá trị thập lục phân:
(A), (B), (C), (D), (E), (F). Bạn cũng có thể

nhập các giá trị thập lục phân bằng cách sử dụng các mục menu CATALOG được
trình bày dưới đây.

 – [Hex Value] > [A], [B], [C], [D], [E], hoặc [F]
• Lưu ý rằng nếu bạn nhập bất kỳ ký tự nào từ A đến F bằng cách thao tác như dưới

đây, ký tự đó sẽ được xem như tên biến, không phải giá trị thập lục phân.
(1) Nhấn  để hiển thị màn hình danh sách biến số.
(2) Chọn [A=], [B=], [C=], [D=], [E=], hoặc [F=], sau đó nhấn .
(3) Trên menu xuất hiện, chọn [Recall].

• Trong ứng dụng Base-N, không hỗ trợ nhập các giá trị phân số và số mũ phân số (số
thập phân). Nếu kết quả phép tính có phần phân số thì phần này sẽ bị cắt mất.

• Chi tiết về miền dữ liệu đầu vào và miền dữ liệu đầu ra (32 bits) được trình bày dưới•
đây.

Cơ số Miền

Nhị phân

Dương: 00000000000000000000000000000000 ≤ x≤
01111111111111111111111111111111
Âm: 10000000000000000000000000000000 ≤ x≤
11111111111111111111111111111111

Bát phân
Dương: 00000000000 ≤ x≤ 17777777777
Âm: 20000000000 ≤ x≤ 37777777777

Thập phân -2147483648 ≤ x ≤ 2147483647

Thập lục phân
Dương: 00000000 ≤ x≤ 7FFFFFFF
Âm: 80000000 ≤ x≤ FFFFFFFF

• Math ERROR xuất hiện khi kết quả tính toán nằm ngoài phạm vi áp dụng cho hệ
thống số đang được sử dụng.

Xác định phương thức số của giá trị nhập đặc biệt
Bạn có thể nhập một lệnh đặc biệt ngay trước một giá trị để xác định
phương thức số của giá trị đó. Các lệnh đặc biệt là: d (thập phân), h (thập
lục phân), b (nhị phân), và o (bát phân).

Ví dụ 3: Để tính 1010 + 1016 + 102 + 108 và hiển thị kết quả là giá trị thập
phân
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1. Sử dụng  để thay đổi phương thức số thành [Decimal].
2. Thực hiện phép tính 1010 + 1016 +  102 + 108.

 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

– [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

Chuyển đổi kết quả phép tính sang kiểu giá trị
khác

Bạn có thể sử dụng  để chuyển đổi kết quả phép tính đang được hiển
thị sang kiểu giá trị khác.

Ví dụ 4: Để tính 1510 × 3710 trong phương thức thập phân, rồi chuyển đổi
kết quả sang thập lục phân
1. Sử dụng  để thay đổi phương thức số thành [Decimal].
2. Thực hiện phép tính 1510 × 3710.

15 37

3. Sử dụng  để thay đổi phương thức số thành [Hexadecimal].

Phép toán logic và phủ định
Các phép toán logic và phủ định được thực hiện bằng cách nhấn  và
chọn [Logic Operation], sau đó chọn lệnh mong muốn (Neg, Not, and, or,
xor, xnor) từ menu xuất hiện. Tất cả những ví dụ sau đều được thực hiện
trong phương thức nhị phân.

Ví dụ 5: Để xác định phép và logic AND của 10102 và 11002 (10102 and
11002)

1010
 – [Logic Operation] > [and]

1100

Ví dụ 6: Để xác định phần bù theo bit của 10102 (Not(10102))
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 – [Logic Operation] > [Not]
1010

Lưu ý

• Trong trường hợp giá trị nhị phân, bát phân hoặc thập lục phân âm, máy tính chuyển
đổi giá trị này sang nhị phân, lấy phần bù của hai và sau đó chuyển ngược về phương
thức số gốc. Với giá trị thập phân, máy tính tay đơn thuần thêm dấu trừ.

Tính toán ma trận
Sử dụng ứng dụng Matrix để thực hiện các phép tính có chứa ma trận, với
tối đa 4 hàng 4 cột.

Quy trình chung để thực hiện tính toán ma trận
Để thực hiện tính toán ma trận, hãy dùng các biến ma trận đặc biệt (MatA,
MatB, MatC, MatD) như trình bày trong ví dụ dưới đây.

Ví dụ 1: Để tính 

• Để nhân (Ma trận 1 × Ma trận 2), số lượng cột trong Ma trận 1 phải
khớp với số lượng hàng trong Ma trận 2. Nếu không sẽ xảy ra lỗi.

1. Nhấn , chọn biểu tượng ứng dụng Matrix, sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình tính toán ma trận.

2. Nhấn .
• Thao tác này sẽ hiển thị màn hình danh sách biến ma trận.

• Để biết chi tiết về nội dung màn hình danh sách biến ma trận, cách
lưu biến ma trận, chỉnh sửa, hoặc các thao tác khác, vui lòng xem
"Màn hình danh sách biến ma trận" (trang 134).

3. Thực hiện các bước dưới đây để lưu  vào MatA.

(1) Chọn [MatA:], sau đó nhấn .
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• Thao tác này sẽ hiển thị màn hình cài đặt kích thước ma trận (cài
đặt mặc định ban đầu: 2 hàng, 2 cột).

(2) Ở đây, chúng ta muốn lưu một ma trận 2×2, vì vậy chọn [Confirm] và
sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo ma trận để nhập các phần tử

của ma trận 2×2 vào MatA.

(3) Nhập các phần tử của MatA.

2 1 1 1

(4) Nhấn , , hoặc  để trở về màn hình tính toán ma trận.
4. Thực hiện các bước dưới đây để lưu  vào MatB.

(1) Nhấn , chọn [MatB:], sau đó nhấn .
(2) Chọn [Confirm], sau đó nhấn .
(3) Nhập các phần tử của MatB.

2 ((-))1 ((-))1 2

(4) Nhấn , , hoặc  để trở về màn hình tính toán ma trận.
5. Nhập MatA×MatB.

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6. Nhấn .
• Thao tác này sẽ hiển thị màn hình MatAns (Bộ nhớ trả lời ma trận)

với kết quả tính toán.
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• Để biết chi tiết về MatAns, vui lòng xem "Bộ nhớ trả lời ma trận
(MatAns)" (trang 136).

• Thao tác nhấn  trong khi màn hình MatAns hiển thị sẽ làm trở về
màn hình tính toán ma trận và xoá biểu thức tính toán. Thao tác nhấn

 hoặc  sẽ làm trở về trạng thái hoàn tất nhập biểu thức tính toán
trong bước 5 của quy trình này.

Lưu ý

• Trong khi màn hình Bộ soạn thảo ma trận hoặc MatAns hiển thị, bạn có thể lưu giá trị
đang được đánh dấu vào một biến. Trong khi màn hình tính toán ma trận hiển thị và
có một giá trị kết quả tính toán ở trên màn hình, bạn có thể lưu kết quả tính toán được
hiển thị vào biến. Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C, D,
E, F, x, y, z)" (trang 38).

Màn hình danh sách biến ma trận
Màn hình danh sách biến ma trận là cổng nhập bạn nên sử dụng khi
muốn lưu một ma trận vào biến ma trận MatA, MatB, MatC, hoặc MatD,
hoặc khi muốn chỉnh sửa ma trận đã được lưu trước đó. Trạng thái của
mỗi biến ma trận được thể hiện như trong các ví dụ dưới đây.

(1) 2×2
Cho biết ma trận 2×2 được lưu vào biến ma trận.

(2) None
Cho biết không có gì được lưu vào biến ma trận.

Hiển thị màn hình danh sách biến ma trận

Tùy thuộc vào màn hình đang hiển thị, hãy thực hiện một trong các thao
tác bên dưới.
• Khi màn hình tính toán ma trận được hiển thị:

Nhấn .
• Khi màn hình Bộ soạn thảo ma trận hoặc MatAns được hiển thị:

Nhấn , chọn [Define Matrix], sau đó nhấn .

Lưu dữ liệu mới vào biến ma trận

Ví dụ 2: Để lưu ma trận 2×3 

1. Trong khi màn hình tính toán ma trận hiển thị, nhấn  để hiển thị màn
hình danh sách biến ma trận.
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2. Chọn biến ma trận (MatA, MatB, MatC, hoặc MatD) mà bạn muốn lưu
dữ liệu mới, sau đó nhấn .
• Nếu bạn chọn một biến ma trận có trạng thái là "None", hãy chuyển

sang bước 4 của quy trình này.
• Nếu bạn chọn một biến ma trận đã có ma trận được lưu vào, màn

hình menu sẽ xuất hiện. Chuyển đến bước 3.

3. Chọn [Define New], sau đó nhấn .
4. Trên màn hình "Matrix Size?" xuất hiện, chỉ định số hàng và cột trong

ma trận.

• Để chỉ định một ma trận 2×3, thực hiện các bước dưới đây.
(1) Chọn [Rows] và sau đó nhấn . Trên menu xuất hiện, chọn [2

Rows] và nhấn .
(2) Chọn [Columns] và nhấn . Trên menu xuất hiện, chọn [3 Columns]

và nhấn .
5. Sau khi chỉ định các thông số hàng và cột như mong muốn, chọn

[Confirm] và sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo ma trận.

6. Nhập các phần tử của biến ma trận.

1 0 ((-))1
0 ((-))1 1

7. Nhấn , , hoặc  để trở về màn hình tính toán ma trận.

Lưu ý

• Nội dung biến ma trận được lưu lại ngay cả khi bạn nhấn , thay đổi ứng dụng máy
tính, hoặc tắt máy tính. Việc thực hiện một trong các thao tác sau đây sẽ làm cho nội
dung của tất cả các biến ma trận bị xóa.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]
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Soạn thảo dữ liệu cho biến ma trận

1. Trong khi màn hình tính toán ma trận hiển thị, nhấn  để hiển thị màn
hình danh sách biến ma trận.

2. Chọn biến ma trận (MatA, MatB, MatC, hoặc MatD) bạn muốn chỉnh
sửa, sau đó nhấn .

3. Trên menu xuất hiện, chọn [Edit] và sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo ma trận.

4. Sử dụng Bộ soạn thảo ma trận để chỉnh sửa các phần tử của ma trận.
• Chuyển con trỏ tới ô có chứa phần tử bạn muốn thay đổi, nhập giá trị

mới, sau đó nhấn .
5. Nhấn , , hoặc  để trở về màn hình tính toán ma trận.

Sao chép nội dung biến ma trận (hoặc MatAns)

1. Hiển thị màn hình Bộ soạn thảo ma trận hoặc MatAns của biến ma trận
bạn muốn sử dụng làm nguồn sao chép.
• Để hiển thị Bộ soạn thảo ma trận, thực hiện các bước 1, 2, và 3 trong

phần "Soạn thảo dữ liệu cho biến ma trận" (trang 136).
• Để hiển thị màn hình MatAns, thực hiện các bước dưới đây trong khi

màn hình tính toán ma trận được hiển thị.
 – [Matrix] > [MatAns] 

2. Lựa chọn đích sao chép biến ma trận.
• Ví dụ, để sao chép vào MatD, thực hiện thao tác sau:  – [Store] >

[MatD].
• Thao tác này sẽ hiển thị Bộ soạn thảo ma trận với nội dung của đích

sao chép.
3. Nhấn , , hoặc  để trở về màn hình tính toán ma trận.

Bộ nhớ trả lời ma trận (MatAns)
Bất cứ khi nào kết quả của phép tính được thực hiện trong ứng dụng
Matrix là một ma trận, màn hình MatAns sẽ xuất hiện với kết quả. Kết quả
này cũng sẽ được lưu vào biến có tên "MatAns".

Biến MatAns có thể được dùng trong tính toán như được mô tả dưới đây.
• Để chèn biến MatAns vào một phép tính, thực hiện thao tác sau:  –

[Matrix] > [MatAns].
• Thao tác nhấn bất kỳ phím nào sau đây trong khi màn hình MatAns hiển

thị sẽ làm chuyển đổi tự động sang màn hình tính toán ma trận, với
"MatAns" theo sau là toán tử hoặc chức năng của phím bạn đã nhấn:

, , , , , , , ( ), ( ).
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Lưu ý

• Nội dung MatAns được lưu lại ngay cả khi bạn nhấn  hoặc tắt máy tính. Việc thực
hiện một trong các thao tác dưới đây sẽ làm cho nội dung MatAns bị xóa.
- Trở về màn hình HOME và khởi chạy ứng dụng máy tính khác
- Thực hiện  – [Reset] > [Settings & Data]
- Thực hiện  – [Reset] > [Initialize All]

Ví dụ tính ma trận

Ví dụ dưới đây sử dụng MatA = , MatB = , MatC = ,

MatD = .

Ví dụ 3: Để cộng hai ma trận (MatA + MatB)

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 

Lưu ý

• Hai ma trận phải có cùng kích thước để cộng hoặc trừ. Lỗi xảy ra nếu bạn cố gắng
cộng hoặc trừ ma trận ở các kích thước khác nhau.

Ví dụ 4: Tính bình phương và lập phương MatA (MatA2, MatA3)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]

Ví dụ 5: Để nghịch đảo MatA (MatA-1)
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 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

Lưu ý

• Chỉ có thể nghịch đảo ma trận vuông (cùng số hàng và cột). Thao tác nghịch đảo một
ma trận không vuông sẽ gây ra lỗi.

• Một ma trận với định thức bằng không thì không thể nghịch đảo. Thao tác nghịch đảo
một ma trận với định thức bằng không sẽ gây ra lỗi.

• Độ chính xác tính toán bị ảnh hưởng đối với ma trận có định thức gần bằng không.

Ví dụ 6: Để lấy định thức của MatA (Det(MatA))

 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]

Lưu ý

• Chỉ có thể lấy được định thức đối với ma trận vuông (cùng số hàng và cột). Thao tác
lấy định thức đối với một ma trận không vuông sẽ gây ra lỗi.

Ví dụ 7: Để lấy chuyển vị của MatC (Trn(MatC)).
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 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

Ví dụ 8: Để tạo một ma trận đơn vị 2 × 2 và cộng nó vào MatA (Identity(2)
+ MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

Lưu ý

• Bạn có thể chỉ định một giá trị từ 1 tới 4 làm đối số cho lệnh Identity (số chiều).

Ví dụ 9: Để lấy được giá trị tuyệt đối của từng phần tử của MatC
(Abs(MatC))

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]

Tính toán véc-tơ
Sử dụng ứng dụng Vector để thực hiện tính toán véc-tơ hai chiều và
véc-tơ ba chiều.

Quy trình chung để thực hiện tính toán véc-tơ
Để thực hiện tính toán véc-tơ, hãy dùng các biến véc-tơ đặc biệt (VctA,
VctB, VctC, VctD) như trong ví dụ dưới đây.

Ví dụ 1: Để tính (1, 2) + (3, 4)
• Khi thực hiện cộng hoặc trừ hai véc-tơ, cả hai đều phải có cùng số

chiều.
1. Nhấn , chọn biểu tượng ứng dụng Vector, sau đó nhấn .

• Thao tác này sẽ hiển thị màn hình tính toán véc-tơ.

2. Nhấn .
• Thao tác này sẽ hiển thị màn hình danh sách biến véc-tơ.
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• Để biết chi tiết về nội dung màn hình danh sách biến véc-tơ, cách lưu
biến véc-tơ, chỉnh sửa, hoặc các thao tác khác, vui lòng xem "Màn
hình danh sách biến véc-tơ" (trang 141).

3. Thực hiện các bước dưới đây để lưu (1, 2) vào VctA.
(1) Chọn [VctA:], sau đó nhấn .

• Thao tác này sẽ hiển thị màn hình cài đặt chiều véc-tơ (cài đặt
mặc định ban đầu: 2 chiều).

(2) Ở đây, chúng ta muốn lưu véc-tơ hai chiều, vì vậy chọn [Confirm] và
sau đó nhấn .

• Thao tác này sẽ hiển thị Bộ soạn thảo véc-tơ để nhập véc-tơ hai
chiều cho VctA.

(3) Nhập các phần tử của VctA.

1 2

(4) Nhấn , , hoặc  để trở về màn hình tính toán véc-tơ.
4. Thực hiện các bước dưới đây để lưu (3, 4) vào VctB.

(1) Nhấn , chọn [VctB:], sau đó nhấn .
(2) Chọn [Confirm], sau đó nhấn .
(3) Nhập các phần tử của VctB.

3 4

(4) Nhấn , , hoặc  để trở về màn hình tính toán véc-tơ.
5. Nhập VctA+VctB.

 – [Vector] > [VctA]
 – [Vector] > [VctB]
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6. Nhấn .
• Thao tác này sẽ hiển thị màn hình VctAns (Bộ nhớ trả lời véc-tơ) với

kết quả tính toán.

• Để biết chi tiết về VctAns, vui lòng xem "Bộ nhớ trả lời véc-tơ
(VctAns)" (trang 143).

• Thao tác nhấn  trong khi màn hình VctAns hiển thị sẽ làm trở về
màn hình tính toán véc-tơ và xoá biểu thức tính toán. Thao tác nhấn

 hoặc  sẽ làm trở về trạng thái hoàn tất nhập biểu thức tính toán
trong bước 5 của quy trình này.

Lưu ý

• Trong khi màn hình Bộ soạn thảo véc-tơ hoặc VctAns hiển thị, bạn có thể lưu giá trị
đang được đánh dấu vào một biến. Trong khi màn hình tính toán véc-tơ hiển thị và có
giá trị kết quả tính toán trên màn hình, bạn có thể lưu kết quả tính toán được hiển thị
vào biến. Để biết chi tiết về các biến số, vui lòng xem "Các biến (A, B, C, D, E, F, x, y,
z)" (trang 38).

Màn hình danh sách biến véc-tơ
Màn hình danh sách biến véc-tơ là cổng nhập bạn nên sử dụng khi muốn
lưu một véc-tơ vào biến véc-tơ VctA, VctB, VctC, hoặc VctD, hoặc khi
muốn chỉnh sửa véc-tơ đã được lưu trước đó. Trạng thái của mỗi biến
véc-tơ được thể hiện như trong các ví dụ dưới đây.

(1) 2
Cho biết rằng véc-tơ hai chiều được lưu vào biến véc-tơ.

(2) None
Cho biết rằng không có gì được lưu vào biến véc-tơ.

Hiển thị màn hình danh sách biến véc-tơ

Tùy thuộc vào màn hình đang hiển thị, hãy thực hiện một trong các thao
tác bên dưới.
• Khi màn hình tính toán véc-tơ được hiển thị:

Nhấn .
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• Khi màn hình Bộ soạn thảo véc-tơ hoặc VctAns được hiển thị:
Nhấn , chọn [Define Vector], sau đó nhấn .

Lưu dữ liệu mới vào biến véc-tơ

Ví dụ 2: Để lưu véc-tơ ba chiều (1, 2, 3)
1. Trong khi màn hình tính toán véc-tơ hiển thị, nhấn  để hiển thị màn

hình danh sách biến véc-tơ.
2. Chọn biến véc-tơ (VctA, VctB, VctC, hoặc VctD) mà bạn muốn lưu dữ

liệu mới, sau đó nhấn .
• Nếu bạn chọn một biến véc-tơ có trạng thái là "None", hãy chuyển

sang bước 4 của quy trình này.
• Nếu bạn chọn một biến véc-tơ đã có véc-tơ được lưu vào, màn hình

menu sẽ xuất hiện. Chuyển đến bước 3.

3. Chọn [Define New], sau đó nhấn .
4. Trên màn hình "Vector Dimension?" xuất hiện, hãy chỉ định số chiều

véc-tơ.

• Để chỉ định ba chiều, thực hiện các bước dưới đây.
(1) Chọn [Dimensions] và nhấn .
(2) Trên menu xuất hiện, chọn [3 Dimensions] và nhấn .

5. Sau khi chỉ định thông số chiều như mong muốn, chọn [Confirm] và sau
đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo véc-tơ.

6. Nhập các phần tử của biến véc-tơ.

1 2 3

7. Nhấn , , hoặc  để trở về màn hình tính toán véc-tơ.
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Lưu ý

• Nội dung biến véc-tơ được lưu lại ngay cả khi bạn nhấn , thay đổi ứng dụng máy
tính, hoặc tắt máy tính. Việc thực hiện một trong các thao tác dưới đây sẽ làm cho nội
dung của tất cả các biến véc-tơ bị xóa.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Soạn thảo dữ liệu cho biến véc-tơ

1. Trong khi màn hình tính toán véc-tơ hiển thị, nhấn  để hiển thị màn
hình danh sách biến véc-tơ.

2. Chọn biến véc-tơ (VctA, VctB, VctC, hoặc VctD) bạn muốn chỉnh sửa,
sau đó nhấn .

3. Trên menu xuất hiện, chọn [Edit] và sau đó nhấn .
• Thao tác này sẽ hiển thị Bộ soạn thảo véc-tơ.

4. Sử dụng Bộ soạn thảo véc-tơ để chỉnh sửa các phần tử của véc-tơ.
• Chuyển con trỏ tới ô có chứa phần tử bạn muốn thay đổi, nhập giá trị

mới, sau đó nhấn .
5. Nhấn , , hoặc  để trở về màn hình tính toán véc-tơ.

Sao chép nội dung biến véc-tơ (hoặc VctAns)

1. Hiển thị màn hình Bộ soạn thảo véc-tơ hoặc VctAns của biến véc-tơ
bạn muốn sử dụng làm nguồn sao chép.
• Để hiển thị Bộ soạn thảo véc-tơ, thực hiện các bước 1, 2, và 3 trong

phần "Soạn thảo dữ liệu cho biến véc-tơ" (trang 143).
• Để hiển thị màn hình VctAns, thực hiện các bước dưới đây trong khi

màn hình tính toán véc-tơ được hiển thị.
 – [Vector] > [VctAns] 

2. Chọn đích sao chép biến véc-tơ.
• Ví dụ, để sao chép vào VctD, thực hiện thao tác sau:  – [Store] >

[VctD].
• Thao tác này sẽ hiển thị Bộ soạn thảo véc-tơ với nội dung của đích

sao chép.
3. Nhấn , , hoặc  để trở về màn hình tính toán véc-tơ.

Bộ nhớ trả lời véc-tơ (VctAns)
Bất cứ khi nào kết quả của phép tính được thực hiện trong ứng dụng
Vector là một véc-tơ, màn hình VcAns sẽ xuất hiện với kết quả. Kết quả
này cũng sẽ được lưu vào biến có tên "VctAns".

Biến VctAns có thể được dùng trong tính toán như được mô tả sau đây.
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• Để chèn biến VctAns vào một phép tính, thực hiện thao tác sau:  –
[Vector] > [VctAns].

• Thao tác nhấn bất kỳ phím nào sau đây trong khi màn hình VctAns
hiển thị sẽ làm chuyển đổi tự động sang màn hình tính toán véc-tơ, với
"VctAns" theo sau là toán tử hoặc chức năng của phím bạn đã nhấn:

, , , , , , , ( ), ( ).

Lưu ý

• Nội dung VctAns được lưu lại ngay cả khi bạn nhấn  hoặc tắt máy tính. Việc thực
hiện một trong các thao tác dưới đây sẽ làm cho nội dung VctAns bị xóa.
- Trở về màn hình HOME và khởi chạy ứng dụng máy tính khác
- Thực hiện  – [Reset] > [Settings & Data]
- Thực hiện  – [Reset] > [Initialize All]

Ví dụ tính véc-tơ
Các ví dụ dưới đây sử dụng VctA = (1, 2) và VctB = (3, 4), và VctC = (2,
-1, 2).

Ví dụ 3: VctA • VctB (Tích vô hướng véc-tơ)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

Lưu ý

• Khi tính tích vô hướng, số chiều của hai véc-tơ phải giống nhau.

Ví dụ 4: VctA × VctB (Tích có hướng véc-tơ)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

Lưu ý

• Khi tính tích có hướng, số chiều của hai véc-tơ phải giống nhau.
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Ví dụ 5: Để xác định góc tạo bởi VctA và VctB chính xác đến ba chữ số
thập phân. (Number Format: Fix 3, Angle Unit: Degree)

 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

Lưu ý

• Khi tính góc tạo bởi hai véc-tơ, số chiều của hai véc-tơ phải giống nhau.

Ví dụ 6: Để chuẩn hóa VctB

 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]

Ví dụ 7: Để thu được giá trị tuyệt đối của VctC

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]

Tính toán tỷ lệ
Ứng dụng Ratio cho phép bạn xác định giá trị của X trong biểu thức tỷ lệ
A: B = X : D (hoặc A : B = C : X) khi giá trị của A, B, C và D đều đã biết.

Quy trình chung để thực hiện tính toán tỷ lệ
Ví dụ 1: Để giải 3: 8 = X : 12 tìm X
1. Nhấn , chọn biểu tượng ứng dụng Ratio, sau đó nhấn .
2. Trên menu xuất hiện, chọn [A:B=X:D] hoặc [A:B=C:X].

• Ở đây chúng ta muốn giải 3 : 8 = X : 12 tìm X, vì vậy chọn [A:B=X:D],
sau đó nhấn .

3. Trên Bộ soạn thảo hệ số xuất hiện, nhập các giá trị hệ số.
• Ở đây chúng ta nhập vào các hệ số sau đây: A = 3, B = 8, D = 12.

3 8 12

4. Sau khi điều chỉnh tất cả các giá trị theo ý muốn của bạn, nhấn .
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• Thao tác này sẽ hiển thị nghiệm (giá trị của X).

• Nhấn , , hoặc  để trở về Bộ soạn thảo hệ số.

Lưu ý

• Math ERROR sẽ xảy ra nếu bạn thực hiện tính toán trong khi 0 là đầu vào cho hệ số.
• Thực hiện các bước dưới đây sẽ đặt lại tất cả các hệ số trong Bộ soạn thảo hệ số

thành 0.
- Trong khi Bộ soạn thảo hệ số hiển thị, nhấn , , , hoặc .
- Khi nghiệm hiển thị, nhấn  hoặc .

• Bạn có thể lưu kết quả tính toán đang được hiển thị vào một biến. Ví dụ, nếu thực
hiện thao tác sau khi màn hình trong bước 4 ở trên hiển thị, máy sẽ lưu kết quả tính
toán vào biến A:  – [A=] > [Store]. Để biết chi tiết về các biến số, vui lòng xem
"Các biến (A, B, C, D, E, F, x, y, z)" (trang 38).

Để thay đổi loại biểu thức tỷ lệ

1. Trong khi Bộ soạn thảo hệ số hiển thị, nhấn .
2. Trên menu xuất hiện, chọn loại biểu thức tỷ lệ bạn muốn.

Ví dụ về phép tính
Ví dụ 2: Để tính toán X theo tỉ lệ 1: 2 = X : 10

 – [Ratio] > [A:B=X:D]
1 2 10

Sử dụng Math Box
Ứng dụng Math Box có các chức năng hỗ trợ học tập sau đây.
Dice Roll: Dice Roll là chức năng mô phỏng xác suất xúc xắc.
Coin Toss: Coin Toss là chức năng mô phỏng xác suất tung đồng xu.
Number Line: Number Line đăng ký tối đa ba phương trình hoặc bất
phương trình và hiển thị các trục số của chúng.
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Circle: Circle sử dụng đồ thị Unit Circle hoặc Half Circle để hiển thị các
giá trị góc và lượng giác. Bạn cũng có thể sử dụng đồ thị Clock để hiển thị
góc.

Dice Roll
Dice Roll thực hiện mô phỏng một, hai, hoặc ba xúc xắc ảo tung một số
lần xác định. Bạn có thể chọn một trong hai màn hình sau đây đối với kết
quả.

Màn hình List

Màn hình Relative Freq

Quy trình thao tác chung của Dice Roll

Ví dụ: Để mô phỏng 100 lần tung của hai xúc xắc. Đối với ví dụ này, màn
hình Relative Freq được sử dụng cho kết quả mô phỏng, hiển thị số lần
xuất hiện (tần số) và tần số tương đối trong sự khác biệt về con số (0, 1,
2, 3, 4, 5) giữa hai viên xúc xắc mỗi lần tung.

1. Nhấn , chọn biểu tượng ứng dụng Math Box, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Math Box.

2. Chọn [Dice Roll], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình nhập tham số.

Dice: Chọn số lượng xúc xắc là 1, 2, hoặc 3.
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Attempts: Nhập số lần tung xúc xắc (số lần thử) dưới dạng giá trị từ 1
đến 250.
Same Result: Cài đặt này thường là Off (cài đặt mặc định ban đầu). Để
biết chi tiết, vui lòng xem "Cài đặt Same Result" (trang 150).

3. Chọn từng cài đặt menu và cấu hình theo cách bạn muốn.
(1) Chọn [Dice] và nhấn . Trên menu xuất hiện, chọn [2 Dice] và nhấn

.
(2) Chọn [Attempts] và nhấn . Trên màn hình nhập xuất hiện, nhập

100 và nhấn . Chọn [Confirm] và nhấn .
(3) Để nguyên [Same Result] là Off (cài đặt mặc định ban đầu).

4. Sau khi tất cả các cài đặt được đặt theo cách bạn muốn, chọn [Execute]
và nhấn .
• Màn hình hiển thị việc thực hiện mô phỏng sẽ xuất hiện, và sau đó

màn hình sẽ chuyển sang menu Result Type.

List: Hiển thị danh sách kết quả của từng lần tung (lần thử).*1

Relative Freq: Hiển thị số lần xuất hiện dựa trên kết quả tung*2 và tần
số tương đối của chúng.
*1 Khi có hai xúc xắc, kết quả của mỗi lần tung được hiển thị cùng với

tổng và hiệu số của mỗi lần tung. Khi có ba xúc xắc, kết quả của mỗi
lần tung được hiển thị cùng với tổng số của mỗi lần tung.

*2 Kết quả (1 đến 6) trong trường hợp một xúc xắc, tổng (2 đến 12)
hoặc hiệu (0 đến 5) của kết quả trong trường hợp hai xúc xắc, và
tổng (3 đến 18) của kết quả trong trường hợp ba xúc xắc.

5. Sử dụng menu Result Type để chọn dạng thức hiển thị kết quả.
(1) Ở đây, chúng ta muốn hiển thị số lần xuất hiện và tần số tương đối,

vì vậy chọn [Relative Freq] và nhấn .
• Thao tác này sẽ hiển thị menu lựa chọn [Sum] hoặc [Difference].

(2) Ở đây, chúng ta muốn hiển thị hiệu số trong kết quả của mỗi lần
tung, vì vậy chọn [Difference] và nhấn .

• Kết quả mô phỏng được hiển thị trên màn hình Relative Freq.

(Mỗi lần thực hiện sẽ cho kết quả khác nhau.)

• Để biết chi tiết về màn hình kết quả mô phỏng, vui lòng xem
"Màn hình kết quả Dice Roll" (trang 149).

6. Để hiển thị kết quả bằng dạng thức khác, hiển thị màn hình kết quả và
sau đó nhấn .

148



• Thao tác này sẽ trở về menu Result Type, vì vậy bạn có thể lặp lại
bước 5 của quy trình này và thay đổi dạng thức hiển thị kết quả.

7. Nếu bạn muốn thực hiện mô phỏng với các cài đặt khác, nhấn  trong
khi menu Result Type được hiển thị.
• Thao tác này sẽ xóa kết quả mô phỏng và trở về màn hình nhập tham

số. Thực hiện lại quy trình từ bước 3.
8. Để thoát Dice Roll, nhấn  trong khi màn hình nhập tham số hiển thị.

• Thao tác này sẽ trở về menu Math Box.

Lưu ý

• Trên màn hình Relative Freq, bạn có thể lưu giá trị trong ô cột Rel Fr vào biến. Ví dụ,
nếu thực hiện thao tác sau trong bước 5 ở trên, máy sẽ lưu giá trị trong hàng đầu tiên
của cột "Rel Fr" vào biến A:  – [A=] > [Store]. Để biết chi tiết về các biến số, vui
lòng xem "Các biến (A, B, C, D, E, F, x, y, z)" (trang 38).

Màn hình kết quả Dice Roll

• Màn hình List

(1) Mỗi hàng thể hiện một lần tung theo tuần tự. Ví dụ, 1 là lần tung đầu
tiên, 2 là lần tung thứ hai, v.v...

(2) A, B, và C cho biết mỗi xúc xắc đang được sử dụng. "Sum" là tổng
kết quả và "Diff" là hiệu số giữa kết quả của hai xúc xắc. Các cột
xuất hiện trên màn hình phụ thuộc vào số lượng xúc xắc đang được
sử dụng.
1 xúc xắc: Chỉ cột A.
2 xúc xắc: Các cột A, B, Sum, và Diff.
3 xúc xắc: Các cột A, B, C, và Sum.

• Màn hình Relative Freq
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(1) Sum hoặc Diff: Thể hiện kết quả một xúc xắc (Sum: 1 đến 6), tổng
kết quả hai xúc xắc (Sum: 2 đến 12) hoặc hiệu (Diff: 0 đến 5), hoặc
tổng kết quả ba xúc xắc (Sum: 3 đến 18).

(2) Freq: Thể hiện số lần xuất hiện (tần số) của mỗi kết quả tung.
(3) Rel Fr: Thể hiện tần số tương đối (tần số chia cho số lần tung) của

kết quả tung.
(4) Số lần thử
(5) Giá trị của ô Rel Fr được đánh dấu

Cài đặt Same Result

Khi thực hiện mô phỏng Dice Roll hoặc Coin Toss với Same Result ở cài
đặt mặc định ban đầu (Off), mỗi lần thực hiện sẽ hiển thị kết quả (ngẫu
nhiên) khác nhau. Nếu cài đặt Same Result được thay đổi khác với Off,
kết quả hiển thị là kết quả được xác định bởi máy tính. Sử dụng cài đặt
#1, #2, hoặc #3 sẽ hữu ích khi bạn muốn tất cả các máy tính sinh viên sử
dụng trong lớp hiển thị cùng một kết quả.

Lưu ý

• Để có nhiều máy tính hiển thị cùng một kết quả, hãy đảm bảo rằng các cài đặt dưới
đây giống nhau trên tất cả các máy tính.
- Số lượng xúc xắc hoặc đồng xu
- Số lần thử (tung xúc xắc hoặc tung đồng xu)
- Cài đặt Same Result (#1, #2, hoặc #3)

Coin Toss
Coin Toss thực hiện mô phỏng một, hai, hoặc ba đồng xu ảo tung một số
lần xác định. Bạn có thể chọn một trong hai màn hình sau đây đối với kết
quả.

Màn hình List
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Màn hình Relative Freq

Màn hình sẽ hiển thị mặt ngửa là  và mặt sấp là .

Quy trình thao tác chung của Coin Toss

Ví dụ: Để mô phỏng 100 lần tung ba đồng xu. Đối với ví dụ này, màn hình
Relative Freq được sử dụng cho kết quả mô phỏng, thể hiện số lượng các
mặt ngửa (0, 1, 2, 3) và tần số tương đối của các mặt ngửa của mỗi lần
tung.

1. Nhấn , chọn biểu tượng ứng dụng Math Box, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Math Box.

2. Chọn [Coin Toss], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình nhập tham số.

Coins: Chọn số lượng đồng xu là 1, 2, hoặc 3.
Attempts: Nhập số lần tung đồng xu (số lần thử) dưới dạng giá trị từ 1
đến 250.
Same Result: Cài đặt này thường là Off (cài đặt mặc định ban đầu). Để
biết chi tiết, vui lòng xem "Cài đặt Same Result" (trang 150).

3. Chọn từng cài đặt menu và cấu hình theo cách bạn muốn.
(1) Chọn [Coins] và sau đó nhấn . Trên menu xuất hiện, chọn [3

Coins] và sau đó nhấn .
(2) Chọn [Attempts] và nhấn . Khi màn hình nhập xuất hiện, nhập 100

và nhấn . Chọn [Confirm] và nhấn .
(3) Để nguyên [Same Result] là Off (cài đặt mặc định ban đầu).

4. Sau khi tất cả các cài đặt được đặt theo cách bạn muốn, chọn [Execute]
và nhấn .
• Màn hình hiển thị việc thực hiện mô phỏng sẽ xuất hiện, và sau đó

màn hình sẽ chuyển sang menu Result Type.
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List: Hiển thị danh sách các mặt ngửa hoặc mặt sấp*1 đối với mỗi lần
tung (lần thử).
Relative Freq: Hiển thị số lần xảy ra đối với mỗi đồng xu xuất hiện mặt
ngửa,*2 và tần số tương đối của chúng.
*1 Khi có hai hoặc ba đồng xu thì sẽ hiển thị số lượng đồng xu xuất hiện

mặt ngửa mỗi lần tung.
*2 Đối với hai hoặc ba đồng xu. Khi có một đồng xu, màn hình này sẽ

hiển thị tần số của mặt ngửa và mặt sấp và tần số tương đối.
5. Sử dụng menu Result Type để chọn dạng thức hiển thị kết quả.

Ở đây chúng ta muốn hiển thị số lần xuất hiện và tần số tương đối, vì
vậy chọn [Relative Freq] và nhấn .
• Kết quả mô phỏng được thể hiện trên màn hình Relative Freq.

(Mỗi lần thực hiện sẽ cho kết quả khác nhau.)

• Để biết chi tiết về màn hình kết quả mô phỏng, vui lòng xem "Màn
hình kết quả Coin Toss" (trang 152).

6. Để hiển thị kết quả bằng dạng thức khác, hiển thị màn hình kết quả và
sau đó nhấn .
• Thao tác này sẽ trở về menu Result Type, vì vậy bạn có thể lặp lại

bước 5 của quy trình này và thay đổi dạng thức hiển thị kết quả.
7. Nếu bạn muốn thực hiện mô phỏng với các cài đặt khác, nhấn  trong

khi menu Result Type được hiển thị.
• Thao tác này sẽ xóa kết quả mô phỏng và trở về màn hình nhập tham

số. Thực hiện lại quy trình từ bước 3.
8. Để thoát Coin Toss, nhấn  trong khi màn hình nhập tham số hiển thị.

• Thao tác này sẽ trở về menu Math Box.

Lưu ý

• Trên màn hình Relative Freq, bạn có thể lưu giá trị trong ô cột Rel Fr vào biến. Ví dụ,
nếu thực hiện thao tác sau trong bước 5 ở trên, máy sẽ lưu giá trị trong hàng đầu tiên
của cột "Rel Fr" vào biến A:  – [A=] > [Store].

Màn hình kết quả Coin Toss

• Màn hình List
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(1) Mỗi hàng thể hiện một lần tung theo tuần tự. Ví dụ, 1 là lần tung đầu
tiên, 2 là lần tung thứ hai, v.v...

(2) A, B, và C cho biết mỗi đồng xu đang được sử dụng. Khi sử dụng
hai hoặc ba đồng xu, cột  bên phải sẽ hiển thị số lượng đồng xu
xuất hiện mặt ngửa.

• Màn hình Relative Freq

(1) Side: Khi chỉ sử dụng một đồng xu thì " " biểu thị mặt ngửa trong
khi " " biểu thị mặt sấp. Khi sử dụng hai hoặc ba đồng xu, cột này
sẽ hiển thị số mặt ngửa (0 đến 3).

(2) Freq: Thể hiện số lần xuất hiện (tần số) của mỗi kết quả tung.
(3) Rel Fr: Thể hiện tần số tương đối (tần số chia cho số lần tung) của

kết quả tung.
(4) Số lần thử
(5) Giá trị của ô Rel Fr được đánh dấu

Number Line
Number Line đăng ký tối đa ba phương trình hoặc bất phương trình và
hiển thị các biểu đồ trục số của chúng. Dưới đây là các loại biểu thức có
thể được chọn.

x<a, x≤a, x=a, x>a, x≥a, a<x<b, a≤x<b, a<x≤b, a≤x≤b
Các giá trị bạn nhập vào cho a và b trong các biểu thức ở trên phải nằm
trong miền như được xác định dưới đây.

-1×1010 ≤ a ≤ 1×1010

-1×1010 ≤ b ≤ 1×1010

Quy trình thao tác chung của Number Line

Ví dụ: Để đăng ký ba bất phương trình sau và hiển thị biểu đồ trục số của
chúng: x≤-1,5, x>-1,0, -2,0<x≤-0,5
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1. Nhấn , chọn biểu tượng ứng dụng Math Box, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Math Box.

2. Chọn [Number Line], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình đăng ký biểu thức.

3. Thực hiện các bước dưới đây để đăng ký x≤-1,5 cho Trục A.
(1) Chọn [A:], sau đó nhấn .
(2) Trên danh sách loại biểu thức xuất hiện, chọn [x≤a] và nhấn .

(3) Nhập -1,5 cho a.

((-))1 5

(4) Sau khi chắc chắn rằng [Confirm] được chọn, nhấn .

4. Sử dụng các bước trình bày trong bước 3 để đăng ký x>-1,0 cho Trục B
và -2,0<x≤-0,5 cho Trục C.

[B:] > [x>a]
((-))1 0

[C:] > [a<x≤b]
((-))2 0

((-))0 5

5. Sau khi bạn hoàn tất đăng ký tất cả các biểu thức, chọn [Execute] trên
màn hình đăng ký biểu thức, sau đó nhấn .
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• Thao tác này sẽ hiển thị màn hình biểu đồ trục số. Bạn có thể sử
dụng  và  để cuộn biểu đồ trục số sang trái hoặc phải.

(1) Thể hiện các trục số của các phương trình hoặc bất phương trình
được đăng ký trong các trục A, B, và C theo thứ tự từ trên xuống
dưới. Ý nghĩa của mũi tên (←, →) và vòng tròn ( , ) hiển thị ở
một trong hai đầu của trục số được mô tả dưới đây.
← Cho biết sự tiếp tục của một miền nhỏ hơn a trong bất phương

trình x<a, hoặc một miền nhỏ hơn hoặc bằng a trong x≤a.
→ Cho biết sự tiếp tục của một miền lớn hơn a trong bất phương

trình x>a hoặc một miền lớn hơn hoặc bằng a trong x≥a.
Cho biết giá trị này (trong trường hợp phương trình) hoặc có bao
gồm giá trị này (trong trường hợp bất phương trình).

Cho biết không có bao gồm giá trị này (trong trường hợp bất
phương trình).

(2) Trục x. Trục này hiển thị giá trị trung tâm và một trong hai giá trị đầu.
(3) Hiển thị các phương trình hoặc bất phương trình của trục số đang

chọn (trục số đang được hiển thị in đậm). Để hiển thị một biểu thức
trục số khác, sử dụng  và  để di chuyển phần tô đậm đến trục
số có biểu thức bạn muốn xem.

6. Để thay đổi biểu thức, hãy hiển thị màn hình biểu đồ trục số và sau đó
nhấn .
• Thao tác này sẽ trở về màn hình đăng ký biểu thức. Bạn chỉ có thể

thay đổi giá trị của một biểu thức đã đăng ký, hoặc bạn có thể đăng
ký lại loại biểu thức khác. Để biết thông tin về cách thực hiện thao tác
này, vui lòng xem "Sửa đổi biểu thức đã đăng ký" (trang 155).

7. Để thoát Number Line, nhấn  trên màn hình đăng ký biểu thức.
• Thao tác này sẽ xóa biểu thức đã đăng ký và trở lại menu Math Box.

Quan trọng!

• Nếu bạn thay đổi cài đặt Angle Unit trên menu SETTINGS, tất cả các biểu thức đã
đăng ký trong Number Line sẽ bị xóa.

Sửa đổi biểu thức đã đăng ký

Để sửa đổi biểu thức đã đăng ký
Ví dụ: Để thay đổi biểu thức trong Trục C (-2,0<x≤-0,5) thành -1,5<x≤0,5
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1. Trên màn hình đăng ký biểu thức, chọn Trục C và sau đó nhấn .
2. Trên menu xuất hiện, chọn [Edit] và sau đó nhấn .
3. Nhập -1,5 cho a và 0,5 cho b.

((-))1 5 0 5
4. Sau khi chắc chắn rằng [Confirm] được chọn, nhấn .

Để đăng ký lại loại biểu thức khác
Ví dụ: Để thay đổi biểu thức trong Trục A (x≤-1,5) thành x=-1,5
1. Trên màn hình đăng ký biểu thức, chọn Trục A và sau đó nhấn .
2. Trên menu xuất hiện, chọn [Define New] và sau đó nhấn .
3. Trên danh sách loại biểu thức xuất hiện, chọn [x=a] và nhấn .
4. Nhập -1,5 cho a.

((-))1 5
5. Sau khi chắc chắn rằng [Confirm] được chọn, nhấn .

Để xóa biểu thức đã đăng ký
Trên màn hình đăng ký biểu thức, chọn biểu thức đã đăng ký mà bạn
muốn xóa, sau đó nhấn .

Thay đổi phạm vi hiển thị của màn hình biểu đồ trục số (View-
Window)

Khi bạn đăng ký một biểu thức và hiển thị màn hình biểu đồ trục số, các
cài đặt phạm vi hiển thị tối ưu sẽ được cấu hình tự động. Bạn có thể thay
đổi phạm vi hiển thị bằng cách thay đổi cài đặt Center (1) và Scale (2) của
trục x. Sử dụng màn hình View-Window để thay đổi cài đặt phạm vi hiển
thị.

Ví dụ: Để thay đổi cài đặt Scale của trục x thành 1 và cài đặt Center thành
2, và hiển thị biểu đồ trục số

1. Hiển thị màn hình biểu đồ trục số.
2. Nhấn , chọn [View-Window], sau đó nhấn .

• Thao tác này sẽ hiển thị màn hình View-Window.
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3. Nhập 1 cho [Scale] và 2 cho [Center].

1 2

4. Sau khi chắc chắn rằng [Execute] được chọn, nhấn .

Lưu ý

• Giá trị tối đa và tối thiểu cho trục x phụ thuộc vào cài đặt Center và Scale như trình
bày dưới đây.
Giá trị tối đa: (Giá trị Center) + (Giá trị Scale) × 8
Giá trị tối thiểu: (Giá trị Center) - (Giá trị Scale) × 8

• Sau khi thay đổi cài đặt View-Window, bạn có thể khôi phục cài đặt Center và Scale
về cài đặt phạm vi hiển thị được cấu hình tự động bằng cách thực hiện thao tác:  –
[View-Reset].

• Các giá trị bạn nhập cho Scale và Center phải nằm trong phạm vi được xác định dưới
đây.

1×10-10 ≤ Scale ≤ 1×1010

-1×1010 ≤ Center ≤ 1×1010

Circle
Circle cung cấp các hàm được mô tả sau đây, có thể được sử dụng để tìm
hiểu về góc và các hàm lượng giác.
• Đồ thị Unit Circle và Half Circle

Đồ thị Unit Circle hiển thị đường tròn hoàn chỉnh với bán kính 1, trong khi
đồ thị Half Circle hiển thị một nửa đường tròn với bán kính 1. Cả đường
tròn hoàn chỉnh và một nửa đường tròn đều có tâm là gốc tọa độ hình chữ
nhật. Các hình bên dưới thể hiện từng loại đường tròn với các góc θ1 và
θ2, cùng với các giá trị hàm lượng giác.

Unit Circle
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Half Circle

• Đồ thị Clock
Đồ thị Clock có thể được sử dụng để hiển thị hai góc mà kim giờ và kim
phút hình thành tùy thuộc vào thời gian trong ngày. Hình bên dưới thể
hiện đồ thị đồng hồ với các góc θ1 và θ2. Trong đồ thị này, vị trí của kim
phút được cố định tại 12 giờ.

Clock

Quy trình thao tác chung của Circle

1. Nhấn , chọn biểu tượng ứng dụng Math Box, sau đó nhấn .
• Thao tác này sẽ hiển thị menu Math Box.

2. Cấu hình cài đặt Angle Unit theo yêu cầu.
• Bạn có thể chọn một trong các đơn vị sau đây để nhập giá trị góc:

Degree, Radian, Gradian. Vui lòng xem "Thay đổi cài đặt của máy
tính" (trang 21).

3. Chọn [Circle], sau đó nhấn .
• Thao tác này sẽ hiển thị màn hình nhập tham số.

• Nếu bạn muốn chọn Unit Circle cho quy trình này, bạn có thể tiến
hành trực tiếp đến bước 5. (Trong trường hợp này, nhấn  để chọn
[θ1] ở bước 5.)

4. Chọn loại Circle bạn muốn sử dụng.
(1) Chọn [Type], sau đó nhấn .
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(2) Trong danh sách loại xuất hiện, chọn [Unit Circle], [Half Circle], hoặc
[Clock] và sau đó nhấn .

• Nếu bạn đã chọn [Unit Circle] hoặc [Half Circle], bạn có thể tiến
hành trực tiếp đến bước 5.

• Nếu bạn chọn [Clock], hãy thực hiện bước 6.
5. Nhập các góc [θ1] và [θ2].

• Khi nhập một giá trị góc, sử dụng đơn vị cho cài đặt Angle Unit đang
chọn.

• Ví dụ, thực hiện thao tác dưới đây để nhập 45° cho [θ1] và 135° cho
[θ2] (Angle Unit: Degree).

45 135

• Về miền đầu vào cho phép đối với các giá trị góc, vui lòng xem "Lưu
ý" bên dưới.

6. Sau khi chắc chắn rằng [Execute] được chọn, nhấn .
• Thao tác này sẽ hiển thị màn hình đồ thị.

• Tham khảo các phần dưới đây để biết thông tin về cách xem màn
hình đồ thị và thực hiện thao tác.
"Màn hình đồ thị Unit Circle và Half Circle" (trang 160)
"Màn hình đồ thị Clock" (trang 160)

7. Nhấn  để trở về màn hình nhập tham số từ màn hình đồ thị.
8. Để thoát Circle, hãy hiển thị màn hình nhập tham số và sau đó nhấn .

• Thao tác này sẽ trở về menu Math Box.

Lưu ý

• Bảng dưới đây thể hiện miền đầu vào cho phép đối với các giá trị bạn nhập vào ở
bước 5 ở trên.

Cài đặt Angle Unit Unit Circle Half Circle

Degree

-10000 < θ < 10000

0 ≤ θ ≤ 180

Radian 0 ≤ θ ≤ π*

Gradian 0 ≤ θ ≤ 200

* 3,1415926535897932384626
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Màn hình đồ thị Unit Circle và Half Circle

Unit Circle và Half Circle sẽ xuất hiện như hình dưới đây. Phần hiển thị
mẫu dưới đây là khi các giá trị cho cả θ1 và θ2 đã được nhập vào.

Unit Circle

Half Circle

(1) Các đường tạo thành góc [θ1] và [θ2]. Đường đang được chọn đậm
hơn đường còn lại. Bạn có thể thay đổi chọn giữa θ1 và θ2 bằng
cách nhấn  hoặc .

(2) Giá trị góc của góc của đường đang được chọn (θ1 hoặc θ2).
(3) Các giá trị hàm lượng giác của góc của đường đang được chọn (θ1

hoặc θ2).

Lưu ý

• Khi chỉ nhập một góc duy nhất (θ1 hoặc θ2), một đường đậm duy nhất sẽ được hiển
thị để tạo thành góc. Trong trường hợp này, giá trị góc của góc duy nhất được hiển thị
cho (2), và các giá trị hàm lượng giác của góc được hiển thị cho (3).

• Trên màn hình đồ thị, các giá trị của các hàm lượng giác được hiển thị theo như các
cài đặt của Input/Output và Angle Unit.

• Khi MathI/MathO hoặc MathI/DecimalO được chọn cho Input/Output, các giá trị lượng
giác có thể bao gồm giá trị phân số hoặc √  nếu thích hợp.
Ví dụ: sin (45) = √2/2, cos (30) = √3/2 (Angle Unit: Degree)

Màn hình đồ thị Clock

Ví dụ dưới đây thể hiện màn hình đồ thị Clock.
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(1) Đồ thị đồng hồ. Clock ban đầu luôn biểu thị 12 giờ.
Nhấn  để tăng kim giờ thêm một giờ hoặc  để lùi trở lại.

(2) Thời gian được thể hiện bởi đồng hồ.
(3) θ1: Góc nhỏ hơn giữa kim giờ và kim phút.

θ2: Góc lớn hơn giữa kim giờ và kim phút.

Lưu ý

• Giá trị góc được hiển thị theo cài đặt Input/Output và Angle Unit.
• Nếu Radian được chọn cho Angle Unit và MathI/MathO được chọn cho Input/Output,

giá trị góc sẽ được hiển thị ở dạng thức π.
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Thông tin kỹ thuật

Lỗi
Máy tính sẽ hiển thị thông báo lỗi mỗi khi lỗi xuất hiện bởi bất kỳ lý do nào
trong quá trình tính toán.

Hiển thị vị trí lỗi
Khi thông báo lỗi hiển thị, nhấn , , hoặc  để trở về màn hình hiển
thị ngay trước khi thông báo lỗi xuất hiện. Con trỏ sẽ được định vị tại vị trí
nơi lỗi xuất hiện, sẵn sàng cho việc nhập. Hãy thực hiện những sửa chữa
cần thiết cho tính toán và thực hiện lại phép tính.

Ví dụ: Khi bạn nhập nhầm 14 ÷ 0 × 2 thay vì 14 ÷ 10 × 2.

14 0 2

(hoặc  hoặc )

1

Thông báo lỗi

Syntax ERROR

Nguyên nhân:
• Có vấn đề với dạng thức của tính toán bạn đang thực hiện.

Hành động:
• Thực hiện thao tác sửa chữa cần thiết.

Math ERROR

Nguyên nhân:
• Kết quả trung gian hay cuối cùng của tính toán bạn đang thực hiện

vượt quá miền tính toán cho phép.
• Đầu vào của bạn vượt quá miền đầu vào cho phép (đặc biệt khi dùng

các hàm).
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• Tính toán bạn đang thực hiện chứa thao tác toán học không hợp thức
(như chia cho không).

• Trong khi sử dụng ứng dụng không hỗ trợ số phức hoặc khi màn hình
không chấp nhận nhập số phức được hiển thị, bạn đã cố thực hiện
phép tính chứa một biến có lưu số phức.

• Khi Verify được bật (Verify ON) trong khi sử dụng ứng dụng Complex,
bạn đã nhập vào một bất phương trình có chứa số phức.

Hành động:
• Kiểm tra các giá trị nhập, giảm bớt số chữ số, và thử lại.
• Khi dùng một biến làm đối số cho hàm, hãy chắc chắn rằng giá trị

biến nằm trong miền cho phép đối với hàm đó.
• Để thực hiện phép tính bao gồm một biến có lưu số phức, khi sử

dụng ứng dụng không hỗ trợ số phức hoặc khi màn hình không chấp
nhận nhập số phức được hiển thị, hãy thay đổi giá trị được lưu cho
biến thành số thực.

• Bạn không thể sử dụng Verify trong ứng dụng Complex để xác định
xem một bất phương trình chứa số phức có đúng hay không. Bạn có
thể xác định tính đúng đắn của một phương trình có số phức.

Stack ERROR

Nguyên nhân:
• Tính toán bạn đang thực hiện đã làm dung lượng chồng số hoặc

chồng lệnh bị vượt quá.
• Tính toán bạn đang thực hiện đã làm cho dung lượng chồng ma trận

hoặc chồng véc-tơ bị vượt quá.
Hành động:
• Đơn giản hoá biểu thức tính toán để không vượt quá dung lượng

chồng.
• Thử chia phép tính thành hai hay nhiều phần.

Argument ERROR

Nguyên nhân:
• Có vấn đề với đối số của phép tính bạn đang thực hiện.

Hành động:
• Thực hiện thao tác sửa chữa cần thiết.

Dimension ERROR (Chỉ có ở các ứng dụng Matrix và Vector)

Nguyên nhân:
• Bạn đang cố gắng thực hiện tính toán với ma trận hay véc-tơ có chiều

không được phép cho kiểu tính toán đó.
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Hành động:
• Kiểm tra các chiều được xác định cho ma trận hay véc-tơ để xem liệu

chúng có tương hợp với tính toán không.

Variable ERROR (Chỉ có ở tính năng Solver của ứng dụng
Equation)

Nguyên nhân:
• Cố gắng thực hiện Solver cho đầu vào biểu thức không chứa bất kỳ

biến nào.
Hành động:
• Nhập biểu thức có chứa một biến.

Cannot Solve (Chỉ có ở tính năng Solver của ứng dụng
Equation)

Nguyên nhân:
• Máy tính không thể thu được nghiệm.

Hành động:
• Kiểm tra các lỗi trong phương trình bạn nhập.
• Đưa vào một giá trị cho biến nghiệm gần với nghiệm được mong đợi

và thử lại.

Range ERROR

Nguyên nhân (ứng dụng Table):
• Cố gắng tạo ra bảng số trong ứng dụng Table với điều kiện làm cho

bảng vượt quá số hàng tối đa cho phép.
Hành động:
• Thu hẹp miền tính toán của bảng bằng cách thay đổi Start, End, và

những giá trị Step, rồi thử lại lần nữa.
Nguyên nhân (ứng dụng Spreadsheet):
• Trong quá trình nhập hàng loạt trong ứng dụng Spreadsheet, đầu vào

cho Range nằm ngoài miền cho phép hoặc là tên ô không tồn tại.
Hành động:
• Đối với Range, nhập một tên ô trong miền từ A1 đến E45, sử dụng cú

pháp: "A1:A1".
Nguyên nhân (ứng dụng Math Box):
• Giá trị đầu vào như Attempts (số lần thử) cho Dice Roll hoặc Coin

Toss nằm ngoài miền cho phép hoặc là giá trị không phải số nguyên.
• Giá trị đầu vào trên màn hình đăng ký biểu thức của Number Line

nằm ngoài miền cho phép, hoặc bạn đã nhập một bất phương trình
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với mối quan hệ giá trị lớn nhất - giá trị nhỏ nhất không hợp lệ (như
10 < x ≤ 5).

• Giá trị đầu vào trên màn hình View-Window của Number Line nằm
ngoài miền cho phép.

Hành động:
• Đối với Attempts, nhập một giá trị số nguyên nằm trong miền cho 

phép.
• Trên màn hình đăng ký biểu thức, nhập giá trị nằm trong miền cho 

phép. Trong trường hợp bất phương trình đã nhập có mối quan hệ 
giá trị lớn nhất - giá trị nhỏ nhất không hợp lệ, hãy sửa bất phương 
trình để điều chỉnh mối quan hệ giá trị lớn nhất - giá trị nhỏ nhất.

• Trên màn hình View-Window, nhập các giá trị nằm trong miền cho 
phép.

Time Out

Nguyên nhân (tính toán vi phân hoặc tích phân):
• Kết thúc tính toán vi phân hay tích phân hiện tại mà không đáp ứng

đủ điều kiện kết thúc.
Hành động:
• Thử tăng giá trị tol lên. Lưu ý rằng điều này cũng làm giảm độ chính

xác của nghiệm.
Nguyên nhân (ứng dụng Distribution):
• Kết thúc tính toán phân phố hiện thời chấm dứt mà không đáp ứng đủ

điều kiện kết thúc.
Hành động:
• Thay đổi giá trị của từng tham số.

Circular ERROR

Nguyên nhân (tính năng f(x) và g(x)):
• Tham chiếu vòng xảy ra trong hàm hợp đã đăng ký ("Đăng ký hàm

hợp" (trang 71)).
Hành động:
• Không được nhập g(x) vào f(x), và nhập f(x) vào g(x) cùng một lúc.

Nguyên nhân (ứng dụng Spreadsheet):
• Có tham chiếu vòng (chẳng hạn như "=A1" ở ô A1) trong bảng tính.

Hành động:
• Thay đổi nội dung trong ô để loại bỏ tham chiếu vòng.
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Memory ERROR (chỉ có ở ứng dụng Spreadsheet)

Nguyên nhân:
• Bạn đang cố nhập dữ liệu vượt quá dung lượng đầu vào cho phép

(1.700 byte).
• Bạn đang cố nhập dữ liệu dẫn đến một chuỗi tham chiếu ô liên tiếp

(như ô A2 tham chiếu từ ô A1, ô A3 tham chiếu từ ô A2, v.v...) Loại
đầu vào này luôn gây ra lỗi trên, ngay cả khi không vượt quá dung
lượng bộ nhớ (1.700 byte).

Hành động:
• Xóa dữ liệu không cần thiết và nhập lại dữ liệu.
• Hạn chế tối đa dữ liệu đầu vào dẫn đến một chuỗi tham chiếu ô liên

tiếp.

No Operator (chỉ có ở ứng dụng Calculate và Complex)

Nguyên nhân:
• Bạn đã nhập một biểu thức không chứa toán tử và cố gắng xác định

xem có đúng hay không.
Hành động:
• Nhập một phương trình hoặc bất phương trình, sau đó xác định xem

có đúng hay không.

Not Defined

Nguyên nhân (tính năng f(x) và g(x)):
• Bạn đã cố tính f(x) hoặc g(x) với f(x)/g(x) không xác định.

Hành động:
• Xác định f(x) hoặc g(x) trước khi tính f(x)/g(x).

Nguyên nhân (ứng dụng Matrix và Vector):
• Ma trận hay véc-tơ bạn đang định dùng trong tính toán đã được đưa

vào mà không xác định chiều của nó.
Hành động:
• Xác định chiều của ma trận hay véc-tơ và rồi thực hiện lại tính toán.

Trước khi xác định máy tính gặp trục
trặc...
Lưu ý rằng bạn phải sao chép dữ liệu quan trọng thành các bản sao riêng
trước khi thực hiện các bước này.
1. Kiểm tra biểu thức tính toán để đảm bảo rằng nó không chứa lỗi nào.
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2. Đảm bảo rằng bạn đang dùng đúng ứng dụng máy tính cho kiểu phép
tính bạn muốn thực hiện.
• Để kiểm tra ứng dụng máy tính bạn đang sử dụng, nhấn . Thao tác

này sẽ đánh dấu biểu tượng của ứng dụng máy tính hiện đang được
sử dụng.

3. Nếu các bước trên không giải quyết được vấn đề của bạn, nhấn phím
.

• Thao tác này sẽ làm cho máy tính thực hiện một quy trình kiểm tra
xem các chức năng tính toán có hoạt động chính xác hay không. Nếu
máy tính phát hiện bất kỳ bất thường nào, máy sẽ tự khởi động ứng
dụng máy tính và xóa nội dung bộ nhớ.

4. Đưa các cài đặt của máy tính (ngoại trừ Contrast, Auto Power Off, và
Language) về cài đặt mặc định ban đầu bằng cách thực hiện quy trình
dưới đây.
(1) Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
(2) Nhấn , sau đó chọn [Reset] > [Settings & Data] > [Yes].

Thay thế pin
Nếu màn hình hiển thị dưới đây xuất hiện ngay sau khi bạn bật nguồn, có
nghĩa là nguồn pin còn lại yếu.

Pin yếu được chỉ báo bởi hiển thị mờ, cho dù đã điều chỉnh độ tương
phản, hay được chỉ báo bởi việc không hiện hình trên màn hình hiển thị
ngay sau khi bạn bật máy tính.
Nếu điều này xảy ra hoặc màn hình trên xuất hiện, hãy thay pin bằng pin
mới.

Quan trọng!

• Việc tháo pin sẽ làm cho tất cả nội dung bộ nhớ của máy bị xóa.

1. Nhấn (OFF) để tắt máy tính.
• Để đảm bảo rằng bạn không tình cờ bật nguồn lên trong khi thay pin,

hãy gắn nắp trước vào phía trước của máy tính.
2. Thực hiện như thể hiện trong hình minh họa, hãy tháo nắp pin, tháo pin,

sau đó lắp một pin mới đúng cực dương (+) và cực âm (-).
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3. Lắp lại nắp pin.
4. Nhấn  để bật máy tính.
5. Khởi động máy tính.

(1) Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
(2) Nhấn , sau đó chọn [Reset] > [Initialize All] > [Yes].
• Đừng bỏ qua các bước trên!

Trình tự ưu tiên tính toán
Máy tính thực hiện các phép tính theo trình tự ưu tiên tính toán.

• Về cơ bản, các phép tính được thực hiện từ trái sang phải.
• Các biểu thức trong dấu ngoặc đơn có mức ưu tiên cao nhất.
• Sau đây là trình tự ưu tiên cho mỗi lệnh riêng lẻ.

1 Biểu thức trong ngoặc đơn

2
Các hàm có dấu ngoặc đơn (sin(, log(, f(, g(, v.v..., các hàm
có đối số ở bên phải, các hàm cần có dấu ngoặc đóng sau
đối số)

3
Các hàm đi sau giá trị nhập (x2, x3, x-1, x!, °’ ”, °, r, g, %, t),
các ký hiệu kỹ thuật (m, μ, n, p, f, k, M, G, T, P, E), lũy thừa
( ), căn ( )

4 Phân số

5 Dấu âm ((-)), Base Prefix (d, h, b, o)

6
Các lệnh chuyển đổi đơn vị (cm in, v.v...), các giá trị ước
lượng trong ứng dụng Statistics (x̂, ŷ, x̂1, x̂2)
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7 Phép nhân bỏ đi dấu nhân

8
Phép hoán vị (nPr), phép tổ hợp (nCr), ký hiệu tọa độ cực số
phức (∠)

9 Tích vô hướng (•)

10 Phép nhân (×), phép chia (÷), phép tính số dư (÷R)

11 Phép cộng (+), phép trừ (−)

12 and (toán tử logic)

13 or, xor, xnor (toán tử logic)

Nếu phép tính chứa giá trị âm, bạn có thể cần phải đặt giá trị âm trong
dấu ngoặc đơn. Ví dụ, nếu bạn muốn bình phương giá trị bằng -2, bạn
cần nhập: (-2)2. Lý do là vì x2 là hàm đi sau một giá trị (Ưu tiên 3, ở trên),
có mức ưu tiên lớn hơn dấu âm, là một ký hiệu tiền tố (Ưu tiên 5).

Ví dụ:
((-))2     -22 = -4

((-))2  (-2)2 = 4

Miền tính toán, số chữ số và độ
chính xác
Miền tính toán, số chữ số được dùng cho tính toán nội bộ, và độ chính xác
của phép tính phụ thuộc vào kiểu phép tính bạn đang thực hiện.

Miền tính toán và độ chính xác

Miền tính toán
±1 × 10-99 đến ±9,999999999 × 1099 hoặc
0

Số chữ số cho tính toán
nội bộ

23 chữ số

Độ chính xác

Nói chung, ±1 ở chữ số thứ 10 cho một
tính toán đơn. Độ chính xác cho hiển thị
số mũ là ±1 chữ số ít quan trọng nhất.
Lỗi tích lũy trong trường hợp tính toán liên
tiếp.
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Miền đầu vào tính toán hàm và độ chính xác

Hàm Miền đầu vào

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632,7

Gradian 0 ≤ |x| < 1 × 1010

tanx

Degree
Như sinx, ngoại trừ khi |x| =
(2n - 1) × 90.

Radian
Như sinx, ngoại trừ khi |x| =
(2n - 1) × π/2.

Gradian
Như sinx, ngoại trừ khi |x| =
(2n - 1) × 100.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9,999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230,2585092

sinh-1x 0 ≤ |x| ≤ 4,999999999 × 1099

cosh-1x 1 ≤ x ≤ 4,999999999 × 1099

tanhx 0 ≤ |x| ≤ 9,999999999 × 1099

tanh–1x 0 ≤ |x| ≤ 9,999999999 × 10-1

logx, lnx 0 < x ≤ 9,999999999 × 1099

10x -9,999999999 × 1099 ≤ x ≤ 99,99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0

x! 0 ≤ x ≤ 69 (x là số nguyên)
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nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r là các số nguyên)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r là các số nguyên)
1 ≤ n!/r! < 1 × 10100 hoặc 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9,999999999 × 1099

√x2 + y2 ≤ 9,999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9,999999999 × 1099

θ: Như sinx

a°b’c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
Giá trị giây hiển thị có sai số ± 1 ở vị trí thập phân
thứ hai.

a°b’c” = x
0°0’0” ≤ |x| ≤ 9999999°59’59”
Giá trị lục thập phân nằm ngoài miền trên sẽ
được tự động xem là giá trị thập phân.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m, n là các số nguyên)

Tuy nhiên: -1 × 10100 < ylog |x| < 100

x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n + 1, 2n + 1
　 m　

 (m ≠ 0; m, n là các số

nguyên)
Tuy nhiên: -1 × 10100 < 1/x log |y| < 100

a b/c
Toàn bộ số nguyên, tử số và mẫu số phải là 10
chữ số hay ít hơn (kể cả biểu tượng phân tách).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

GCD(a, b) |a|, |b| < 1 × 1010 (a, b là các số nguyên)

LCM(a, b) 0 ≤ a, b < 1 × 1010 (a, b là các số nguyên)

• Độ chính xác về căn bản là như đã mô tả tại "Miền tính toán và độ chính
xác" ở trên.
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• Các hàm dạng xy, 
x
√y, x!, nPr, nCr cần tính toán nội bộ liên tiếp, có thể

tạo ra sự tích lũy lỗi xuất hiện với mỗi tính toán.
• Sai số được tích luỹ có xu hướng tăng lên trong lân cận của điểm kì dị

và điểm uốn của hàm.
• Miền cho các kết quả tính toán có thể được hiển thị dưới dạng π khi

MathI/MathO được chọn cho Input/Output trên menu SETTINGS là |x| <
106. Tuy nhiên, lưu ý rằng sai số tính toán bên trong có thể gây ra việc
không hiển thị được một số kết quả tính toán dưới dạng π. Nó cũng có
thể làm cho kết quả tính toán lẽ ra phải ở dạng thập phân lại xuất hiện
dưới dạng π.

Đặc tả
Yêu cầu nguồn:
Pin cỡ AAA R03 × 1

Tuổi thọ pin xấp xỉ:
2 năm (trên cơ sở một giờ làm việc mỗi ngày)

Tiêu thụ điện năng:
0,0008 W

Nhiệt độ vận hành:
0°C đến 40°C

Kích thước:
13,8 (C) × 77 (R) × 162 (D) mm

Trọng lượng xấp xỉ:
100 g kể cả pin
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Câu hỏi thường gặp

Câu hỏi thường gặp
■ Làm cách nào để tôi có thể thay đổi kết quả dạng thức phân số

được tạo bởi phép chia thành dạng thức thập phân?
→ Khi kết quả tính toán dạng phân số được hiển thị, nhấn  rồi chọn

[Decimal], hoặc nhấn ( ). Để kết quả tính toán ban đầu xuất hiện
dưới dạng giá trị thập phân, hãy thay đổi cài đặt Input/Output trên menu
SETTINGS thành MathI/DecimalO.

■ Điểm khác biệt giữa bộ nhớ Ans, bộ nhớ PreAns, và bộ nhớ biến là
gì?

→ Mỗi loại bộ nhớ trên đây đều hoạt động giống như "hộp chứa" để lưu
trữ tạm thời một giá trị duy nhất.
Bộ nhớ Ans: Lưu trữ kết quả của phép tính cuối cùng được thực hiện.
Dùng bộ nhớ này để mang kết quả của phép tính này sang phép tính
khác.
Bộ nhớ PreAns: Lưu trữ kết quả của phép tính được thực hiện trước
phép tính cuối cùng. Bộ nhớ PreAns chỉ có thể được sử dụng trong ứng
dụng Calculate.
Biến: Bộ nhớ này hữu ích khi bạn cần sử dụng cùng một giá trị nhiều
lần trong một hoặc nhiều phép tính.

■ Làm cách nào để tôi có thể tìm thấy một hàm mà tôi đang sử dụng
với mẫu máy tính CASIO cũ hơn trên máy tính này?

→ Có thể truy cập các hàm của máy tính này từ menu CATALOG xuất
hiện khi bạn nhấn . Để biết chi tiết, vui lòng xem các phần bên dưới.
"Sử dụng Menu CATALOG" (trang 26)
"Tính toán nâng cao" (trang 51)

■ Với mẫu máy tính cũ hơn, tôi đã nhấn  để thay đổi dạng thức
hiển thị kết quả tính toán. Tôi nên thao tác thế nào trên máy tính
này?

→ Khi kết quả tính toán được hiển thị, nhấn . Sử dụng menu xuất hiện
để chọn dạng thức hiển thị bạn muốn. Để biết chi tiết, vui lòng xem
"Thay đổi dạng thức kết quả tính toán" (trang 42).

■ Làm thế nào để tôi có thể tìm ra ứng dụng máy tính tôi đang sử
dụng?

→ Nhấn . Thao tác này sẽ làm cho biểu tượng của ứng dụng máy tính
bạn đang sử dụng được tô đậm.
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■ Làm cách nào để tính sin2 x

→ Ví dụ, để tính sin2 30 =  1
4 , hãy nhập phép tính bên dưới.

30

■ Tại sao tôi không thể nhập (i) hoặc tính toán một số phức?
→ Bạn không thể dùng ứng dụng Calculate để nhập i hoặc thực hiện tính

toán số phức. Hãy sử dụng ứng dụng Complex cho các tính toán như
vậy.

■ Tại sao chỉ báo Verify ( ) không biến mất?
→ Để chỉ báo  xuất hiện trong khi Verify được bật (Verify ON) biến mất,

thực hiện thao tác sau:  – [Verify OFF].
Để biết thêm thông tin về Verify, vui lòng xem "Sử dụng Verify" (trang
73).

■ Tại sao biểu tượng pin ( ) xuất hiện ngay sau khi bật máy tính?
→ Biểu tượng pin cho biết nguồn pin yếu. Nếu bạn nhìn thấy biểu tượng

này, hãy thay pin càng sớm càng tốt. Để biết chi tiết về việc thay pin, vui
lòng xem "Thay thế pin" (trang 167).

■ Làm sao để đưa máy tính trở về cài đặt mặc định ban đầu?
→ Thực hiện quy trình dưới đây để khởi chạy các cài đặt của máy tính

(ngoại trừ Contrast, Auto Power Off, và Language).
(1) Nhấn , chọn biểu tượng ứng dụng máy tính, sau đó nhấn .
(2) Nhấn , sau đó chọn [Reset] > [Settings & Data] > [Yes].
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